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Notes, Cautions, and Warnings
 NOTE: A NOTE indicates important information that helps you make better use of your printer.

 CAUTION: A CAUTION indicates either potential damage to hardware or loss of data and tells you how to avoid the problem.

 WARNING: A WARNING indicates a potential for property damage, personal injury, or death.

Information in this document is subject to change without notice.

© 2014 Dell Inc. All rights reserved.

Reproduction of these materials in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden.

Trademarks used in this text: Dell and the DELL logo are trademarks of Dell Inc.; Microsoft, Windows, Windows Server, Windows Vista, and 
Internet Explorer are either trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries; Macintosh 
and Mac OS are trademarks of Apple Inc., registered in the U.S. and other countries; Adobe is either a registered trademark or a trademark of 
Adobe Systems Incorporated in the United States and/or other countries; Wi-Fi is a registered trademark of the Wi-Fi Alliance; Wi-Fi Protected 
Setup, WPA, and WPA2 are trademarks of the Wi-Fi Alliance.

XML Paper Specification (XPS): This product may incorporate intellectual property owned by Microsoft Corporation. The terms and conditions 
upon which Microsoft is licensing such intellectual property may be found at http://go.microsoft.com/fwlink/?LinkId=52369; DES: This product 
includes software developed by Eric Young (eay@mincom.oz.au); AES: Copyright © 2003, Dr Brian Gladman, Worcester, UK. All rights reserved. 
This product uses published AES software provided by Dr Brian Gladman under BSD licensing terms; TIFF (libtiff): Copyright © 1988-1997 Sam 
Leffler and Copyright © 1991-1997 Silicon Graphics, Inc.; ICC Profile (Little cms): Copyright © 1998-2004 Marti Maria.

Other trademarks and trade names may be used in this document to refer to either the entities claiming the marks and names or their products. 
Dell Inc. disclaims any proprietary interest in trademarks and trade names other than its own.

Our printer software uses some of the codes defined by the Independent JPEG Group.

____________________

UNITED STATES GOVERNMENT RESTRICTED RIGHTS

This software and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 and in 
applicable FAR provisions: Dell Inc., One Dell Way, Round Rock, Texas, 78682, USA.

June 2014 Rev. A04
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1
Dell™ C1765nf/C1765nfw Color Multifunction Printer 
User's Guide
Click the links to the left for information on the features, options, and operation of your Dell C1765nf/C1765nfw 
Color Multifunction Printer. For information on other documentation included with your Dell C1765nf/C1765nfw 
Color Multifunction Printer, see "Finding Information" on page 21.

 NOTE: In this manual, Dell C1765nf/C1765nfw Color Multifunction Printer is referred to as the "printer."

Conventions
The following describe the meaning of the symbols and fonts used in this manual:

Bold texts : • Names of hardware button on the operator panel.

• Screen names on the LCD panel.

• Menus, commands, windows, or dialog boxes displayed on the computer screen.

Texts in Courier New font : • Menus and messages displayed on the LCD panel.

• Characters entered from the computer.

• Directory paths.

< > : • Key on the keyboard of the computer.

→ : • Indicates a path to a certain item within a procedure on a computer.

" " : • Cross references in this manual.

• Characters entered from the operator panel.

• Messages displayed on the computer screen.
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2
Finding Information

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

What are you looking for? Find it here

• Drivers for my printer

• My User's Guide

Software and Documentation disc

The Software and Documentation disc contains setup video, documentation, 
and drivers for your printer. You can use the disc to install/re-install drivers or 
access your setup video and documentation.

Readme files may be included on your disc to provide last-minute updates about 
technical changes to your printer or advanced technical reference material for 
experienced users or technicians.

How to use my printer Quick Reference Guide

• Safety information

• Warranty information

Important Information

WARNING: Read and follow all safety instructions in the Important Information 
prior to setting up and operating your printer.
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How to set up my printer Setup diagram

Troubleshooting "Troubleshooting" on page 347

Express Service Code and Service Tag

The Express Service Code and Service Tag are located inside the side door of your 
printer.

• Latest drivers for my printer

• Answers to technical service and support 
questions

• Documentation for my printer

Go to www.dell.com/support

www.dell.com/support provides several online tools, including:

• Solutions — Troubleshooting hints and tips, articles from technicians, and 
online courses 

• Upgrades — Upgrade information for components, such as printer driver

• Customer Care — Contact information, order status, warranty, and repair 
information 

• Downloads — Drivers 

• Manuals — Printer documentation and product specifications

Go to www.dell.com/support. Select your region and fill in the requested details 
to access help tools and information.

What are you looking for? Find it here

Service Tag
xxxxxxx

Express Service Code
000 000 000 00

http://www.dell.com/support
http://www.dell.com/support
http://www.dell.com/support
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3
Product Features
This chapter describes the product features and indicates their links.

Scanning to a USB Storage Device

With Dell™ C1765nf/C1765nfw Color Multifunction Printer, 
you don't need a PC to connect your USB storage device to save 
the scanned data. Insert your USB storage device in the port on 
the printer, and save the scanned data directly to your USB 
storage device.
For more information, see "Scanning to USB Storage Device" 
on page 268.

Printing multiple pages on a single sheet of paper (Multiple-Up)

Multiple-Up Print allows you to print multiple pages on a single 
sheet of paper. This feature allows you to reduce the paper 
consumption.
For more information, see "Multiple-Up" on page 241.

2-Sided Printing (Manual Duplex Print)

Manual Duplex Print is to print two or more pages on the front 
and back side of a single sheet of paper manually. This feature 
allows you to reduce the paper consumption.
For more information, see "Loading Print Media When Manual 
Duplex Printing" on page 224.

Print From USB Memory (USB Direct Print)

Print From USB Memory feature allows you to print directly 
from your USB storage device without starting your computer. 
Without requiring you to start your computer and an 
application, this feature allows quick printing with simple 
procedures.
For more information, see "Direct Print Using the USB Storage 
Device" on page 231.
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Printing Through Wireless Connection (Wireless Print)
(Dell C1765nfw Color Multifunction Printer only)

The Wireless LAN feature on your printer allows you to install 
the printer at any location, and enables printing without a wired 
connection to your computer.
For more information, see "Wireless Connection (Dell 
C1765nfw Color Multifunction Printer Only)" on page 37.
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4
About the Printer
This chapter provides an overview of your Dell™ C1765nf/C1765nfw Color Multifunction Printer.

 NOTE: The images used in this manual are those of the Dell C1765nfw Color Multifunction Printer unless otherwise mentioned.

Front View

1 Operator Panel 2 Automatic Document Feeder (ADF)

3 Document Feeder Tray 4 Document Output Tray

5 Toner Access Cover 6 Print Head Cleaning Rod

7 Power Switch 8 Front Cover

9 Paper Width Guides 10 MPF Extension

11 Length Guide 12 Multipurpose Feeder (MPF)

13 Front USB Port 14 Priority Sheet Inserter (PSI)

19

79101114 8

652 3 4

1213
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Rear View

1 ADF Cover 2 Ethernet Port

3 USB Port 4 Wall Jack Connector

5 Phone Connector 6 Power Connector

7 Rear Cover 8 Transfer Roller

9 Paper Chute 10 Paper Feed Roller

11 Transfer Belt 12 Levers

13 Security Slot

7

8
9

10
11

12 1

2

3

6

4

5 

13
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Space Requirements
Place the printer at a location such that there is adequate space for using the printer feeder and covers.

 CAUTION: To avoid irregular screen image or malfunctioning of your printer, avoid placing the printer in direct sunlight with 
the front cover opened.

596 mm/23.46 inches

262.5 mm/10.33 inches

379 mm/14.92 inches

292.5 mm/11.52 inches339 mm/13.35 inches

409 mm/16.10 inches

144.3 mm/5.68 inches

100 mm/3.94 inches
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Automatic Document Feeder (ADF)

Operator Panel

For more information on the operator panel, see "Operator Panel" on page 91.

1 ADF Cover

2 Document Guides

3 Document Glass

4 Document Feeder Tray

1 2 3

4
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Securing the Printer
To protect your printer from theft, you can use the optional Kensington lock.

Attach the Kensington lock to the security slot on your printer.

For details, see the operating instructions supplied with the Kensington lock.

Security slot
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Ordering Supplies
You can order consumables from Dell on the Internet when using a networked printer. Enter the IP address of your 
printer in your web browser, launch the Dell Printer Configuration Web Tool, and click the Order Supplies at: to 
order toner for your printer. 

You can also order toner cartridges by the following method:

1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Dell Supplies 
Management System.

The Dell Supplies Management System window appears.

2 Select your printer from the Select Printer Model list.

3 If ordering from the web:

a Select a web address from the Select Reorder URL list.

b Click the Visit Dell printer supplies ordering web site.

The Dell C1765nf/C1765nfw Color MPF - Dell Supplies Management System screen appears.

c Enter the Service Tag, and then click OK.

The Service Tag is located inside the toner access cover of your printer.

Dell supplies web site appears.

If you order by phone, call the number that appears in the Order by Phone section.

Service Tag
xxxxxxx

Express Service Code
000 000 000 00
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Printer Setup

5 Removing Packaging Material.................................................. 33

6 Connecting Your Printer ............................................................. 35

7 Setting Up Your Printer............................................................... 47

8 Setting the IP Address ............................................................... 53

9 Loading Paper.............................................................................. 57

10 Installing Printer Drivers on Computers Running Windows®

........................................................................................................ 65

11 Installing Printer Drivers on Computers Running Macintosh
........................................................................................................ 85
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5
Removing Packaging Material
This chapter provides an overview of your Dell™ C1765nf/C1765nfw Color Multifunction Printer.

 NOTE: The images used in this manual are those of the Dell C1765nfw Color Multifunction Printer unless otherwise mentioned.

1 Remove the packaging material from the printer.

2 Lift and open the document cover.

3 Remove the protective sheet from the document glass.
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6
Connecting Your Printer
Your Dell™ C1765nf/C1765nfw Color Multifunction Printer interconnection cable must meet the following 
requirements:

 NOTE: The images used in this manual are those of the Dell C1765nfw Color Multifunction Printer unless otherwise mentioned.

Connection type Connection specifications

Wireless IEEE 802.11b/802.11g (Dell C1765nfw Color Multifunction Printer only)

USB USB 2.0 compatible

Ethernet 10 Base-T/100 Base-TX compatible

Wall jack connector RJ11

Phone connector RJ11

1 Ethernet Port

2 USB Port

3 Wall Jack Connector

4 Phone Connector

1

2

3

4 
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Connecting Printer to Computer or Network

Direct Connection
A local printer is a printer which is directly attached to your computer using a USB cable. If your printer is attached 
to a network, go to "Ethernet Connection" on page 36.

To connect the printer to a computer:

1 Ensure that the printer, computer, and any other attached devices are turned off and unplugged from the power 
source/outlet.

2 Connect the smaller USB connector into the USB port at the back of the printer.

3 Connect the other end of the cable into a USB port of your computer.

 CAUTION: Do not connect the printer USB cable to the USB port available on the keyboard.

Ethernet Connection
To connect the printer to a network:

1 Ensure that the printer, computer and any other connected devices have been turned off and all cables have been 
disconnected.

2 Connect the Ethernet cable.

 NOTE: Connect the Ethernet cable, only if you need to setup a wired connection.

USB port

Ethernet port
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To connect the printer to the network, connect one end of an Ethernet cable into the Ethernet port at the rear of the 
printer, and the other end to a LAN drop or hub.

To setup a wireless connection, see "Wireless Connection (Dell C1765nfw Color Multifunction Printer Only)" on 
page 37.

Wireless Connection (Dell C1765nfw Color Multifunction Printer Only)
The specifications of wireless setting function are described below:

You can select a method to configure a wireless setting from the following:

Item Specification

Connectivity Wireless

Connectivity Standard IEEE 802.11b/802.11g compliant

Bandwidth 2.4 GHz

Data Transfer Rate IEEE 802.11b mode: 11, 5.5, 2, 1 Mbps

IEEE 802.11g mode: 54, 48, 36, 24, 18, 12, 9, 6 Mbps

Security 64 (40-bit key)/ 128 (104-bit key) WEP, WPA-PSK (TKIP, AES), WPA2-PSK (AES)(IEEE 
802.1x attestation function of WPA 1x non-corresponds), Mixed Mode PSK

Wi-Fi Protected Setup®(WPS)*1 Push Button Configuration (PBC), Personal Identification Number (PIN)

*1 WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed mode PSK, WPA-PSK AES, WPA2-PSK 
AES, WPA-PSK TKIP, Open (No Security)

WPS-PBC (Wi-Fi | WPS Button)*1

WPS-PBC (Operator Panel Menu)*1

WPS-PIN*2

Auto SSID Setup

Manual SSID Setup
*1 WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register devices required for wireless 

configuration, by starting WPS-PBC on the printer with the  (Wi-Fi | WPS) button or operator panel menu, and then pressing the 
button provided on the wireless LAN access point (Registrar) or router. This setting is available only when the access point supports 
WPS-PBC.

*2 WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register devices required for wire-
less configuration, by entering PIN assignments in the printer and computer. This setting, performed through access point, is available 
only when the access points of your wireless router supports WPS.
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WPS-PBC (Wi-Fi | WPS Button)

You can start WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) by pressing the  (Wi-Fi | WPS) 
button.

 NOTE: WPS-PBC is available only when the wireless LAN access point (Registrar) or router supports WPS-PBC.

 NOTE: Before starting WPS-PBC with the  (Wi-Fi | WPS) button, confirm the position of the WPS button (button name may 
vary) on the wireless LAN access point (Registrar) or router. For information about WPS operation on the wireless LAN access 
point (Registrar) or router, refer to the manual supplied with the product.

 NOTE: For more information on the  (Wi-Fi | WPS) button, see "Status of Wi-Fi | WPS Button Backlight (Dell C1765nfw Color 
Multifunction Printer only)" on page 93. 
If a problem occurs or error messages are displayed on the operator panel, see "Wireless Problems (Dell C1765nfw Color 
Multifunction Printer only)" on page 364.

1 Press and hold the  (Wi-Fi | WPS) button on the printer for 2 seconds.

Ensure that the  (Wi-Fi | WPS) button starts to flash and Press WPS Button on WPS Router 
appears on the operator panel.

2 Start the WPS operation on the wireless LAN access point (Registrar) or router within two minutes.

3 When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed.



Connecting Your Printer 39

WPS-PBC (Operator Panel Menu)

You can start WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) from the operator panel.

 NOTE: WPS-PBC is available only when the wireless LAN access point (Registrar) or router supports WPS-PBC.

 NOTE: Before starting WPS-PBC, confirm the position of the WPS button (button name may vary) on the wireless LAN access 
point (Registrar) or router. For information about WPS operation on the wireless LAN access point (Registrar) or router, refer to 
the manual supplied with the product.

 NOTE: A password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter the 
password you specified, and press the  (Set) button.

1 Press the  (Menu) button.

2 Press the  button until System appears, and then press the  (Set) button.

3 Press the  button until Admin Menu appears, and then press the  (Set) button.

4 Press the  button until Network appears, and then press the  (Set) button.

5 Press the  button until WPS appears, and then press the  (Set) button.

6 Ensure that Push Button Control appears, and then press the  (Set) button.

7 Ensure that Yes appears, and then press the  (Set) button.

Ensure that Press WPS Button on WPS Router is displayed, and start the WPS-PBC on the wireless LAN 
access point (Registrar) or router within two minutes.

8 When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed.
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WPS-PIN

The PIN code of WPS-PIN can only be configured from the operator panel.

 NOTE: WPS-PIN is available only when the wireless LAN access point (Registrar) or router supports WPS-PIN.

 NOTE: A password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter the 
password you specified, and press the  (Set) button.

1 Press the  (Menu) button.

2 Press the  button until System appears, and then press the  (Set) button.

3 Press the  button until Admin Menu appears, and then press the  (Set) button.

4 Press the  button until Network appears, and then press the  (Set) button.

5 Press the  button until WPS appears, and then press the  (Set) button.

6 Ensure that PIN Code appears, and then press the  (Set) button.

7 Write down the displayed 8-digit PIN code or select Print PIN Code. The PIN code is printed.

8 Ensure that Start Configuration appears, and then press the  (Set) button.

9 Ensure that WPS AP Searching is displayed, and enter the PIN code displayed on step 7 into the wireless LAN 
access point (Registrar) or router.

 NOTE: For WPS operation on the wireless LAN access point (Registrar) or router, refer to the manual supplied with the 
product.

10 When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed.

Auto SSID Setup

 NOTE: A password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter the 
password you specified, and press the  (Set) button.

1 Press the  (Menu) button.

2 Press the  button until System appears, and then press the  (Set) button.

3 Press the  button until Admin Menu appears, and then press the  (Set) button.

4 Press the  button until Network appears, and then press the  (Set) button.

5 Press the  button until Wireless Setup appears, and then press the  (Set) button.

The printer automatically searches the access points on wireless network.

6 Press the  button until the desired access point appears, and then press the  (Set) button.

If the desired access point does not appear, go to "Manual SSID Setup" on page 41.

 NOTE: Some hidden SSID may not be displayed. If the SSID is not detected turn on SSID broadcast from the router.

7 Enter the passphrase or WEP key.

When the encryption type of the selected access point is WPA, WPA2 or Mixed in step 6:

• Enter the passphrase, and then press the  (Set) button.

When the encryption type of the selected access point is WEP in step 6:

• Enter the WEP key, and then press the  (Set) button.

 NOTE: A passphrase is an encryption key for WPA and WPA2 encryption which consists of 8 to 63 alphanumeric 
characters. It may be described as a key on some access points or routers. For details, refer to the manual supplied with 
the access point or router.

8 The Restart System screen appears and the printer is rebooted, wireless LAN connection setting is completed.
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Manual SSID Setup

 NOTE: A password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter the 
password you specified, and press the  (Set) button.

1 Press the  (Menu) button.

2 Press the  button until System appears, and then press the  (Set) button.

3 Press the  button until Admin Menu appears, and then press the  (Set) button.

4 Press the  button until Network appears, and then press the  (Set) button.

5 Press the  button until Wireless Setup appears, and then press the  (Set) button.

6 Press the  button until Manual Setup appears, and then press the  (Set) button.

7 Enter the SSID, and then press the  (Set) button.

8 Select the network mode from Infrastructure and Ad-hoc depending on your environment, and then press 
the  (Set) button.

If you select Infrastructure, proceed to step 9.

If you select Ad-hoc, proceed to step 10.

9 Select the encryption type from No Security, Mixed mode PSK, WPA-PSK-TKIP, WPA2-PSK-AES, or 
WEP.

If you do not set security for your wireless network:

• Press the  button until No Security appears, and then press the  (Set) button.

     To use Mixed mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES encryption:

a Press the  button until Mixed mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES appears, and then 
press the  (Set) button.

b Enter the passphrase, and then press the  (Set) button.

 NOTE: A passphrase is an encryption key for WPA and WPA2 encryption which consists of 8 to 63 alphanumeric 
characters. It may be described as a key on some access points or routers. For details, refer to the manual supplied with 
the access point or router.

To use WEP encryption:

a Press the  button until WEP appears, and then press the  (Set) button.

b Enter the WEP key, and then press the  (Set)button.

c Press the  button to highlight the desired transmit key from WEP Key 1 to WEP Key 4, and then press 
the  (Set) button.

Proceed to step 11.

10 Select the encryption type from No Security or WEP.

If you do not set security for your wireless network:

• Ensure that No Security appears, and then press the  (Set) button.

To use WEP encryption:

a Press the  button until WEP appears, and then press the  (Set) button.

b Enter the WEP key, and then press the  (Set) button.

c Press the  button to highlight the desired transmit key from WEP Key 1 to WEP Key 4, and then press 
the  (Set) button.

11 The Restart System screen appears and the printer is rebooted, wireless LAN connection setting is completed.
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Reconfiguring the Wireless Setting
To change the wireless setting through an Ethernet or wireless connection from your computer, perform the 
following.

 NOTE: To change the wireless setting through wireless connection, ensure that the wireless connection setting is completed in 
"Wireless Connection (Dell C1765nfw Color Multifunction Printer Only)" on page 37. 

 NOTE: The following settings are available when the network mode is set to infrastructure in "Wireless Connection (Dell 
C1765nfw Color Multifunction Printer Only)" on page 37.

1 Check the IP address of the printer.

For details about how to check the IP address of the printer, see "Verifying the IP Settings" on page 55.

2 Launch the Dell Printer Configuration Web Tool by entering the IP address of the printer in your web browser.

3 Click Print Server Settings.

4 Click Print Server Settings tab.

5 Click Wireless LAN.

6 Change the wireless setting of the printer.

7 Reboot the printer.

8 Change the wireless settings on your computer or access point accordingly.

 NOTE: To change the wireless settings on your computer, refer to the manuals provided with the wireless adapter or if 
your computer provides a wireless adapter tool, change the wireless settings using that tool. 
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Connecting the Telephone Line
 NOTE: Do not connect your printer directly to a Digital Subscriber Line (DSL). This may damage the printer. To use a DSL, you 

will need to use an appropriate DSL filter. Contact your service provider for the DSL filter.

1 Plug one end of a telephone line cord to the wall jack connector and the other end to an active wall jack.

2 Remove the blue plug from the phone connector ( ).

3 To connect a telephone and/or answering machine to your printer, plug the telephone or answering machine line 
cord into the phone connector ( ).

Wall jack connector

To the wall jack

Phone connector

Blue plug

Phone connector

To an external telephone or 
answering machine
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If the phone communication is serial in your country (such as Germany, Sweden, Denmark, Austria, Belgium, Italy, 
France and Switzerland), and you are supplied with a yellow terminator, insert the yellow terminator into the 
phone connector ( ).

Turning On the Printer
 WARNING: Do not use extension cords or power strips.

 WARNING: The printer should not be connected to an Uninterruptible Power Supply (UPS) system.

1 Connect the power cable to the power connector on the rear of your printer (see "Rear View" on page 26).

2 Connect the other end of the cable to the power source.

Phone connector

Yellow terminator
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3 Turn on the printer.

4 Follow the on-screen instructions in the operator panel to configure the initial settings of your printer.
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Setting Up Your Printer

Setting Initial Settings on the Operator Panel
You need to set the printer language, country, clock date, and time when you turn on printer for the first time.

When you turn the printer on, the wizard screen to perform the initial setup appears on the operator panel. Follow 
the steps below to set the initial settings.

 NOTE: If you do not start configuring the initial settings, Ready to Copy appears on the operator panel in three minutes. 
After that, you can set the following initial setup by enabling Power On Wizard on the operator panel or Dell™ Printer 
Configuration Web Tool if needed.

 NOTE: For more information on operator panel, see "Understanding the Printer Menus" on page 163.

 NOTE: For more information on Dell Printer Configuration Web Tool, see "Dell™ Printer Configuration Web Tool" on page 97. 

1 Ensure that Please Select Language appears, and then select the language you want to use on the 
operator panel from the following drop-down list, and then press the  (set) button. 

2 Press the  (set) button to start setting the country.

3 Ensure that Please Select Country appears. Select your country from the drop-down list, and then press 
the  (set) button.

4 Ensure that Please Select Time Zone appears. Select the appropriate time zone from the following drop-
down list, and then press the  (set) button.

English

Français

Italiano

Deutsch

Español

Dansk

Nederlands

Norsk

Svenska
*1

*1 Dell C1765nf Color 
Multifunction Printer 
only
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Geographic Region Time Zone

Africa (UTC) Accra, Bamako, Dakar, Nouakchott

(UTC) Casablanca

(UTC +01:00) Algiers, Douala, Libreville, Luanda

(UTC +01:00) Tunis

(UTC +01:00) Windhoek

(UTC +02:00) Cairo

(UTC +02:00) Harare, Johannesburg, Kinshasa, Tripoli

(UTC +03:00) Addis Ababa, Khartoum, Mogadishu, Nairobi 

Americas (UTC -10:00) Adak

(UTC -09:00) Alaska

(UTC -08:00) Pacific Time (US & Canada)

(UTC -08:00) Tijuana

(UTC -07:00) Arizona, Dawson Creek, Sonora

(UTC -07:00) Chihuahua, Mazatlan

(UTC -07:00) Mountain Time (US & Canada)

(UTC -06:00) Cancun, Mexico City, Monterrey

(UTC -06:00) Central America

(UTC -06:00) Central Time (US & Canada) 

(UTC -06:00) Saskatchewan

(UTC -05:00) Atikokan, Resolute

(UTC -05:00) Bogota, Lima, Panama, Quito

(UTC -05:00) Cayman Islands, Jamaica, Port-au-Prince

(UTC -05:00) Eastern Time (US & Canada)

(UTC -05:00) Grand Turk

(UTC -05:00) Havana

(UTC -04:30) Caracas

(UTC -04:00) Asuncion

(UTC -04:00) Atlantic Time (Canada)

(UTC -04:00) Blanc-Sablon

(UTC -04:00) Caribbean Islands

(UTC -04:00) Cuiaba

(UTC -04:00) Georgetown, La Paz, Manaus

(UTC -04:00) Thule

(UTC -03:30) St. John's

(UTC -03:00) Brasilia, Cayenne, Paramaribo

(UTC -03:00) Buenos Aires

(UTC -03:00) Greenland

(UTC -03:00) Miquelon

(UTC -03:00) Montevideo

(UTC -02:00) Noronha 
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Antarctica (UTC -04:00) Palmer Archipelago, Santiago

(UTC -03:00) Rothera

(UTC +03:00) Syowa

(UTC +06:00) Mawson, Vostok

(UTC +07:00) Davis

(UTC +08:00) Casey

(UTC +10:00) Dumont d'Urville

(UTC +12:00) McMurdo 

Asia (UTC +02:00) Amman

(UTC +02:00) Beirut

(UTC +02:00) Damascus

(UTC +02:00) Jerusalem

(UTC +02:00) Nicosia

(UTC +02:00) Palestine

(UTC +03:00) Aden, Baghdad, Qatar, Riyadh

(UTC +03:30) Tehran

(UTC +04:00) Baku

(UTC +04:00) Dubai, Muscat, Tbilisi

(UTC +04:00) Yerevan

(UTC +04:30) Kabul

(UTC +05:00) Aqtau, Aqtobe, Ashgabat, Samarkand

(UTC +05:00) Ekaterinburg

(UTC +05:00) Karachi

(UTC +05:30) Colombo, Kolkata

(UTC +05:45) Kathmandu

(UTC +06:00) Almaty, Bishkek, Dhaka, Thimphu

(UTC +06:00) Novosibirsk, Omsk

(UTC +06:30) Yangon (Rangoon)

(UTC +07:00) Bangkok, Ho Chi Minh, Hovd, Jakarta

(UTC +07:00)  Krasnoyarsk

(UTC +08:00) Beijing, Chongqing, Hong Kong, Shanghai

(UTC +08:00) Irkutsk

(UTC +08:00) Kuala Lumpur, Makassar, Manila, Singapore

(UTC +08:00) Taipei

(UTC +08:00) Ulaan Baatar

(UTC +09:00) Dili, Jayapura

(UTC +09:00) Pyongyang

(UTC +09:00) Seoul

(UTC +09:00) Tokyo

(UTC +09:00) Yakutsk

(UTC +10:00) Sakhalin, Vladivostok

Geographic Region Time Zone
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Asia (UTC +11:00) Magadan

(UTC +12:00) Anadyr, Kamchatka

Atlantic Ocean (UTC -04:00) Bermuda

(UTC -04:00) Stanley

(UTC -02:00) South Georgia Island

(UTC -01:00) Azores, Scoresbysund

(UTC -01:00) Cape Verde

(UTC) Reykjavik 

Australia (UTC +08:00) Perth

(UTC +08:45) Eucla

(UTC +09:30) Adelaide

(UTC +09:30) Darwin

(UTC +10:00) Brisbane, Lindeman

(UTC +10:00) Hobart, Melbourne, Sydney

(UTC +10:30) Lord Howe Island

Europe (UTC) Dublin, Edinburgh, Lisbon, London

(UTC +01:00) Amsterdam, Berlin, Rome, Stockholm, Vienna

(UTC +01:00) Belgrade, Bratislava, Budapest, Prague

(UTC +01:00) Brussels, Copenhagen, Madrid, Paris

(UTC +01:00) Sarajevo, Skopje, Warsaw, Zagreb

(UTC +02:00) Athens, Bucharest, Istanbul

(UTC +02:00) Helsinki, Kiev, Riga, Sofia

(UTC +02:00) Kaliningrad, Minsk

(UTC +03:00) Moscow

(UTC +04:00) Samara

Indian Ocean (UTC +03:00) Antananarivo, Comoro Islands, Mayotte

(UTC +04:00) Mahe, Reunion

(UTC +04:00) Mauritius

(UTC +05:00) Kerguelen, Maldives

(UTC +06:00) Chagos

(UTC +06:30) Cocos Islands

(UTC +07:00) Christmas Island

Geographic Region Time Zone
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5 Ensure that Please Enter Date appears. Specify the current date, and then press the  (set) button.

6 Ensure that Please Enter Time appears. Specify the current time, and then press the  (set) button.

7 Press the  (set) button for Fax Setup.

If you want to skip the Fax Setup, press the  (Start) button and then restart the printer.

8 Ensure that Please Enter Fax Number appears. Enter your fax number, and then press the  (set) 
button.

9 Ensure that Enter Fax Header Name appears. Enter a name, and then press the  (set) button.

10 Press the  (set) button, and then restart the printer.

Printer Setup Using the Software and Documentation Disc
1 Insert the Software and Documentation disc into your computer to start Dell Printer Easy Install.

2 Double-click the Dell C1765 Installer icon, and follow the on-screen instructions to connect the computer and 
the printer.

 NOTE: If the Software and Documentation disc does not automatically launch, try the following steps.

For Windows® XP, Windows Vista®, Windows 7, Windows Server® 2003, Windows Server 2008, and Windows Server 
2008 R2:

1 Click Start → All Programs (for Windows Vista and Windows 7) → Accessories (for Windows Vista and 
Windows 7) → Run.

2 Type D:\setup.exe (where D is the drive letter of the optical drive), and then click OK.

For Windows 8, Windows 8.1, Windows Server 2012 and Windows Server 2012 R2:

1 Point to the bottom right corner of the screen, and then click Search → Type Run in the search box, click Apps, 
and then click Run.

2 Type D:\setup.exe (where D is the drive letter of the optical drive), and then click OK.

Pacific Ocean (UTC -11:00) Midway Island, Niue, Samoa

(UTC -10:00) Cook Islands, Hawaii, Tahiti

(UTC -09:30) Marquesas Islands

(UTC -09:00) Gambier Islands

(UTC -08:00) Pitcairn Islands

(UTC -06:00) Easter Island

(UTC -06:00) Galapagos Islands

(UTC +09:00) Palau

(UTC +10:00) Guam, Port Moresby, Saipan

(UTC +11:00) Efate, Guadalcanal, Kosrae

(UTC +11:30) Norfolk Island

(UTC +12:00) Auckland

(UTC +12:00) Fiji, Marshall Islands

(UTC +12:45) Chatham

(UTC +13:00) Tongatapu

(UTC +14:00) Kiritimati 

Geographic Region Time Zone
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Setting the IP Address

Assigning an IP Address
An IP address is a unique number that consists of four sections that are delimited by a period and can include up to 
three digits in each section, for example, 111.222.33.44.

You can select the IP mode from Dual Stack and IPv4. If your network supports both IPv4 and IPv6, select Dual 
Stack.

 CAUTION: Assigning an IP address that is already in use can cause network performance issues.

 NOTE: Assigning an IP address is considered as an advanced function and is normally done by a system administrator.

 NOTE: When you assign an IP address manually in IPv6 Mode, use the Dell™ Printer Configuration Web Tool. To open the Dell 
Printer Configuration Web Tool, use the link local address. To check a link local address, see "Verifying the IP Settings" on 
page 55.

 NOTE: Depending on the address class, the range of the IP address assigned may be different. On Class A, for example, an IP 
address in the range from 0.0.0.0 to 127.255.255.255 will be assigned. For assignment of IP addresses, contact 
your system administrator. 

You can assign the IP address by using the operator panel or using the Tool Box.

The Operator Panel
For more information on using your operator panel, see "Operator Panel" on page 91.

 NOTE: A password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter the 
password you specified, and press the  (Set) button.

1 Turn on the printer.

Ensure that Ready to Copy appears on the operator panel.

2 Press the  (Menu) button.

3 Press the  button until System appears, and then press the  (set) button.

4 Press the  button until Admin Menu appears, and then press the  (set) button.

5 Press the  button until Network appears, and then press the  (set) button.

6 Press the  button until TCP/IP appears, and then press the  (set) button.

7 Press the  button until IPv4 appears, and then press the  (set) button.

8 Ensure that Get IP Address appears, and then press the  (set) button.

9 Press the  button until Panel appears, and then press the  (set) button.

10 Press the  button and ensure that Get IP Address appears.

11 Press the  button until IP Address appears, and then press the  (set) button.

The cursor is located at the first three digits of the IP address.

12 Enter the value of the IP address using the numeric keypad.

13 Press the  button.

The next three digits are highlighted.

14 Repeat step 12 and step 13 to enter all of the digits in the IP address, and then press the  (set) button.

15 Press the  button and ensure that IP Address appears.
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16 Press the  button until Subnet Mask appears, and then press the  (set) button.

The cursor is located at the first three digits of the subnet mask.

17 Enter the value of the subnet mask using the numeric keypad.

18 Press the  button.

The next three digits are highlighted.

19 Repeat step 17 and step 18 to set subnet mask, and then press the  (set) button.

20 Press the  button and ensure that Subnet Mask appears.

21 Press the  button until Gateway Address appears, and then press the  (set) button.

The cursor is located at the first three digits of the gateway address.

22 Enter the value of the gateway address using the numeric keypad.

23 Press the  button.

The next three digits are highlighted.

24 Repeat step 22 and step 23 to set gateway address, and then press the  (set) button.

25 Turn off and turn on the printer.

The Tool Box

 NOTE: When you use IPv6 Mode for network printing, the Tool Box cannot be used to assign an IP address.

1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Tool Box.

 NOTE: The Select Printer dialog box opens in this step, when multiple printer drivers are installed on your computer. In this 
case, click the name of Dell C1765nf Color Multifunction Printer or Dell C1765nfw Color Multifunction Printer listed in 
Printer Name.

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select TCP/IP Settings from the list at the left side of the page.

The TCP/IP Settings page is displayed.

4 Select the mode from IP Address Mode, and then enter the values in IP Address, Subnet Mask, and Gateway 
Address.

5 Press the Apply New Settings button to take effect.

The IP address is assigned to your printer. To verify the setting, open the web browser on any computer connected to 
the network and enter the IP address into the address bar on the browser. If the IP address is set up correctly, the Dell 
Printer Configuration Web Tool displays in your browser.

You can also assign the IP address to the printer when installing the printer drivers with installer. When you use the 
Wireless or Ethernet Connection feature, and the Get IP Address is set to Auto IP on the operator panel 
menu, you can set the IP address from 0.0.0.0 to the desired IP address on the printer selection window. 
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Verifying the IP Settings
You can confirm the settings by using the operator panel, printing the printer settings report, or using the ping 
command.

 NOTE: A password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter the 
password you specified, and press the  (Set) button.

The Operator Panel
1 Press the (Menu) button.

2 Press the  button until System appears, and then press the  (set) button.

3 Press the  button until Admin Menu appears, and then press the  (set) button.

4 Press the  button until Network appears, and then press the  (set) button.

5 Press the  button until TCP/IP appears, and then press the  (set) button.

6 Press the  button until IPv4 appears, and then press the  (set) button.

Check the IP address displayed on the operator panel.

The System Settings Report
1 Print the system settings report.

For details about how to print a system settings report, see "Printing a Report/List Using the Operator Panel" on 
page 175.

2 Verify the correct IP address, subnet mask, and gateway address are listed in the system settings report under Wired 
Network or Wireless Network.

If the IP address shows 0.0.0.0 (the factory default), an IP address has not been assigned. To assign one for your 
printer, see "Assigning an IP Address" on page 53.

The Ping Command
Ping the printer and verify that it responds. For example, at a command prompt on a network computer, type ping 
followed by the new IP address (for example, 192.168.0.11):
ping 192.168.0.11
If the printer is active on the network, you will receive a reply.
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9
Loading Paper

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

 NOTE: To avoid paper jams, do not remove the priority sheet inserter while a printing is in progress.

 NOTE: Use only laser print media. Do not use ink jet paper in your printer.

 NOTE: For printing envelopes, see "Loading Print Media" on page 211.

Loading Print Media in the Multipurpose Feeder (MPF)
1 Open the front cover by pulling out the instruction sheet.

2 Pull the PSI out.
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3 Remove the instruction sheet attached to the PSI with adhesive tape.

 NOTE: Read the instruction sheet before you use the PSI.

4 Pull the length guide forward until it stops.

5 Pull the MPF extension forward until it stops.
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6 Adjust the paper width guides to their maximum.

7 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack 
on a level surface.

8 Load paper on the MPF with the top edge first and with the recommended print side facing up.
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9 Adjust the width guides and length guides until they rest lightly against the edges of the stack of print media.

10 Slide the length guide towards the printer until it touches the print media.

 NOTE: Depending on the size of print media, first slide the MPF extension backward until it stops, and then pinch the 
length guide and slide it backward until it touches print media.
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11 Insert the PSI into the printer and then align the PSI to the marking on the paper tray.

12 Select the paper type from the printer driver if the loaded print media is not standard plain paper. 
If a user-specified print media is loaded in the MPF, you must specify the paper size setting by using the printer 
driver.
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Loading Print Media in the Priority Sheet Inserter (PSI)
1 Open the front cover.

2 Slide the PSI forward, and then align the PSI to the marking on the paper tray.

3 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack 
on a level surface.
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4 Load print media on the PSI with the top edge first and with the recommended print side facing up.

5 Adjust the width guides until they rest lightly against the edges of the stack of print media.

6 Select the paper type from the printer driver if the loaded print media is not standard plain paper. 
If a user-specified print media is loaded in the PSI, you must specify the paper size setting by using the printer 
driver.
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Installing Printer Drivers on Computers Running 
Windows®

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

Identifying Printer Driver Pre-install Status
Before installing the printer driver on your computer, check the IP address of your printer by performing one of the 
procedures in "Verifying the IP Settings" on page 55.

Changing the firewall settings before installing your printer
If you are running one of the following operating systems, you must change the firewall settings before installing the 
Dell printer software:

• Microsoft® Windows XP

• Windows Vista®

• Windows 7

• Windows 8

• Windows 8.1

• Windows Server® 2008

• Windows Server 2008 R2

• Windows Server 2012

• Windows Server 2012 R2

 NOTE: For Windows XP, Service Pack 2 or 3 must be installed.

The following procedure uses Windows 7 as an example.

1 Insert the Software and Documentation disc into your computer.

2 Click Start → Control Panel.

3 Select System and Security.

4 Click Allow a program through Windows Firewall.

5 Click Change settings → Allow another program.

6 Check Browse.

7 D:\setup.exe (where D is the drive letter of the optical drive) in the File name text box, and then click Open.

8 Click Add, and then click OK.

Direct Connection Setup

For installing host-based printer driver
1 Insert the Software and Documentation disc into your computer to start Dell Printer Easy Install.

2 Ensure that the printer is connected to the computer using the USB cable and the printer is turned on.

3 Click Connect.
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4 Select USB Cable Connection, and then click Next.

The Plug and Play installation starts and the required driver and software are automatically installed.

5 Click Finish to exit the wizard when the Ready to Print screen appears. If necessary, click Print Test Page to print a 
test page.

USB Cable Connection

A personal printer is a printer attached to your computer or a print server using a USB. If your printer is attached to 
a network and not your computer, see "Network Connection Setup" on page 68.

For installing XML Paper Specification (XPS) printer driver

 NOTE: Download and install the XPS printer driver at www.dell.com/support.

 NOTE: The XPS driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit Edition, Windows 
7, Windows 7 64-bit Edition, Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit Edition, Windows Server 
2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows Server 2012 and Windows Server 2012 R2.

Windows Vista or Windows Vista 64-bit Edition

1 Extract the zip file you downloaded to your desired location.

2 Click Start → Control Panel → Hardware and Sound → Printers.

3 Click Add a printer.

4 Click Add a local printer.

5 Select the port connected to this product, and then click Next.

6 Click Have Disk to display the Install From Disk dialog box.

7 Click Browse, and then select the extracted folder in step 1.

8 Click OK.

9 Select your printer name and click Next. 

10 To change the printer name, enter the printer name in the Printer name box. To use this printer as the default 
printer, select the check box displayed under the Printer name. Click Next.

Installation starts.

If the User Account Control dialog box appears, click Continue.

 NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action.

11 As the driver installation is completed, click Print a test page to print a test page.

12 Click Finish.

Windows Server 2008 or Windows Server 2008 64-bit Edition

 NOTE: You must log in as an administrator.

1 Extract the zip file you downloaded to your desired location.

2 Click Start → Control Panel → Hardware and Sound → Printers.

3 Click Add a printer.

4 Click Add a local printer.

5 Select the port connected to this product, and then click Next.

6 Click Have Disk to display the Install From Disk dialog box.

7 Click Browse, and then select the extracted folder in step 1.

http://www.dell.com/support
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8 Click OK.

9 Select your printer name and click Next. 

10 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box. Click Next.

Installation starts.

11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next.

12 As the driver installation is completed, click Print a test page to print a test page. 

13 Click Finish.

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2

1 Extract the zip file you downloaded to your desired location.

2 Click Start → Devices and Printers.

3 Click Add a printer.

4 When you use Windows Server 2008 R2, click Add a local or network printer as an administrator.

If the User Account Control dialog box appears, click Yes.

 NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

5 Click Add a local printer.

6 Select the port connected to this product, and then click Next.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted folder in step 1.

9 Click OK.

10 Select your printer name and click Next. 

11 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

12 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next.

13 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box.

14 Click Finish.

Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit Edition, Windows Server 2012, or Windows Server 
2012 R2

1 Extract the zip file you downloaded to your desired location.

2 Right-click the bottom left corner of the screen, and then click Control Panel.

3 Click Hardware and Sound (Hardware for Windows Server 2012 and Windows Server 2012 R2) → Devices and 
Printers → Add a printer.

4 Click Have Disk to display the Install From Disk dialog box.

5 Click Browse, and then select the extracted folder in step 1.

6 Click OK.
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7 Select your printer name and click Next. 

8 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

9 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next.

10 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box.

11 Click Finish.

Network Connection Setup

Network Printer Setup on a Local Network

For installing host-based printer driver

1 Insert the Software and Documentation disc into your computer to start Dell Printer Easy Install.

2 Click Connect.

3 Select Wireless or Ethernet Connection, and then click Next.

4 Select Install printer on this computer, and then click Next.

5 Select the printer you want to install from the printer list, and then click Next. If the target printer is not displayed 
on the list, click the  (Refresh) button or click add printer to add a printer to the list manually. You may specify 
the IP address and port name at this point.

If you have installed this printer on the server computer, select I am setting up this printer on a server check box.

 NOTE: When using AutoIP, 0.0.0.0 is displayed in the installer. Before you can continue, you must enter a valid IP address.

 NOTE: If you are running any of the following operating systems, a Windows Security Alert is displayed:

• Windows Vista

• Windows Vista 64-bit Edition

• Windows 7

• Windows 7 64-bit Edition

• Windows 8

• Windows 8 64-bit Edition

• Windows 8.1

• Windows 8.1 64-bit Edition

• Windows Server 2008

• Windows Server 2008 64-bit Edition

• Windows Server 2008 R2 64-bit Edition

• Windows Server 2012

• Windows Server 2012 R2

To continue installing the host-based printer driver, click Unblock or Allow access (for Windows Server 2008 R2 
and Windows 7).

6 Specify the printer settings, and then click Next.

a Enter the printer name.

b If you want other users on the network to access this printer, select Share this printer with other computers on 
the network, and then enter a share name that users can identify.
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c If you want to set a printer as the default, select the Set this printer as default check box.

7 Select the software and documentation you want to install, and then click Install. You can specify folders in which 
to install the Dell software and documentation. To change the folders, click Change Destination Folder.

8 Click Finish to exit the wizard when the Ready to Print screen appears. If necessary, click Print Test Page to print a 
test page.

For installing XML Paper Specification (XPS) printer driver

 NOTE: Download and install the XPS printer driver at www.dell.com/support.

 NOTE: The XPS driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit Edition, Windows 
7, Windows 7 64-bit Edition, Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit Edition, Windows Server 
2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows Server 2012 and Windows Server 2012 R2.

Windows Vista or Windows Vista 64-bit Edition

1 Extract the zip file you downloaded to your desired location.

2 Click Start → Control Panel → Hardware and Sound → Printers.

3 Click Add a printer.

4 Click Add a network, wireless or Bluetooth printer.

5 Select printer or click The printer that I want isn't listed.

6 Select Add a printer using a TCP/IP address or hostname, and then click Next.

7 Select TCP/IP Device for Device type, and enter the IP address for Hostname or IP address, and then click Next.

If the User Account Control Continue dialog box appears, click Continue.

 NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action.

8 Click Have Disk to display the Install From Disk dialog box.

9 Click Browse, then select the extracted folder in step 1, and then click OK.

10 Select your printer name and click Next.

11 To change the printer name, enter the printer name in the Printer name box, and then click Next.

To use this printer as the default printer, select the Set as the default printer check box.

Installation starts.

If the User Account Control dialog box appears, click Continue.

 NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action.

12 As the driver installation is completed, click Print a test page to print a test page.

13 Click Finish.

Windows Server 2008 or Windows Server 2008 64-bit Edition

 NOTE: You must log in as an administrator.

1 Extract the zip file you downloaded to your desired location.

2 Click Start → Control Panel → Hardware and Sound → Printers.

3 Click Add a printer.

4 Click Add a network, wireless or Bluetooth printer.

http://www.dell.com/support 
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5 Select your printer or click The printer that I want isn't listed.

When you select your printer, go to step 8.

When you click The printer that I want isn't listed, go to step 6.

6 Select Add a printer using a TCP/IP address or hostname, and then click Next.

7 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.

If the User Account Control Continue dialog box appears, click Continue.

8 Click Have Disk to display the Install From Disk dialog box.

9 Click Browse, then select the extracted folder in step 1, and then click OK.

10 Select your printer name and click Next.

11 To change the printer name, enter the printer name in the Printer name box, and then click Next.

To use this printer as the default printer, select the Set as the default printer check box.

Installation starts.

12 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next.

13 As the driver installation is completed, click Print a test page to print a test page.

14 Click Finish.

Windows Server 2008 R2

1 Extract the zip file you downloaded to your desired location.

2 Click Start → Devices and Printers.

3 Click Add a printer.

4 Click Add a network, wireless or Bluetooth printer.

5 Select your printer or click The printer that I want isn't listed.

 NOTE: When you click The printer that I want isn't listed, Find a printer by name or TCP/IP screen appears where you can 
find your printer using your printer name or TCP/IP.

If the User Account Control dialog box appears, click Yes.

 NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

6 Click Have Disk to display the Install From Disk dialog box.

7 Click Browse, then select the extracted folder in step 1, and then click OK.

8 Select your printer name and click Next.

9 To change the printer name, enter the printer name in the Printer name box, and then click Next.

10 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it.

11 Click Next.

Installation starts.

12 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box.

13 Click Finish.
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Windows 7 or Windows 7 64-bit Edition

1 Extract the zip file you downloaded to your desired location.

2 Click Start → Devices and Printers.

3 Click Add a printer.

4 Click Add a network, wireless or Bluetooth printer.

5 Select your printer or click The printer that I want isn't listed.

When you select your printer, go to step 8.

When you click The printer that I want isn't listed, go to step 6.

6 Select Add a printer using a TCP/IP address or host name, and then click Next.

7 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.

If the User Account Control dialog box appears, click Yes.

 NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

8 Click Have Disk to display the Install From Disk dialog box.

9 Click Browse, then select the extracted folder in step 1, and then click OK.

10 Select your printer name and click Next.

11 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

12 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box.

13 Click Finish.

Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit Edition, Windows Server 2012 or Windows 
Server 2012 R2

1 Extract the zip file you downloaded to your desired location.

2 Right-click the bottom left corner of the screen, and then click Control Panel.

3 Click Hardware and Sound (Hardware for Windows Server 2012 and Windows Server 2012 R2) → Devices and 
Printers → Add a printer.

4 Click Have Disk to display the Install From Disk dialog box.

5 Click Browse, and then select the extracted folder in step 1.

6 Click OK.

7 Select your printer name and click Next. 

8 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

9 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next.

10 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box.

11 Click Finish.
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Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your 
desk. You can view and/or change the printer settings, monitor toner level, and acknowledge the timing of ordering 
replacement consumables. You can click the Dell supplies link for ordering supplies.

 NOTE: The Dell Printer Configuration Web Tool is not available when the printer is directly connected to a computer or a print 
server.

To launch the Dell Printer Configuration Web Tool, type the printer's IP address in your web browser. The printer 
configuration appears on the screen.

You can set up the Dell Printer Configuration Web Tool to send you an e-mail when the printer needs supplies or 
intervention.

To set up e-mail alerts:

1 Launch the Dell Printer Configuration Web Tool.

2 Click E-Mail Alert link.

3 Under E-Mail Server Settings, enter the Primary SMTP Gateway, Reply Address, and your or key operator's e-mail 
address in the e-mail list box.

4 Click Apply New Settings.

 NOTE: Connection pending until printer sends an alert is displayed on the SMTP server until an error occurs.

Network Printer Setup on a Remote Network

Before Installation

Before you start remote installation, perform the following procedures.

Allow Print Spooler to Accept Client Connections

 NOTE: This step is required for Windows XP 64-bit Edition, Windows Vista, Windows Vista 64-bit Edition, Windows 7, Windows 7 
64-bit Edition, Windows Server 2003, Windows Server 2003 x64 Edition, Windows Server 2008, Windows Server 2008 64-bit 
Edition, Windows Server 2008 R2.

For Windows XP 64-bit Edition, Windows Vista, Windows Server 2003, and Windows Server 2008:

1 Click Start → All Programs (for Windows Vista only) → Accessories (for Windows Vista only) → Run.

2 Type gpedit.msc, and then click OK.

3 Click Computer Configuration → Administrative Templates → Printers.

4 Right-click Allow Print Spooler to accept client connections and select Properties.

5 On the Setting tab, select Enabled, and then click OK.

6 Restart the computer.

For Windows Server 2008 R2 and Windows 7:

1 Click Start → All Programs (for Windows 7 only) → Accessories (for Windows 7 only) → Run.

2 Type gpedit.msc, and then click OK.

3 Click Computer Configuration → Administrative Templates → Printers.

4 Right-click Allow Print Spooler to accept client connections and select Edit.

5 Select Enabled, and then click OK.

6 Restart the computer.
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Share the Firewall File and Printer

 NOTE: This step is required for Windows XP, Windows XP 64-bit Edition, Windows Vista, Windows Vista 64-bit Edition, Windows 
7, Windows 7 64-bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, and Windows Server 2008 R2.

For Windows XP:

1 Click start → Control Panel.

2 Select Security Center.

3 Click Windows Firewall.

4 On the Exceptions tab, check the File and Printer Sharing check box, and then click OK.

For Windows Vista:

1 Click Start → Control Panel.

2 Select Security.

3 Click Windows Firewall.

4 Click Change settings.

5 Click Continue.

6 On the Exceptions tab, check the File and Printer Sharing check box, and then click OK.

For Windows Server 2008:

1 Click Start → Control Panel.

2 Double-click Windows Firewall.

3 Click Change settings.

4 On the Exceptions tab, check the File and Printer Sharing check box, and then click OK.

For Windows Server 2008 R2 and Windows 7:

1 Click Start → Control Panel.

2 Select System and Security.

3 Click Windows Firewall.

4 Click Allow a program or feature through Windows Firewall.

5 If the check boxes under Allowed programs and features: are dimmed, click Change settings.

6 Check the File and Printer Sharing check box. Home/Work (Private) or Public check box is automatically selected 
according to your settings.

If File and Printer Sharing Properties dialog box appears, click OK.

7 Click OK.
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Start Remote Registry

 NOTE: This step is required for Windows Vista, Windows Vista 64-bit Edition, Windows 7, Windows 7 64-bit Edition.

1 Click Start → Control Panel.

2 Select System and Maintenance (System and Security for Windows 7).

3 Click Administrative Tools.

4 Double-click Services.

5 Click Continue (for Windows Vista only).

6 Right-click Remote Registry and select Start.

7 Right-click Remote Registry and select Properties.

8 Change Startup type: to Automatic, and then click OK.

Disable User Account Control

 NOTE: Disabling the User Account Control might leave the system vulnerable to virus attacks.

 NOTE: This step is required for Windows Vista, Windows Vista 64-bit Edition, Windows 7, Windows 7 64-bit Edition, Windows 
Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2.

For Windows Vista:

1 Click Start → Control Panel.

2 Select User Accounts and Family Safety.

3 Click User Accounts.

4 Click Turn User Account Control on or off.

5 Click Continue.

6 Clear the Use User Account Control (UAC) to help protect your computer check box.

7 Restart the computer.

For Windows Server 2008:

1 Click Start → Control Panel.

2 Double-click User Accounts.

3 Click Turn User Account Control on or off.

4 Click Continue.

5 Clear the Use User Account Control (UAC) to help protect your computer check box.

6 Click OK.

7 Restart the computer.

For Windows Server 2008 R2:

1 Click Start → Control Panel.

2 Select User Accounts.

3 Click User Accounts.

4 Click Change User Account Control Settings.

5 Move the slider to the bottom, and then click OK.

6 Click Yes.

7 Restart the computer.
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For Windows 7:

1 Click Start → Control Panel.

2 Select User Accounts and Family Safety.

3 Click User Accounts.

4 Click Change User Account Control Settings.

5 Move the slider to the bottom, and then click OK.

6 Click Yes in User Account Control dialog box.

7 Restart the computer.

Enable Network Discovery and File Sharing for all Public Networks

 NOTE: This step is required when you use Windows Vista, Windows Vista 64-bit Edition, Windows 7, Windows 7 64-bit Edition, 
Windows Server 2008, Windows Server 2008 64-bit Edition, and Windows Server 2008 R2 for the server computer.

For Windows 7, Windows 7 64-bit Edition, Windows Server 2008 R2:

1 Click Start → Control Panel → Network and Internet → Network and Sharing Center → Change advanced 
sharing settings.

2 To allow your computer to be found on the network, and to allow other computers on the network to share the files 
and folders on your computer, click Turn on network discovery.

3 Click Save changes.

4 If you see the User Account Control dialog box, click Yes.

For Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition:

1 Click Start → Network.

2 Right-click Network and select Properties.

The Network an Sharing Center screen appears.

3 Click the down arrow button next to either Network discovery.

4 To allow your computer to be found on the network, and to allow other computers on the network to share the files 
and folders on your computer, click Turn on network discovery.

5 Click Apply.

6 If the User Account Control dialog box appears, click Continue. 

Disable Simple File Sharing

 NOTE: This step is required for Windows XP, and Windows XP 64-bit Edition.

1 Click Start → Control Panel.

2 Select Appearance and Themes.

3 Select Folder Options.

4 On the View tab, clear the Use simple file sharing (Recommended) check box, and then click OK.

5 Click Start → Control Panel.

6 Select Performance and Maintenance.

7 Select Administrative Tools.

8 Double-click Local Security Policy.

9 Click Local Policies → Security Options.

10 Right-click Network access: Sharing and security model for local accounts and select Properties.
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11 Ensure that Classic - local users authenticate as themselves is selected.

12 Click OK.

Installing the Printer Driver

 NOTE: Installation on Windows XP Home Edition, Windows Vista Home Basic, Windows Vista Home Premium, Windows Vista 
x64 Home Basic, Windows Vista x64 Home Premium, Windows 7 Starter, Windows 7 Home Basic, Windows 7 Home Premium, 
Windows 7 x64 Home Basic, Windows 7 x64 Home Premium, Windows 8, Windows 8 x64, Windows 8 Pro, Windows 8 x64 Pro, 
Windows 8.1, Windows 8.1 x64, Windows 8.1 Pro, Windows 8.1 x64 Pro, Windows Server 2012, and Windows Server 2012 R2 is 
not supported.

1 Insert the Software and Documentation disc provided with the printer in your computer. The Dell Printer Easy 
Install file launches automatically.

2 Click Connect.

The Choose a Method of Connection screen appears.

3 Select Wireless or Ethernet Connection, and then click Next.

4 Select Install printer on one or more computers, and then click Next.

5 Enter the Administrator user name and password of the client computer, then select the clients or servers, and then 
click Next.

 NOTE: If you are running any of the following operating systems, a Windows Security Alert is displayed:

• Windows Vista

• Windows Vista 64-bit Edition

• Windows 7

• Windows 7 64-bit Edition

• Windows Server 2008

• Windows Server 2008 64-bit Edition

• Windows Server 2008 R2 64-bit Edition

To continue installing the host-based printer driver, click Unblock or Allow access (for Windows Server 2008 R2 
and Windows 7).

6 Check if the printer to be installed is listed in Select Printer, and then click Next.

 NOTE: If the printer to be installed is not listed in Select Printer, try the following steps:

• Click Refresh to update the information.

• Click add printer, and then enter a port name (any alphanumeric string of your choosing) and an existing IP address for 
the printer.

7 Select the required items on Install Printer Driver and Software, and then click Install.

8 Click Finish to exit this tool.

Setting Up for Web Services on Devices (WSD)
This section provides information for network printing with WSD, the protocol of Microsoft for Windows Vista, 
Windows 7, Windows 8, Windows 8.1, Windows Server 2008, Windows Server 2008 R2, Windows Server 2012, and 
Windows Server 2012 R2.

Adding Roles of Print Services
When you use Windows Server 2008, Windows Server 2008 R2, Windows Server 2012, or Windows Server 2012 R2, 
you need to add the roles of print services to the Windows Server 2008, Windows Server 2008 R2, Windows Server 
2012, or Windows Server 2012 R2 client.
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For Windows Server 2008 R2:

1 Click Start → Administrative Tools → Server Manager.

2 Select Add Roles from the Action menu.

3 Check the Print and Document Services check box on the Server Roles window in the Add Roles Wizard, and 
then click Next.

4 Click Next.

5 Check the Print Server check box, and then click Next.

6 Click Install.

For Windows Server 2008:

1 Click Start → Administrative Tools → Server Manager.

2 Select Add Roles from the Action menu.

3 Check the Print Services check box on the Server Roles window in the Add Roles Wizard, and then click Next.

4 Check the Print Server check box, and then click Next.

5 Click Install.

For Windows Server 2012, Windows Server 2012 R2: 

1 Click Server Manager of the Start screen.

2 Select Add Roles and Features from the Manage menu.

3 Click Next on the Before You Begin window → Select installation type on the Installation Type window → Select 
destination server on the Server Selection window in the Add Roles and Features Wizard.

4 Check the Print and Document Services check box on the Server Roles window, and then click Next.

5 Select features on the Features window → Confirm installation selections on the Confirmation window.

6 Click Install.

WSD Printer Setup
You can install your new printer on the network using Windows Add Printer wizard. When installing using the 
Software and Documentation disc that shipped with your printer, see "Network Connection Setup" on page 68 for 
details. 

 NOTE: Installing WSD printer for Windows 8, Windows 8.1, Windows Server 2008, Windows Server 2008 R2, Windows Server 
2012, and Windows Server 2012 R2 is available only with the Add Printer wizard.

Installing a Printer Driver Using the Add Printer Wizard

1 For Windows Vista, Windows 7, Windows Server 2008, and Windows Server 2008 R2:
Click Start → Devices and Printers (Start → Control Panel → Hardware and Sound → Printers for Windows 
Server 2008 and Windows Vista).

For Windows 8, Windows 8.1, Windows Server 2012, and Windows Server 2012 R2:
Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound (Hardware 
for Windows Server 2012 and Windows Server 2012 R2) → Devices and Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer.

4 In the list of available printers, select the one you want to use, and then click Next.

 NOTE: In the list of available printers, the WSD printer is displayed in the form of http://IP address/ws/. 



78 Installing Printer Drivers on Computers Running Windows®

 NOTE:  If no WSD printer is displayed in the list, enter the printer's IP address manually to create a WSD printer. To enter 
the printer's IP address manually, follow the instructions below. For Windows Server 2008 R2, to create a WSD printer, you 
must be a member of Administrators group.
1. Click The printer that I want isn't listed.
2. Select Add a printer using a TCP/IP address or hostname and click Next.
3. Select Web Services Device from Device type.
4. Enter the printer's IP address in the Hostname or IP address text box and click Next.

 NOTE: Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, perform one of 
the followings:

• Establish the Internet connection so that Windows Update can scan your computer.

• Add the printer driver to your computer in advance.

5 Install the printer driver on your computer. If you are prompted for an administrator password or confirmation, 
type the password or provide confirmation.

6 Complete the additional steps in the wizard, and then click Finish.

7 Print a test page to verify print installation.

a For Windows Vista, Windows 7, Windows Server 2008, and Windows Server 2008 R2:
Click Start → Devices and Printers (Start → Control Panel → Hardware and Sound → Printers for 
Windows Server 2008 and Windows Vista).

For Windows 8, Windows 8.1, Windows Server 2012, and Windows Server 2012 R2:
Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound 
(Hardware for Windows Server 2012 and Windows Server 2012 R2) → Devices and Printers.

b Right-click the printer you just created, and then click Printer properties (Properties for Windows Server 2008 
and Windows Vista).

c On the General tab, click Print Test Page. When a test page is printed successfully, installation is complete.

Setting Up for Shared Printing
You can share your new printer on the network using the Software and Documentation disc that shipped with your 
printer, or using Windows Point and Print or peer-to-peer method. However, if you use either of the Microsoft 
methods you will not get features such as the status monitor and other printer utilities, which will get installed with 
the Software and Documentation disc.

If you want to use the printer on a network, share the printer and install its drivers on all the computers on the 
network.

 NOTE: You need to purchase the Ethernet cable separately for shared printing.

For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, Windows Server 2003 x64 Edition

1 Click Start → Printers and Faxes.

2 Right-click this printer icon and select Properties.

3 From the Sharing tab, check the Share this printer check box, and then type a name in the Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients using this printer.

5 Click OK.

If the files are not present in your computer, then you will be prompted to insert the server operating system CD.

For Windows Vista, Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon and select Sharing.
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3 Click Change sharing options.

4 The "Windows needs your permission to continue" appears.

5 Click Continue.

6 Select the Share this printer check box, and then type a name in the Share name text box.

7 Select Additional Drivers and select the operating systems of all network clients using this printer.

8 Click OK.

For Windows Server 2008, Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon and select Sharing.

3 Click Change Sharing Options if exists.

4 Select the Share this printer check box, and then type a name in the Share name text box.

5 Click Additional Drivers and select the operating systems of all network clients using this printer.

6 Click OK.

For Windows 7, Windows 7 64-bit Edition, Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, click Change Sharing Options if exists.

4 Select the Share this printer check box, and then type a name in the Share name text box.

5 Click Additional Drivers and select the operating systems of all network clients using this printer.

6 Click Apply, and then click OK.

For Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit Edition, Windows Server 2012, Windows Server 
2012 R2

1 Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound (Hardware 
for Windows Server 2012 and Windows Server 2012 R2) → Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, click Change Sharing Options if exists.

4 Select the Share this printer check box, and then type a name in the Share name text box.

5 Click Additional Drivers and select the operating systems of all network clients using this printer.

6 Click Apply, and then click OK.

To check that the printer is shared:

• Ensure that the printer object in the Printers, Printers and Faxes, or Devices and Printers folder is shared. The 
share icon is shown under the printer icon.

• Browse Network or My Network Places. Find the host name of the server and look for the shared name you 
assigned to the printer.

Now that the printer is shared, you can install the printer on network clients using the Point and Print method or the 
peer-to-peer method.
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Point and Print
Point and Print is a Microsoft Windows technology that allows you to connect to a remote printer. This feature 
automatically downloads and installs the printer driver.

For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, Windows Server 2003 x64 Edition

1 On the Windows desktop of the client computer, double-click My Network Places.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Printers and Faxes folder. The time taken to copy varies based on the network traffic.

Close My Network Places.

4 Print a test page to verify installation.

a Click start (Start for Windows Server 2003 / Windows Server 2003 x64 Edition) → Settings (for Windows XP 
/ Windows XP 64-bit Edition) → Printers and Faxes.

b Select the printer you have installed.

c Click File → Properties.

d On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.

For Windows Vista, Windows Vista 64-bit Edition

1 Click Start → Network.

2 Locate and double-click the host name of the server computer.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Click Continue in User Account Control dialog box.

Wait until the driver is copied from the server to the client computer. A new printer object is added to the Printers 
folder. The duration of this procedure may vary based on the network traffic.
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6 Print a test page to verify installation.

a Click Start → Control Panel → Hardware and Sound.

b Select Printers.

c Right-click the printer you just created and select Properties.

d On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.

For Windows Server 2008, Windows Server 2008 64-bit Edition

1 Click Start → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait until the driver is copied from the server to the client computer. A new printer object will be added to the 
Printers folder. The time taken for these activities varies based on network traffic.

6 Print a test page to verify installation.

a Click Start → Control Panel.

b Select Printers.

c Right-click the printer you just created and select Properties.

d On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.

For Windows 7, Windows 7 64-bit Edition, Windows Server 2008 R2

1 Click Start → your user name → Network (Start → Network for Windows Server 2008 R2).

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait until the driver is copied from the server to the client computer. A new printer object will be added to the 
Printers folder. The time taken for these activities varies based on network traffic.

6 Print a test page to verify installation.

a Click Start → Devices and Printers.

b Right-click the printer you just created and select Printer properties.

c On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.

For Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit Edition, Windows Server 2012, Windows Server 
2012 R2

1 Point to the bottom right corner of the screen, and then click Search → Type Network in the search box, click 
Apps, and then click Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.
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5 Wait until the driver is copied from the server to the client computer. A new printer object will be added to the 
Printers folder. The time taken for these activities varies based on network traffic.

6 Print a test page to verify installation.

a Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound 
(Hardware for Windows Server 2012 and Windows Server 2012 R2) → Devices and Printers.

b Right-click the printer you just created and select Printer properties.

c On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.

Peer-to-Peer
If you use the peer-to-peer method, the printer driver is installed on each client computer. The client computers can 
modify the drivers and handle the print jobs.

For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, Windows Server 2003 x64 Edition

1 Click start (Start for Windows Server 2003 / Windows Server 2003 x64 Edition) → Settings (for Windows XP / 
Windows XP 64-bit Edition) Printers and Faxes.

2 Click Add a Printer to launch the Add Printer wizard.

3 Click Next.

4 Select A network printer, or a printer attached to another computer, and then click Next. If the printer is not 
listed, type in the path of the printer in the text box.

The server host name is the name of the server computer that identifies it to the network. The shared printer name 
is the name assigned during the server installation process.

5 Click Browse for a printer, and then click Next.

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, specify the 
location where the driver is available.

6 Select Yes if you want this printer to be set as the default printer, and then click Next.

If you want to verify installation, click Yes to print a test page.

7 Click Finish.

When a test page prints successfully, installation is complete.

For Windows Vista, Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a Printer to launch the Add Printer wizard.

For example:\\<server host name>\<shared printer name>
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3 Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and type in the path of the printer in the Select a 
shared printer by name text box and click Next.

The server host name is the name of the server computer that identifies it on the network. The shared printer 
name is the name assigned during the server installation process.

4 If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, specify the 
location where the driver is available.

5 Select Yes if you want this printer to be set as the default printer, and then click Next.

6 If you want to verify installation, click Print a test page.

7 Click Finish.

When a test page is printed successfully, installation is complete.

For Windows Server 2008, Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and type in the path of the printer in the Select a 
shared printer by name text box and click Next.

For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it on the network. The shared printer 
name is the name assigned during the server installation process.

4 If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, specify the 
location where the driver is available.

5 Select Yes if you want this printer to be set as the default printer, and then click Next.

6 If you want to verify installation, click Print a test page.

7 Click Finish.

When a test page is printed successfully, installation is complete.

For Windows 7, Windows 7 64-bit Edition, Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a Printer to launch the Add Printer wizard.

For example:\\<server host name>\<shared printer name>
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3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer and click Next, or 
select The printer that I want isn't listed. Click Select a shared printer by name and type in the path of the printer 
in the text box, and then click Next.

For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it to the network. The shared printer name 
is the name assigned during the server installation process.

4 If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, you need to 
specify the path to the available drivers.

5 Confirm the printer name, and then click Next.

6 Select Yes if you want this printer to be set as the default printer, and then click Next.

7 If you want to verify installation, click Print a test page.

8 Click Finish.

When a test page is printed successfully, installation is complete.

For Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit Edition, Windows Server 2012,  Windows Server 
2012 R2

1 Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound (Hardware 
for Windows Server 2012 and Windows Server 2012 R2) → Devices and Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer and click Next, or 
select The printer that I want isn't listed. Click Select a shared printer by name and type in the path of the printer 
in the text box, and then click Next.

For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it to the network. The shared printer name 
is the name assigned during the server installation process.

4 If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, you need to 
specify the path to the available drivers.

5 Confirm the printer name, and then click Next.

6 Select Yes if you want this printer to be set as the default printer, and then click Next.

7 If you want to verify installation, click Print a test page.

8 Click Finish.

When a test page is printed successfully, installation is complete.
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11
Installing Printer Drivers on Computers Running 
Macintosh

Installing the Drivers and Software
1 Run the Software and Documentation disc on the Macintosh computer.

2 Double-click the Dell C1765 Installer icon.

3 Click Continue on the Introduction screen.

4 Confirm the installation location, and then click Continue.

5 Click Install to perform the standard installation. 

6 Type the administrator's name and password, and then click Install Software.

7 Click Continue Installation.

8 Click Restart to finish installing the software.

Adding a Printer on Mac OS X 10.5 or Later Version(s)

When Using a USB connection

1 Turn on the printer.

2 Connect the USB cable between the printer and Macintosh computer.

3 For Mac OS X 10.5 and Mac OS X 10.6: Open the System Preferences, and click Print & Fax.

For Mac OS X 10.7 and Mac OS X 10.8: Open the System Preferences, and click Print & Scan.

For Mac OS X 10.9: Open the System Preferences, and click Printers & Scanners.

4 Click the Plus (+) sign, and click Default.

5 Select the printer connected via USB from the Printer Name list.

For Mac OS X 10.5, Mac OS X 10.6, and Mac OS X 10.7: Name and Print Using are automatically entered.

For Mac OS X 10.8 and Mac OS X 10.9: Name and Use are automatically entered.

6 Click Add.

When Using Bonjour

1 Turn on the printer.

2 Ensure that your Macintosh computer is connected to the network.

If you use wired connection, connect the Ethernet cable between the printer and the network.

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and printer.

3 For Mac OS X 10.5 and Mac OS X 10.6: Open the System Preferences, and click Print & Fax.

For Mac OS X 10.7 and Mac OS X 10.8: Open the System Preferences, and click Print & Scan.

For Mac OS X 10.9: Open the System Preferences, and click Printers & Scanners.
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4 Click the Plus (+) sign, and click Default (Click the Plus (+) sign, and select the printer from Nearby Printers. 
If there are no printers in Nearby Printers, select Add Other Printer or Scanner for Mac OS X 10.7 or select Add 
Printer or Scanner for Mac OS X 10.8 and Mac OS X 10.9).

5 Select the printer connected via Bonjour from the Printer Name list. 

For Mac OS X 10.5, Mac OS X 10.6, and Mac OS X 10.7: Name and Print Using are automatically entered.

For Mac OS X 10.8 and Mac OS X 10.9: Name and Use are automatically entered.

6 Click Add.

When Using IP Printing

1 Turn on the printer.

2 Ensure that your Macintosh computer is connected to the network.

If you use wired connection, connect the Ethernet cable between the printer and the network.

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and printer.

3 For Mac OS X 10.5 and Mac OS X 10.6: Open the System Preferences, and click Print & Fax.

For Mac OS X 10.7 and Mac OS X 10.8: Open the System Preferences, and click Print & Scan.

For Mac OS X 10.9: Open the System Preferences, and click Printers & Scanners.

4 Click the Plus (+) sign, and click IP.

5 Select Line Printer Daemon - LPD for Protocol.

6 Type the IP address for the printer in the Address area.

7 For Mac OS X 10.5, Mac OS X 10.6, and Mac OS X 10.7: Select the model of your printer for Print Using.

For Mac OS X 10.8 and Mac OS X 10.9: Select the model of your printer for Use.

 NOTE: When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it.

8 Click Add.

Adding a Printer on Mac OS X 10.4.11

When Using a USB Connection

1 Turn on the printer.

2 Connect the USB cable between the printer and Macintosh computer.

3 Start Printer Setup Utility.

 NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Click Default Browser in the Printer Browser dialog box.

6 Select the printer connected via USB from the Printer Name list.

Name and Print Using are automatically entered.

7 Click Add.

When Using Bonjour

1 Turn on the printer.

2 Ensure that your Macintosh computer is connected to the network.



Installing Printer Drivers on Computers Running Macintosh 87

If you use wired connection, connect the Ethernet cable between the printer and the network.

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and printer.

3 Start the Printer Setup Utility.

 NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Click Default Browser in the Printer Browser dialog box.

6 Select the printer connected via Bonjour from the Printer Name list.

Name and Print Using are automatically entered.

7 Click Add.

When Using IP Printing

1 Turn on the printer.

2 Ensure that your Macintosh computer is connected to the network.

If you use wired connection, connect the Ethernet cable between the printer and the network.

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and printer.

3 Start Printer Setup Utility.

 NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Click IP Printer in the Printer Browser dialog box.

6 Select Line Printer Daemon - LPD for Protocol.

7 Type the IP address for the printer in the Address area.

8 Select the model of your printer for Print Using.

 NOTE: When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it. 

9 Click Add.
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12
Operator Panel

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

Using the Operator Panel Buttons
The operator panel has a 4-line by 28-character liquid crystal display (LCD), light-emitting diodes (LED), control 
buttons, and numeric keypad, which allow you to control the printer.

1 One Touch Dial button

• Calls up the stored Fax number registered in the Phone Book. The first four fax numbers in the Phone Book 
are assigned to the buttons in row order, starting from the top corner.

2  (Copy) button

• Moves to the top level of the Copy menu.

3  (Fax) button

• Moves to the top level of the Fax menu.

4 Data LED

• Lights up for incoming, outgoing, or pending Fax jobs.

5 Ready / Error LED

• Lights up when the printer is ready. (Ready LED)

• Lights up when the printer has an error. (Error LED)

6  button

• Moves a cursor or highlight right or left. 

7  button

• Moves a cursor or highlight up or down. 

8  (Set) button

• Confirms the entry of values. 

9  (Contacts) button

• Moves to the Address Book menu for the Fax and Scan services.

10  (Re-dial / Pause) button

• Calls up the last telephone number the printer dialed.

• Pauses a telephone number.
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11  (Cancel) button

• Cancels the current processing or pending job.

12 B&W / Color LED

• Lights up to indicate which color mode is selected.

13  (Color Mode) button

• Switches between color mode and black and white mode. 

14  (Start) button

• Starts the job. 

15  (Backspace) button

• Deletes characters and numbers.

16  (Speed Dial) button

• Calls up a stored telephone number.

17 Numeric keypad

• Enters characters and numbers.

18 AC (All Clear) button

• Resets the current setting, and returns to the top menu. 

19  (Back) button

• Returns to the previous screen. 

20 LCD Panel

• Displays various settings, instructions, and error messages. 

21  (Scan) button

• Moves to the top level of the Scan menu. 

22  (Menu) button

• Moves to the top level of the Print From USB Memory, Job Status, and System menus.

23  (Wi-Fi | WPS) button (Dell C1765nfw Color Multifunction Printer only)

• Starts Wi-Fi Protected Setup® (Push Button Configuration). Lights up when it is activated, and blinks in 
certain conditions.

 NOTE: Moving to a different menu or returning to a previous screen cancels the current entry or setting. Make sure to press the 
 (Set) button to save the current entry or setting. 

 NOTE: For details on how to use the numeric keypad to enter alphanumeric characters, see "Using the Numeric Keypad to Enter 
Characters" on page 94.
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Status of Wi-Fi | WPS Button Backlight (Dell C1765nfw Color Multifunction Printer only)
This section describes when the backlight of the  (Wi-Fi | WPS) button lights up or blinks.

For more information, see "Wireless Problems (Dell C1765nfw Color Multifunction Printer only)" on page 364.

*1 You can enable/disable the Wi-Fi settings. For more information, see "Wi-Fi (Dell C1765nfw Color Multifunction Printer only)" on page 180.

Wi-Fi | WPS Button 
Backlight

Wi-Fi 
settings*1

Printer Status Error Message

Off N/A Connected to the network via Ethernet 
cable; Wi-Fi settings is not available 
when an Ethernet cable is connected to 
the printer.

-

Off - -

On The printer enters Sleep/Deep Sleep mode -

On On Wireless link established -

Blinking 
normal

On Searching for wireless LAN access point or 
router

-

Blinking 
slowly

On Searching/Connecting with WPS access 
point or router during wireless operation

-
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Using the Numeric Keypad to Enter Characters 
As you perform various tasks, you may need to enter names and numbers. For example, when you set up your printer, 
you enter your name or your company name and telephone number. When you store speed dial or group dial 
numbers, you may also need to enter the corresponding names.

• When prompted to enter a letter, press the appropriate button until the correct letter appears on the display.

For example, to enter the letter O, press 6.

– Each time you press 6, the display shows a different letter, M, N, O and finally 6.

– To enter additional letters, repeat the first step.

– Press the  (Set) button when you are finished.

Keypad Letters and Numbers

Changing Numbers or Names
If an incorrect name or number is entered, press the  (Backspace) button to delete the last digit or character. 
Then enter the correct number or character.

Inserting a Pause
For some telephone systems, it is necessary to dial an access code and listen for a second dial tone. A pause must be 
entered in order for the access code to function. For example, enter the access code 9 and then press the  
(Redial/Pause) button before entering the telephone number. "-" appears on the display to indicate when a pause is 
entered.

Key Assigned numbers, letters or characters

1 @  :  .  /  1

2 a  b  c  A  B  C  2

3 d  e  f  D  E  F  3

4 g  h  i G  H  I  4

5 j  k  l  J  K  L  5

6 m  n  o  M  N  O  6

7 p  q  r  s  P  Q  R  S  7

8 t  u  v  T  U  V  8

9 w  x  y  z  W  X  Y  Z  9

0 0

* -  _ ~

# @  .   _  !  "  #  $  %  &  ' ~^  |  `  ;  :  ? , (space)  +  -  *  /  =  (  )  [  ]  {  }  <  >



Operator Panel 95

Printing a Panel Settings Page
The panel settings page shows current settings for the printer menus. For details about how to print a panel settings 
report, see "Understanding the Printer Menus" on page 163.

Changing the Language
To display a different language on the operator panel:

The Operator Panel
1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Panel Language is highlighted, and then press the  (Set) button.

4 Press the  button until the desired language is highlighted, and then press the  (Set) button.

The Tool Box
1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Tool Box.

 NOTE: For details about starting the Tool Box, see "Starting the Tool Box" on page 139.

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select System Settings from the list at the left side of the page.

The System Settings page is displayed.

4 Select the desired language from Panel Language, and then click Apply New Settings.

Setting the Power Saving Timer Option
 NOTE: A password is required to enter the Admin Menu menu when Panel Lock Set is set to Enable. In this 

case, enter the password you specified, and press the  (Set) button.

You can set the power saving timer for the printer. The printer waits before it restores the default copy settings, if you 
do not start copying after changing them on the operator panel.

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until System Settings is highlighted, and then press the  (Set) button.

5 Ensure that Power Saving Timer is highlighted, and then press the  (Set) button.

6 Press the  button to select Sleep or Deep Sleep, and then press the  (Set) button.

7 Press the  or  button or enter the desired value using the numeric keypad, and then press the  (Set) 
button.

You can select from 5–30 minutes for Sleep or 1–6 minutes for Deep Sleep.

8 To return to the previous screen, press the  (Back) button.
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Dell™ Printer Configuration Web Tool

 NOTE: The images used in this manual are those of the Dell C1765nfw Color Multifunction Printer unless otherwise mentioned.

Overview
 NOTE: This web tool is available only when the printer is connected to a network.

One of the features of the Dell Printer Configuration Web Tool is the E-Mail Alert Setup, which sends an e-mail to 
you or the key operator when the printer needs supplies or intervention.

To fill out printer inventory reports requiring the asset tag number of all the printers in your area, use the Printer 
Information feature in the Dell Printer Configuration Web Tool. Enter the IP address of each printer on the 
network to display the asset tag number.

The Dell Printer Configuration Web Tool feature also allows you to change the printer settings and keep track of 
printing trends.

Setting Up the Dell Printer Configuration Web Tool
Ensure that you activate JavaScript in your browser before using the Dell Printer Configuration Web Tool.

It is recommended that you configure the environment settings of your web browser before using the Dell Printer 
Configuration Web Tool.

 NOTE: The Dell Printer Configuration Web Tool pages may be unreadable if the language differs from that of your web browser.

Setting Up From Web Browser
It is recommended that you configure both the environment settings of your web browser and the operator panel 
before using the Dell Printer Configuration Web Tool.
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For Internet Explorer®

Setting Up the Display Language

1 Select Internet Options from Tools on the menu bar.

2 Select Languages in the General tab.

3 Specify the display language in order of preference in the Language list.

For example:

• Italian (Italy) [it-IT]
• Spanish (Traditional Sort) [es-ES tradnl]
• German (Germany) [de-DE]
• French (France) [fr-FR]
• English (United States) [en-us]
• Danish [da-DK]
• Dutch (Netherlands) [nl-NL]
• Norwegian (Bokmal) [no]
• Swedish [sv-SE]

• Chinese (Simplified, PRC) [zh-CN]

Setting the IP Address of the printer to Non-Proxy

1 Select Internet Options from the Tools menu.

2 Click LAN Settings under Local Area Network (LAN) settings in the Connections tab.

3 You can configure the LAN settings in one of the following ways:

• Clear the Use a proxy server for your LAN check box under Proxy server.

• Click Advanced, and then specify the IP address of your printer in the Do not use proxy server for addresses 
beginning with field under Exceptions.

After setting the language and proxy, enter <http://nnn.nnn.nnn.nnn/> (the IP address of your printer) in 
the URL entry field of the browser to activate the Dell Printer Configuration Web Tool.

For Firefox®

Setting Up the Display Language

1 Select Options from the Tools menu.

2 Click Choose in the Content tab.

3 Specify the display language in order of preference in the Languages in order of preference list.

For example:

• English [en] or English/United States [en-us]

• Italian [it]
• Spanish [es]
• German [de]
• French [fr]
• Dutch [nl]
• Norwegian [no]
• Swedish [sv]
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• Danish [da]

• Chinese/China [zh-cn]

Setting the IP Address of the printer to Non-Proxy

1 Select Options from the Tools menu.

2 Click Advanced tab.

3 Click Network on the Options dialog box.

4 Click Connection → Settings.

5 You can configure the LAN settings in one of the following ways:

• Select the No Proxy check box, if you do not want to use a proxy.

• Select the Auto-detect proxy settings for this network check box.

• Select the Manual proxy configuration: check box, and then enter a hostname and a port number if you have 
a list of one or more proxy servers. If you have an IP address that does not use a proxy, enter the IP address of 
your printer in the No Proxy for: edit box. 

• Select the Automatic proxy configuration URL: check box.

After setting the language and proxy, enter <http://nnn.nnn.nnn.nnn/> (the IP address of your printer) in 
the URL entry field of the browser to activate the Dell Printer Configuration Web Tool.

Setting Up From Operator Panel
You can launch the Dell Printer Configuration Web Tool only when EWS is set to Enable (the factory default) on 
the operator panel. Check the operator panel setting if you cannot launch the Dell Printer Configuration Web Tool. 
For more information, see "Understanding the Printer Menus" on page 163.

Starting the Dell Printer Configuration Web Tool
To launch the Dell Printer Configuration Web Tool, enter the IP address of your printer in your web browser.

If you do not know the IP address of your printer, print the printer settings report or display the TCP/IP Settings 
page, which lists the IP address. For details about how to find your printer's IP address, see "Verifying the IP Settings" 
on page 55.

Overview of the Menu Items
Use the Dell Printer Configuration Web Tool for:

Printer Status

Use the Printer Status menu to get feedback on the printer status. When a toner cartridge is running low, click the 
order supplies link on the first screen to order an additional toner cartridge.

Printer Jobs

Use the Printer Jobs menu to contain information on the Job List page and Completed Jobs page.

These pages show the details of the status regarding each protocol or job.

Printer Settings

Use the Printer Settings menu to change printer settings and view the settings in the operator panel remotely.
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Print Server Settings

Use the Print Server Settings menu to change the type of printer interface and necessary conditions for 
communications.

Print Volume

Use the Print Volume option to check the number of pages printed for each paper size.

Address Book

Use the Address Book menu to view or edit the e-mail address, phone number, server address, and fax number 
entries in the Address Book, or to register new entries.

 NOTE: You must log in as an administrator to use this feature.

Printer Information

Use the Printer Information menu to display the information of your printer.

Tray Settings

Use the Tray Settings menu to get information about the paper size and type of paper loaded in the Multipurpose 
Feeder (MPF).

E-Mail Alert

Use the E-Mail Alert menu to receive an e-mail when the printer needs supplies or intervention. Enter your name or 
the key operator name in the e-mail list box to be notified. Set E-Mail Alert also when using the Scan to E-Mail 
feature.

Set Password

Use the Set Password menu to lock the Dell Printer Configuration Web Tool with a password so that other users do 
not inadvertently change the printer settings you selected.

 NOTE: You must log in as an administrator to use this feature.

Online Help

Click Online Help to visit the Dell Support web site.

Order Supplies at:
www.dell.com/supplies

Contact Dell Support at:
www.dell.com/support

http://www.dell.com/supplies
http://www.dell.com/support 
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Page Display Format
The layout of the page is divided into three sections.

Top Frame
The top frame is located on the top of all pages. When the Dell Printer Configuration Web Tool is activated, the 
current status and specifications of the printer are displayed in the top frame on every page. 

The following items are displayed in the top frame.

1 Dell C1765nfw Color MFP Displays the printer model name.

2 IP Address Displays the IP address of your printer.

3 Location Displays the location of the printer. The location can be changed in the Basic 
Information on the Print Server Settings page.

4 Contact Person Displays the administrator name of the printer. The name can be changed in the Basic 
Information on the Print Server Settings page.

5 Printer Bitmap Shows the bitmap image of the printer. The Printer Status menu appears in the right 
frame when you click the image.
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Left Frame
The left frame is located on the left side of all pages. The menu titles displayed in the left frame are linked to 
corresponding menus and pages. You can go to the corresponding page by clicking their characters.

The following menus are displayed in the left frame.

1 Printer Status Links to the Printer Status menu.

2 Printer Jobs Links to the Printer Jobs menu.

3 Printer Settings Links to the Printer Settings Report menu.

4 Print Server Settings Links to the Print Server Reports menu.

5 Print Volume Links to the Print Volume menu.

6 Address Book Links to the Address Book menu.

7 Printer Information Links to the Printer Status menu.

8 Tray Settings Links to the Tray Settings menu.

9 E-Mail Alert Links to the Print Server Settings menu.

10 Set Password Links to the Security menu.

11 Online Help Links to the Dell Support website. 

12 Order Supplies at: Links to the Dell web page.

13 Contact Dell Support at: Links to the Dell support page web address.
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Right Frame
The right frame is located on the right side of all pages. The contents of the right frame correspond to the menu that 
you select in the left frame. For details on the items displayed in the right frame, see "Details of the Menu Items" on 
page 104.

Buttons in the Right Frame

1 Refresh button Receives the current printer configuration and updates the latest information in the right 
frame.

2 Apply New Settings button Submits new settings made on the Dell Printer Configuration Web Tool to the printer. 
The new settings replace the old settings of the printer.

3 Restore Settings button Restores the old settings. New settings will not be submitted to the printer.
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Changing the Settings of the Menu Items
Some menus allow you to change the printer settings through the Dell Printer Configuration Web Tool. When you 
access these menus, the authentication window appears on the screen. Enter a user name and password of the 
administrator by following the prompts displayed in the dialog box.

The default user name is admin, and the default password is left blank (NULL). You can change only the password in 
the Set Password page in the Security menu. For more information, see "Set Password" on page 132.

Details of the Menu Items

"Printer Status" "Printer Status"

"Printer Events"

"Printer Information"

"Printer Jobs" "Job List"

"Completed Jobs"

"Printer Settings" "Printer Settings Report" "Menu Settings"

"Reports"

"Printer Settings" "System Settings"

"Secure Settings"

"Copy Defaults"

"Copy Color Balance"

"Copy Settings"

"Scan Defaults"

"Fax Defaults"

"Fax Settings"

"Printer Maintenance" "Paper Density"

"Adjust Transfer Roller"

"Adjust Fusing Unit"

"Auto Registration Adjustment"

"Color Registration Adjustment"

"Clean Developer"

"Adjust Altitude"

"Reset Defaults"

"Non-Dell Toner"

"Clock Settings"

"Web Link Customization"
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"Print Server Settings" "Print Server Reports" "Print Server Setup Page"

"E-Mail Alert Setup Page"

"Print Server Settings" "Basic Information"

"Port Settings"

"Wireless LAN (Dell C1765nfw Color Multifunction Printer 
only)"*1

"TCP/IP"

"E-Mail Alert"

"Bonjour (mDNS)"

"SNMP"

"Scan to PC"

"Reset Print Server"

"Security" "Set Password"

"IP Filter (IPv4)"

"Print Volume" "Print Volume"

"Address Book" "Fax/E-Mail" "Address Book - Top Page"

"Address Book (Confirm/Change, Create)"

"Address Book (Delete)"

"FAX Group - Top Page"

"FAX Group (Confirm/Change, Create)"

"FAX Group (Delete)"

"E-Mail Group - Top Page"

"E-Mail Group (Confirm/Change, Create)"

"E-Mail Group (Delete)"

"E-Mail Default Setup"

"Server Address" "Server Address - Top Page"

"Server Address (Confirm/Change, Create)"

"Server Address (Delete)"

"Tray Settings"

*1 This item is available only when the printer is connected with a wireless network.
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Printer Status
Use the Printer Status menu to check the status of consumables, hardware, and specifications of the printer.

The following pages are displayed in the Printer Status menu.

Printer Status
Purpose:

To check the status of the consumables and trays.
Values:

Printer Events
Purpose:

When faults such as Out of Paper or Rear Cover is Open occur, the details of all alerts or indications of faults are 
displayed in the Printer Events page.
Values:

Printer Information
Purpose:

To display the system information of the printer. This page can also be displayed by clicking Printer Information in 
the left frame.
Values:

Cyan Cartridge Level

Magenta Cartridge Level

Yellow Cartridge Level

Black Cartridge Level

Displays the percentage of toner remaining in each toner cartridge. 
When a cartridge is empty, a message appears. The text Call or 
Order is linked to the Dell Printer Supplies website.

Paper Trays Status Ready Indicates that there is some paper in the tray but the quantity is 
unknown.

Add Paper Indicates that there is no paper in the tray.

Capacity Displays the maximum capacity of the paper tray.

Size Displays the size of paper in the tray.

Output Tray Status OK Indicates that the tray is available.

Capacity Displays the maximum capacity of the output tray.

Cover Status Closed Indicates that the cover is closed.

Open Indicates that the cover is open.

Printer Type Displays the type of the printer. Color Laser is displayed normally.

Printing Speed Displays the printing speed.

Location Displays the location where the error occurred.

Details Displays the details of the error.

Dell Service Tag Number Displays Dell's service tag number.

Asset Tag Number Displays the asset tag number of the printer.
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Printer Jobs
The Printer Jobs menu contains information on the Job List and Completed Jobs pages. These pages show the 
details of the status regarding each protocol or the print jobs.

Job List
Purpose:

To confirm the print jobs that are being processed. Click Refresh to update the screen.
Values:

Completed Jobs
Purpose:

To check the completed jobs. Up to 20 latest jobs are displayed. Click Refresh to update the screen.
Values:

Printer Serial Number Displays the serial number of the printer.

Memory Capacity Displays the memory capacity.

Processor Speed Displays the processing speed.

Printer Revision Levels Firmware Version Displays the version of the controller.

Network Firmware Version Displays the NIC version.

ID Displays the job ID.

Job Name Displays the file name of the job being printed.

Owner Displays the name of the job owner.

Host Name Displays the name of the host computer.

Job Status Displays the status of the job being printed.

Job Type Displays the type of the job.

Host I/F Displays the status of the host interface.

Job Submitted Time Displays the date when the print job was submitted.

ID Displays the job ID.

Job Name Displays the file name of the job.

Owner Displays the name of the job owner.

Host Name Displays the name of the host computer.

Output Result Displays the status of the job.

Job Type Displays the type of the job.

Impression Number Displays the total number of pages used by the print job.

No. of Sheets Displays the total number of sheets used by the print job.

Host I/F Displays the status of the host interface.

Job Submitted Time Displays the date when the job was submitted.
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Printer Settings
Use the Printer Settings menu to display the Printer Settings Report and to configure the printer settings.

The following tabbed pages are displayed at the top of the right frame.

Printer Settings Report

The Printer Settings Report tab contains the Menu Settings and Reports pages.

Menu Settings
Purpose:

To display the current settings of your printer. 
Values:

System Settings Power Saver Timer - Sleep Displays the time taken by the printer before it enters the power 
saver timer - sleep after it finishes a job.

Power Saver Timer - Deep 
Sleep

Displays the time taken by the printer before it enters the power 
saver timer - deep sleep after it goes into the power saver timer 
mode 1.

Auto Reset Displays the time taken by the printer before it automatically resets 
the settings for Copy, Scan, or Fax on the operator panel to the 
defaults when no additional settings are made.

Panel Select Tone Displays the volume of the tone that is emitted when the operator 
panel input is correct. Off indicates that the tone is disabled.

Panel Alert Tone Displays the volume of the tone that is emitted when the operator 
panel input is incorrect. Off indicates that the tone is disabled.

 Job Tone Displays the volume of the tone that is emitted when a job is 
complete. Off indicates that the tone is disabled.

Alert Tone Displays the volume of the tone that is emitted when a problem 
occurs. Off indicates that the tone is disabled.

Out of Paper Tone Displays the volume of the tone that is emitted when the printer 
runs out of paper. Off indicates that the tone is disabled.

Auto Clear Alert Tone Displays the volume of the tone that is emitted 5 seconds before 
the printer performs auto clear. Off indicates that the tone is 
disabled.

All Tones Displays the volume of all the alert tones. Off indicates that all the 
tones are disabled.

Job Time-Out Displays the amount of time that the printer waits for data to arrive 
from the computer.

Panel Language Displays the language used on the operator panel.

Disable printing with larger 
paper size

Displays whether to disable printing if the paper size set in the 
printer driver and the paper size set in the tray of the printer does 
not match (the paper set in the tray is larger).

Auto Log Print Displays whether to automatically print a job history report after 
every 20 jobs.

mm/inch Displays the measurement unit used after the numeric value on the 
operator panel.
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Secure Settings Panel Lock Set Displays whether to limit access to Admin Menu with a 
password.

Software Download Displays whether to enable download of firmware updates.

Copy Service Lock Set Displays whether to enable the Copy service or to require a 
password to use the service.

Scan Service Lock Set Displays whether to enable the Scan service or to require a 
password to use the service.

Fax Service Lock Set Displays whether to enable the Fax service or to require a password 
to use the service.

Print from USB Displays whether to enable the USB-Print service or to require a 
password to use the service.

Secure Receive Set Displays whether to require a password to print incoming faxes.

Copy Defaults Color Displays whether to make copies in color or in black and white.

Reduce/Enlarge Displays the default copy reduction/enlargement ratio.

Original Type Displays the default document type.

Document Size Displays the default document size.

Lighter/Darker Displays the default copy density level.

Sharpness Displays the default sharpness level.

Auto Exposure Displays whether to suppress the background of the original to 
enhance text on the copy.

Copy Color Balance Color Balance (Red) Displays the color balance level of red.

Color Balance (Green) Displays the color balance level of green.

Color Balance (Blue) Displays the color balance level of blue.

Gray Balance Displays the gray balance level.

Copy Settings Multiple-Up Displays whether to enable the Multiple-Up feature.

Collated Displays whether to sort the copy job.

Margin Top/Bottom Displays the value of the top and bottom margins.

Margin Left/Right Displays the value of the left and right margins.

Margin Middle Displays the value of the middle margin.

Scan Defaults File Format Displays the file format to save the scanned image.

Color Displays whether to scan in color or in black and white.

Resolution Displays the default scan resolution.

Document Size Displays the default document size.

Lighter/Darker Displays the default scan density level.

Sharpness Displays the default sharpness level.

Auto Exposure Displays whether to suppress the background of the original to 
enhance text on the scanned image.

Margin Top/Bottom Displays the value of the top and bottom margins.

Margin Left/Right Displays the value of the left and right margins.

Margin Middle Displays the value of the middle margin.

TIFF File Format Displays the selected TIFF file format; TIFF V6 or TTN2.

Image Compression Displays the image compression level.

Max E-Mail Size Displays the maximum size of e-mail that can be sent.
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Fax Defaults Resolution Displays the resolution level to be used for fax transmission.

Lighter/Darker Displays the default density level to be used for fax transmission.

Delayed Start Displays the fax transmission start time.

Fax Settings Receive Mode Displays the fax receiving mode.

Auto Receive Fax Displays the interval at which the printer goes into the fax receive 
mode after receiving an incoming call.

Auto Receive Tel/Fax Displays the interval at which the printer goes into the fax receive 
mode after the external telephone receives an incoming call.

Auto Receive Answer/Fax Displays the interval at which the printer goes into the fax receive 
mode after the external answering machine receives an incoming 
call.

Line Monitor Displays the volume of the line monitor, which audibly monitors a 
transmission through the internal speaker until a connection is 
made.

Ring Tone Volume Displays the volume of the ring tone, which indicates that an 
incoming call is a telephone call through the internal speaker when 
Receive Mode is set to Telephone/Fax.

Line Type Displays the line type.

Tone/Pulse Displays the dialing type.

Resend Delay Displays the interval between transmission attempts. 

Redial Attempts Displays the number of redial attempts.

Redial Delay Displays the interval between redial attempts.

Junk Fax Setup Displays whether to reject faxes sent from unwanted numbers.

Remote Receive Displays whether to receive faxes by pressing a remote receive code 
on the external telephone.

Remote Receive Tone Displays the remote receive code to start Remote Receive.

Fax Header Displays whether to print the information of sender on the header 
of faxes.

Fax Header Name Displays the name of sender to be printed on the header of faxes.

Fax Number Displays the fax number to be printed on the header of faxes.

Fax Cover Page Displays whether to attach a cover page to faxes.

DRPD Pattern Displays the Distinctive Ring Pattern Detection (DRPD) setting.

Sent Fax Forward Displays whether to forward incoming faxes to a specified 
destination.

Fax Forward Number Displays the fax number of the destination to which incoming 
faxes are to be forwarded.

Prefix Dial Displays whether to set a prefix dial number.

Prefix Dial Number Displays a prefix dial number. This number dials before any auto 
dial number is started.

Discard Size Displays whether to discard text or images at the bottom of a fax 
page when the entire page does not fit onto the output paper.

ECM Displays whether to enable the Error Correction Mode (ECM).

Modem Speed Displays the fax modem speed.

Fax Activity Displays whether to automatically print a fax activity report after 
every 50 incoming and outgoing fax communications.
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Fax Transmit Displays whether to print a transmission report after every fax 
transmission or only when an error occurs.

Fax Broadcast Displays whether to print a transmission report after every fax 
transmission to multiple destinations or only when an error occurs.

Fax Protocol Displays whether to print a protocol monitor report after every fax 
transmission or only when an error occurs.

Country Displays the country where the printer is used.

Paper Density Plain Displays the paper density of plain paper.

Label Displays the paper density of labels.

Adjust Transfer Roller Plain Displays the voltage setting of the transfer roller for plain paper. 

Plain Thick Displays the voltage setting of the transfer roller for thick plain 
paper. 

Covers Displays the voltage setting of the transfer roller for cover paper. 

Label Displays the voltage setting of the transfer roller for labels. 

Coated Displays the voltage setting of the transfer roller for coated paper. 

Recycled Displays the voltage setting of the transfer roller for recycled paper. 

Envelope Displays the voltage setting of the transfer roller for envelopes. 

Adjust Fusing Unit Plain Displays the temperature setting of the fusing unit for plain paper. 

Plain Thick Displays the temperature setting of the fusing unit for thick plain 
paper. 

Covers Displays the temperature setting of the fusing unit for cover paper.

Label Displays the temperature setting of the fusing unit for labels. 

Coated Displays the temperature setting of the fusing unit for coated 
paper. 

Recycled Displays the temperature setting of the fusing unit for recycled 
paper. 

Envelope Displays the temperature setting of the fusing unit for envelopes. 

Auto Registration Adjustment Displays whether to automatically adjust color registration.

Adjust Altitude Displays the altitude of the location where the printer is installed.

Non-Dell Toner Displays whether to use toner cartridge of another manufacturer.

Clock Settings Date Format Displays the default date format.

Time Format Displays the default time format; 24H or 12 Hour Clock.

Time Zone Displays the default time zone.

Set Date Displays the date setting.

Set Time Displays the time setting.

Web Link Customization Select Reorder URL Displays a link used for ordering consumables, which can be 
accessed from Order Supplies at: in the left frame.

Regular Displays the regular web address 
(http://accessories.us.dell.com/sna) that can be linked to Order 
Supplies at: in the left frame.

Premier Displays the premier web address (http://premier.dell.com) that 
can be linked to Order Supplies at: in the left frame.

http://accessories.us.dell.com/sna
http://premier.dell.com
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Reports
Purpose:

To print the settings and history information of your printer.
Values:

Tray Settings MPF Paper Type Displays the paper type setting of the MPF.

MPF Paper Size Displays the paper size setting of the MPF.

MPF Custom Size - Y Displays the length of custom size paper loaded in the MPF.

MPF Custom Size - X Displays the width of custom size paper loaded in the MPF.

Display Popup Displays whether to use a popup menu that prompts the user to set 
Paper Type and Paper Size when the paper is loaded in the MPF.

System Settings Click Start to print the system settings page.

Panel Settings Click Start to print the panel settings page.

Job History Click Start to print the Job History report.

Error History Click Start to print the Error History report.

Address Book Click Start to print the Address Book report.

Color Test Page Click Start to print the Color Test Page.
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Printer Settings

The Printer Settings tab contains the System Settings, Secure Settings, Copy Defaults, Copy Color Balance, Copy 
Settings, Scan Defaults, Fax Defaults, and Fax Settings pages.

System Settings
Purpose:

To configure the basic printer settings.
Values:

Power Saver Timer - Sleep*1 Specifies the time taken by the printer before it enters the power saver timer mode 1 after it 
finishes a job.

Power Saver Timer - Deep 
Sleep

Specifies the time taken by the printer before it enters the power saver timer mode 2 after it goes 
into the power saver timer mode 1.

Auto Reset Specifies the time taken by the printer before it automatically resets the settings for Copy, Scan, or 
Fax on the operator panel to the defaults when no additional settings are made.

Panel Select Tone Sets the volume of the tone that is emitted when the operator panel input is correct, or disables 
the tone.

Panel Alert Tone Sets the volume of the tone that is emitted when the operator panel input is incorrect, or disables 
the tone.

Job Tone Sets the volume of the tone that is emitted when a job is complete, or disables the tone.

Alert Tone Sets the volume of the tone that is emitted when a problem occurs, or disables the tone.

Out of Paper Tone Sets the volume of the tone that is emitted when the printer runs out of paper, or disables the 
tone.

Auto Clear Alert Tone Sets the volume of the tone that is emitted 5 seconds before the printer performs auto clear, or 
disables the tone.

All Tones Sets the volume of all the alert tones, or disables all the tones.

Job Time-Out Specifies the amount of time that the printer waits for data to arrive from the computer. The print 
job is canceled if it times out.

Panel Language Used to set the language on the operator panel.

Disable printing with larger 
paper size*2

Specifies whether to print jobs if the paper set in the tray of the printer is larger than the paper 
size set in the printer driver (the paper size does not have to match).

Auto Log Print Specifies if a job history needs to be printed after every 20 jobs.

mm/inch*3 Specifies the measurement unit displayed after the numeric value on the operator panel.

*1 Enter 5 in Power Saver Timer - Sleep to put the printer in the power saver timer mode five minutes after it finishes a job. This uses less 
energy, but requires more warm-up time for the printer. Enter 5 if your printer shares an electrical circuit with room lighting and you 
notice lights flickering.
Select a high value if your printer is in constant use. In most circumstances, this keeps the printer ready to operate with minimum 
warm-up time. Select a value between 5 and 30 minutes for the power saver timer mode if you want a balance between energy 
consumption and a shorter warm-up period.
The printer automatically returns to the standby mode from the power saver timer mode when it receives data from the computer. You 
can also return the printer to the standby mode by pressing any button on the operator panel.

*2 Disable printing with larger paper size is available only in the Dell Printer Configuration Web Tool and the Tool Box.
*3 The default for mm/inch varies depending on country-specific factory default.
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Secure Settings
Panel Lock

Purpose:

To restrict access to Admin Menu with a password, and to set or change the password.

 NOTE: This menu sets a password to lock the operator panel. When you change the password for the Dell Printer Configuration 
Web Tool, click Set Password on the left frame and set the password.

Values:

Software Download
Purpose:

To set whether to enable download of software updates.
Function Enabled
Purpose:

To enable the services to be password-enabled, and allow the user to change it.

 NOTE: This menu sets a password to limit the Copy, Scan, Fax, and USB-Print services. When you change the password for the 
Dell Printer Configuration Web Tool, click Set Password you change on the left frame and set the password.

Values:

Secure Receive

Purpose:

Allows you to set a password to secure the incoming faxes. When the Secure Receive feature is enabled, the printer 
stores incoming faxes and prints them when the correct password is entered on the operator panel.

 NOTE: This menu sets a password to lock printing incoming fax. When changing the password for the Dell Printer Configuration 
Web Tool, click Set Password on the left frame and set the password.

Values:

Panel Lock Set Restricts access to Admin Menu with a password.

New Password Sets a password that is required to access Admin Menu.

Re-enter Password Enter the new password again to confirm.

Copy Service Lock Set Allows you to set a password for the Copy Service feature.

Scan Service Lock Set Allows you to set a password for the Scan Service feature.

Fax Service Lock Set Allows you to set a password for the Fax Service feature.

Print from USB Allows you to set a password for the USB-Print Service feature.

New Password Sets a password required to use the Copy, Scan, Fax, and USB-Print services.

Re-enter Password Enter the new password again to confirm.

Secure Receive Set Allows you to set a password to secure the incoming faxes.

New Password Sets a password that is required to print incoming faxes.

Re-enter Password Enter the new password again to confirm.
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Copy Defaults
Purpose:

To create your own default copy settings.
Values:

Copy Color Balance
Purpose:

To specify the default color balance level.
Values:

Copy Settings
Purpose:

To configure the copy settings.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

Color Selects mode for color or black and white copying.

Reduce/Enlarge Sets the default copy reduction/enlargement ratio.

Custom Reduce/Enlarge Sets a custom reduction/enlargement ratio within the range of 25% to 400% when Reduce/Enlarge 
is set to Custom. 

Original Type Sets the copy image quality.

Document Size Sets the default document size.

Lighter/Darker Sets the default copy density level.

Sharpness Sets the default sharpness level.

Auto Exposure Sets whether to suppress the background of the original to enhance text on the copy.

Color Balance (Red) Sets the color balance level of red.

Color Balance (Green) Sets the color balance level of green.

Color Balance (Blue) Sets the color balance level of blue. 

Gray Balance Sets the gray balance level.

Multiple-Up Off* Does not perform multiple-up printing.

Auto Automatically reduces the original pages to fit onto one sheet of paper.

Manual Prints the original pages onto one sheet of paper in the size specified in 
Reduce/Enlarge. 

Collated Sets whether to sort the copy job. 

Margin Top/Bottom Sets the value of the top and bottom margins within the range of 0 mm to 50 mm/0.0 to 2.0 inch.

Margin Left/Right Sets the value of the left and right margins within the range of 0 mm to 50 mm/0.0 to 2.0 inch.

Margin Middle Sets the value of the middle margin within the range of 0 mm to 50 mm/0.0 to 2.0 inch.
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Scan Defaults
Purpose:

To create your own default scan settings.

Values:

Fax Defaults
Purpose:

To create your own default fax settings.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

File Format Sets the file format to save the scanned image. 

Color Sets whether to scan in color or in black and white.

Resolution Sets the default scan resolution.

Document Size Sets the default document size.

Lighter/Darker Sets the default scan density level.

Sharpness Sets the default sharpness level.

Auto Exposure Sets whether to suppress the background of the original to enhance text on the scanned image.

Margin Top/Bottom Sets the value of the top and bottom margins within the range of 0 mm to 50 mm/0.0 to 2.0 inch.

Margin Left/Right Sets the value of the left and right margins within the range of 0 mm to 50 mm/0.0 to 2.0 inch. 

Margin Middle Sets the value of the middle margin within the range of 0 mm to 50 mm/0.0 to 2.0 inch.

TIFF File Format Sets the TIFF file format to TIFF V6 or TTN2.

Image Compression Sets the image compression level.

Max E-Mail Size Sets the maximum size of e-mail that can be sent, within the range of 50 K bytes to 16384 K bytes. 
The default is 2048 K bytes.

Resolution Standard* Suitable for documents with normal sized characters.

Fine Suitable for documents containing small characters or thin lines or documents 
printed using a dot-matrix printer.

Super Fine Suitable for documents containing extremely fine detail. The super fine mode is 
enabled only if the remote machine also supports the super fine resolution.

Ultra Fine Suitable for documents containing photographic images.

Lighter/Darker Sets the default density level to be used for fax transmission.

Delayed Start Sets the fax transmission start time when sending a fax at a specified time.
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Fax Settings
Purpose:

To configure the basic fax settings.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

Receive Mode Telephone Automatic fax reception is turned off. You can receive a fax by picking up the 
handset of the external telephone, and then pressing the remote receive code.

Fax* Automatically receives faxes.

Telephone/Fax When the printer receives an incoming fax, the external telephone rings for the 
time specified in Auto Receive Fax/Tel, and then the printer automatically 
receives a fax. If an incoming call is not a fax, the printer beeps from the internal 
speaker indicating that the call is a telephone call.

Answer 
Machine/
Fax

The printer can share a telephone line with an answering machine. In this mode, 
the printer will monitor the fax signal and pick up the line if there are fax tones. 
If the phone communication is using serial transmission in your country (such as 
Germany, Sweden, Denmark, Austria, Belgium, Italy, France and Switzerland), 
this mode is not supported. 

DRPD Before using the Distinctive Ring Pattern Detection (DRPD) option, a 
distinctive ring service must be installed on your telephone line by the telephone 
company. After the telephone company has provided a separate number for 
faxing with a distinctive ring pattern, configure the fax setup to monitor for that 
specific ring pattern.

Auto Receive Fax Sets the interval at which the printer goes into the fax receive mode after receiving an incoming 
call. 

Auto Receive Tel/Fax Sets the interval at which the printer goes into the fax receive mode after the external telephone 
receives an incoming call.

Auto Receive Answer/Fax Sets the interval at which the printer goes into the fax receive mode after the external answering 
machine receives an incoming call.

Line Monitor Sets the volume of the line monitor, which audibly monitors a transmission through the internal 
speaker until a connection is made.

Ring Tone Volume Sets the volume of the ring tone, which indicates that an incoming call is a telephone call through 
the internal speaker when Receive Mode is set to Telephone/Fax.

Line Type Sets the line type.

Tone/Pulse Sets the dialing type.

Resend Delay Specifies the interval between transmission attempts. 

Redial Attempts Specifies the number of redial attempts to make when the destination fax number is busy. If you 
enter 0, the printer will not redial.

Redial Delay Specifies the interval between redial attempts.

Junk Fax Setup Sets whether to reject faxes sent from unwanted numbers by accepting faxes only from the fax 
numbers registered in the Phone Book.

Remote Receive Sets whether to receive a fax by pressing a remote receive code on the external telephone.

Remote Receive Tone Specifies the remote receive code in two digits to start Remote Receive.

Fax Header Sets whether to print the information of sender on the header of faxes.

Fax Header Name Sets the name of sender to be printed on the header of faxes. Up to 30 alphanumeric characters 
can be entered.
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Printer Maintenance

The Printer Maintenance tab contains the Paper Density, Adjust Transfer Roller, Adjust Fusing Unit, Auto 
Registration Adjustment, Color Registration Adjustment, Clean Developer, Adjust Altitude, Reset Defaults, Non-
Dell Toner, Clock Settings, and Web Link Customization pages.

Paper Density
Purpose:

To specify the paper density.
Values:

Fax Number Sets the fax number of the printer to be printed on the header of faxes.

Fax Cover Page Sets whether to attach a cover page to faxes.

DRPD Pattern Sets the DRPD setting from Pattern 1 to Pattern 7. DRPD is a service provided by some 
telephone companies.

Sent Fax Forward Sets whether to forward incoming faxes to a specified destination.

Fax Forward Number Specifies the fax number of the destination to which incoming faxes will be forwarded.

Prefix Dial Specifies whether to set a prefix dial number.

Prefix Dial Number Sets a prefix dial number of up to five digits. This number dials before any auto dial number is 
started. It is useful for accessing the Private Automatic Branch Exchange (PABX).

Discard Size Sets whether to discard text or images at the bottom of a fax page when the entire page does not 
fit onto the output paper. Selecting Auto Reduction automatically reduces the fax page to fit it 
onto the output paper, and does not discard any images or text at the bottom of the page.

ECM Sets whether to enable the ECM. To use the ECM, the remote machines must also support the 
ECM.

Modem Speed Specifies the fax modem speed when a fax transmission or reception error occurs.

Fax Activity Sets whether to automatically print a fax activity report after every 50 incoming and outgoing fax 
communications.

Fax Transmit Sets whether to print a transmission report after every fax transmission or only when an error 
occurs.

Fax Broadcast Sets whether to print a transmission report after every fax transmission to multiple destinations or 
only when an error occurs.

Fax Protocol Sets whether to print a protocol monitor report after every fax transmission or only when an error 
occurs.

Country Sets the country where the printer is used.

Plain Sets the paper density of plain paper.

Label Sets the paper density of labels.
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Adjust Transfer Roller
Purpose:

To specify the optimum voltage settings for printing for the transfer roller. To decrease the voltage, set negative 
values. To increase the voltage, set positive values.

The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 
increase the voltage. If you see white spots on the print output, try to decrease the voltage.

 NOTE: The print quality changes depending on the values you select for this item.

Values:

Adjust Fusing Unit
Purpose:

To specify the optimum temperature settings for printing for the fusing unit. To decrease the temperature, set 
negative values. To increase the temperature, set positive values.

The default settings may not give the best output on all paper types. When the printed paper has curled, try to 
decrease the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.

 NOTE: The print quality changes depending on the values you select for this item.

Values:

Auto Registration Adjustment
Purpose:

To specify whether to automatically adjust color registration.

Plain Sets the reference voltage setting for the transfer roller for plain paper within the range of -3 to 3.

Plain Thick Sets the reference voltage setting for the transfer roller for thick plain paper within the range 
of -3 to 3.

Covers Sets the reference voltage setting for the transfer roller for cover paper within the range of -3 to 3.

Label Sets the reference voltage setting for the transfer roller for labels within the range of -3 to 3.

Coated Sets the reference voltage setting for the transfer roller for coated paper within the range of -3 to 3.

Recycled Sets the reference voltage setting for the transfer roller for recycled paper within the range 
of -3 to 3.

Envelope Sets the reference voltage setting for the transfer roller for envelopes within the range of -3 to 3.

Plain Sets the temperature settings for the fusing unit for plain paper within the range of -3 to 3.

Plain Thick Sets the temperature settings for the fusing unit for thick plain paper within the range of -3 to 3.

Covers Sets the temperature settings for the fusing unit for cover paper within the range of -3 to 3.

Label Sets the temperature settings for the fusing unit for labels within the range of -3 to 3.

Coated Sets the temperature settings for the fusing unit for coated paper within the range of -3 to 3.

Recycled Sets the temperature settings for the fusing unit for recycled paper within the range of -3 to 3.

Envelope Sets the temperature settings for the fusing unit for envelopes within the range of -3 to 3.
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Color Registration Adjustment
Purpose:

To manually adjust color registration.

Color registration adjustment need to be made during the initial setup of the printer or when the printer is moved to 
a different location.

 NOTE: The Color Registration Adjustment feature can be configured when Auto Registration Adjustment is set to Off.

Values:

Clean Developer
Purpose:

To rotate the developer motor and stir the toner in the toner cartridge, to use up a toner cartridge when you need to 
replace it before the end of its life, or to stir the toner in a new toner cartridge.
Values:

Adjust Altitude
Purpose:

To specify the altitude of the location where the printer is installed. 

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 
performed by specifying the altitude of the location where the printer is being used.

 NOTE: An incorrect altitude adjustment setting leads to poor printing quality, incorrect indication of remaining toner.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

Auto Correct Click Start to automatically correct color registration.

Color Registration 
Adjustment 1 (Lateral)

Specifies lateral (perpendicular to paper feed direction) color adjustment values individually for Y 
(Yellow), M (Magenta), C (Cyan) within the range of -5 to +5.

Color Registration 
Adjustment 2 (Process)

Specifies process (paper feed direction) color adjustment values individually for LY (Left Yellow), 
LM (Left Magenta), LC (Left Cyan), RY (Right Yellow), RM (Right Magenta), and RC (Right 
Cyan) within the range of -5 to +5.

Clean Developer Click Start to stir the toner in the toner cartridge.

Yellow Toner Refresh Click Start to clean the toner in the yellow toner cartridge.

Magenta Toner Refresh Click Start to clean the toner in the magenta toner cartridge.

Cyan Toner Refresh Click Start to clean the toner in the cyan toner cartridge.

Black Toner Refresh Click Start to clean the toner in the black toner cartridge.

0 meter* Specifies the altitude of the location where the printer is installed.

1000 meters

2000 meters

3000 meters
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Reset Defaults
Purpose:

To initialize NVM (non-volatile memory) memory for system parameters and Address Book data. After executing 
this function and rebooting the printer, the menu parameters or data are reset to their default values.
Values:

Non-Dell Toner
Purpose:

To use toner cartridge of another manufacturer.

 NOTE: Using non-Dell-brand toner cartridges may make some printer features unusable, reduce print quality and decrease the 
reliability of your printer. Dell recommends only new Dell-brand toner cartridges for your printer. Dell does not provide warranty 
coverage for problems caused by using accessories, parts, or components not supplied by Dell.

 NOTE: Before you use toner cartridge of another manufacturer, be sure to restart the printer.

Clock Settings
Purpose:

To set the date and time, and regional time zone of the printer.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

Reset Defaults and Restart 
Printer

Click Start to initialize the system parameters.

Reset Defaults of User (Fax) 
Section

Click Start to initialize the fax number entries in the Address Book.

Reset Defaults of User 
(Scan) Section

Click Start to initialize the e-mail and server address entries in the Address Book.

Date Format*1 yy/mm/dd Specifies the date format.

mm/dd/yy

dd/mm/yy

Time Format 12 Hour Clock* Specifies the time format.

24H

Time Zone Specifies the time zone.

Set Date Specifies the current date.

Set Time Specifies the current time.
*1 The default for Date Format varies depending on country-specific factory default.
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Web Link Customization
Purpose:

To specify a link used for ordering consumables, which can be accessed from Order Supplies at: in the left frame.
Values:

Print Server Settings
Use the Print Server Settings menu to set the type of printer interface and necessary conditions for 
communications.

The following tabbed pages are displayed in the top of the right frame.

Print Server Reports

The Print Server Reports tab contains the Print Server Setup Page and E-Mail Alert Setup Page.

Print Server Setup Page
Purpose:

To verify the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) and printing ports. On 
this page, you can only verify the settings of items. If you want to change the settings, go to the pages in the Print 
Server Settings tab.
Values:

Select Reorder URL Select the Regular or Premier web address to be linked to Order Supplies at: in the left frame.

Regular Displays the regular web address (http://accessories.us.dell.com/sna) that can be linked to 
Order Supplies at: in the left frame.

Premier Displays the premier web address (http://premier.dell.com) that can be linked to 
Order Supplies at: in the left frame.

Ethernet*1 Ethernet Settings Displays the current settings of Ethernet transmission rate and the 
duplex settings.

Current Ethernet Settings Displays the current Ethernet settings.

MAC Address Displays the Media Access Control (MAC) address of the printer.

Wireless*2 Wireless LAN Displays whether to enable wireless connection.

SSID Displays the name that identifies the network.

Network Type Displays the network type from either the Ad-Hoc or Infrastructure 
mode.

MAC Address Displays the MAC address of the wireless printer setting.

Link Channel Displays the channel number of the connection.

Link Quality Displays the quality of the connection.

Encryption Displays the security method.

Transmit Key Displays the transmit key.

http://accessories.us.dell.com/sna
http://premier.dell.com
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TCP/IP Settings Host Name Displays the host name.

IP Mode Displays the IP mode.

IPv4 IP Address Mode Displays the IP address mode.

IP Address Displays the IP address.

Subnet Mask Displays the subnet mask.

Gateway Address Displays the gateway address.

IPv6 Use Manual Address Displays the manual IP address.

Manual Address Displays the IP address.

Stateless Address 1-3 Displays the stateless addresses.

Link Local Address Displays the link local address.

Manual Gateway Address Displays the gateway address.

Auto Configure Gateway 
Address

Displays the gateway address.

DNS IPv4 Get DNS Server Address from 
DHCP

Displays if the printer receives 
the DNS server address 
automatically from the DHCP 
server.

Manual DNS Server Address Displays the DNS server address.

IPv6 Manual DNS Server Address Displays the DNS server address.

LPD Port Status Displays the port status.

Connection Time-Out Displays the connection time-out period.

Bonjour (mDNS) Port Status Displays the port status.

Port9100 Port Status Displays the port status.

Port Number Displays the port number.

Connection Time-Out Displays the connection time-out period.

HTTP Port Status Displays the port status.

Port Number Displays the port number.

Simultaneous Connections Displays the number of connections received simultaneously by the 
client.

Connection Time-Out Displays the connection time-out period.

WSD Port Status Displays the Web Services on Devices (WSD) port status.

Port Number Displays the WSD port number.

Receive Time-Out Displays the receive time-out period.

Notification Time-Out Displays the notification time-out period.

Maximum Number of TTL Displays the maximum number of TTLs.

Maximum Number of 
Notification

Displays the maximum number of notifications.

SNMP Port Status Displays the port status.

FTP Client Connection Time-Out Displays the connection time-out period.

FTP Passive Displays whether to enable the FTP Passive mode.

SMB Client Connection Time-Out Displays the connection time-out period.
*1 This item is available only when the printer is connected with a wired network.
*2 This item is available only when the printer is connected with a wireless network.
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E-Mail Alert Setup Page
Purpose:

To verify the current settings of SMTP/POP (Simple Mail Transfer Protocol/Post Office Protocol) used for the e-mail 
feature and e-mail alert feature. In this page, you can only verify the settings of items. If you want to change the 
settings, go to the pages in the Print Server Settings tab.
Values:

E-Mail Alert Setup Page Port Status Displays the port status.

Primary SMTP Gateway Displays the primary SMTP gateway.

SMTP Port Number Displays the SMTP port number.

E-Mail Send Authentication Displays the authentication method for outgoing e-mail.

POP3 Server Address Displays the POP3 server address.

POP3 Port Number Displays the POP3 port number.

Reply Address Displays the reply e-mail address sent with each e-mail alert.

SMTP Server Connection Displays the status of the SMTP server connection.

E-Mail Alert Settings E-Mail List 1 Displays the acceptable e-mail addresses for the e-mail alert feature 
specified in E-Mail List 1.

Select Alerts for List 1 Supplies Alerts Displays the e-mail alert receive 
status for consumables.

Paper Handling Alerts Displays the e-mail alert receive 
status for paper handling.

Service Call Displays the e-mail alert receive 
status for service calls.

E-Mail List 2 Displays the acceptable e-mail addresses for the e-mail alert feature 
specified in E-Mail List 2.

Select Alerts for List 2 Supplies Alerts Displays the e-mail alert receive 
status for consumables.

Paper Handling Alerts Displays the e-mail alert receive 
status for paper handling.

Service Call Displays the e-mail alert receive 
status for service calls.
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Print Server Settings

The Print Server Settings tab contains the Basic Information, Port Settings, Wireless LAN, TCP/IP, E-Mail Alert, 
Bonjour (mDNS), SNMP, Scan To PC, and Reset Print Server pages.

Basic Information
Purpose:

To configure the basic information of the printer.

 NOTE: The Auto Refresh feature is effective for the contents of the top frame, Printer Status page, Job List page, and Completed 
Jobs page.

Values:

System Settings Printer Name Specifies the name of the printer using up to 31 alphanumeric 
characters.

Location Specifies the location of the printer using up to 63 alphanumeric 
characters.

Contact Person Specifies the contact name, number, and other information of the 
administrator and service center using up to 63 alphanumeric 
characters.

Administrator E-Mail 
Address

Specifies the contact address of the administrator and service 
center using up to 63 alphanumeric characters.

Asset Tag Number Enter the asset tag number for the printer.

EWS Settings Auto Refresh Automatically refreshes the contents of the status display pages. 

Auto Refresh Interval Sets the time interval for refreshing the contents of the status 
display pages automatically from 15 to 600 seconds.
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Port Settings
Purpose:

To enable or disable printing connectors and management protocol features.

 NOTE: The settings in the Port Settings page will be valid only when the printer is rebooted. When you change or configure the 
settings, click Apply New Settings to apply the new settings.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

Ethernet*1 Ethernet Settings Auto* Detects Ethernet transmission 
rate and the duplex settings 
automatically.

10Base-T Half-Duplex Selects 10Base-T Half-Duplex as 
the default value.

10Base-T Full-Duplex Selects 10Base-T Full-Duplex as 
the default value.

100Base-TX Half-Duplex Selects 100Base-TX Half-Duplex 
as the default value.

100Base-TX Full-Duplex Selects 100Base-TX Full-Duplex 
as the default value.

Current Ethernet Settings Displays the current settings of Ethernet.

MAC Address Displays the MAC address of the printer.

Port Status LPD Specifies whether to enable LPD.

Port9100 Specifies whether to enable Port9100.

E-Mail Alert Specifies whether to enable the E-Mail Alert feature.

SNMP Specifies whether to enable the SNMP.

WSD Specifies whether to enable the WSD port.

Bonjour (mDNS) Specifies whether to enable the Bonjour (mDNS) feature.

Status Messager Specifies whether to enable the Status Messager.
*1 This item is available only when the printer is connected with a wired network.
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Wireless LAN (Dell C1765nfw Color Multifunction Printer only)
Purpose:

To configure wireless network settings.

To connect the printer with a wireless network, be sure to disconnect the Ethernet cable.

 NOTE: Once wireless LAN is activated, wired LAN protocol will be disabled.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

Wireless Settings Wireless LAN Specifies whether to enable wireless connection.

SSID Specifies the name that identifies the wireless network using up to 
32 alphanumeric characters.

Network Type Specifies the network type from either Ad-Hoc or Infrastructure.

MAC Address Displays the MAC address of the wireless network setting of the 
printer.

Link Channel Displays the channel number of the wireless connection of the 
printer.

Link Quality Displays the quality of the wireless network connection of the 
printer.

Security Settings Encryption Select the security method from the list.

No Security* Specifies No Security to 
configure the wireless setting 
without specifying a security 
method from WEP, WPA-PSK 
TKIP/WPA2-PSK AES, and 
Mixed Mode PSK.

WEP 64 Bit ASCII (5 Bytes) Specifies the WEP 64 Bit ASCII 
to use through the wireless 
network.

WEP 128 Bit ASCII (13 Bytes) Specifies the WEP 128 Bit 
ASCII to use through the 
wireless network.

WEP 64 Bit Hex (10 Bytes) Specifies the WEP 64 Bit Hex to 
use through the wireless 
network.

WEP 128 Bit Hex (26 Bytes) Specifies the WEP 128 Bit Hex 
to use through the wireless 
network.

WPA-PSK TKIP*1 Specifies the WPA-PSK TKIP to 
use through the wireless 
network.

WPA2-PSK AES*1 Specifies the WPA2-PSK AES to 
use through the wireless 
network.

Mixed Mode PSK Specifies the Mixed Mode PSK 
to use through the wireless 
network. 
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TCP/IP
Purpose:

To configure the IP address, subnet mask, and gateway address of the printer. 
Values:

WEP Key 1 Enter the WEP key when WEP is selected from Encryption.

Re-enter WEP Key 1 Enter the WEP key 1 again to confirm.

WEP Key 2 Enter the WEP key when WEP is selected from Encryption.

Re-enter WEP Key 2 Enter the WEP key 2 again to confirm.

WEP Key 3 Enter the WEP key when WEP is selected from Encryption.

Re-enter WEP Key 3 Enter the WEP key 3 again to confirm.

WEP Key 4 Enter the WEP key when WEP is selected from Encryption.

Re-enter WEP Key 4 Enter the WEP key 4 again to confirm.

Transmit Key Specifies the transmit key type from the list.

Pass Phrase Specifies the passphrase.

Re-enter Pass Phrase Enter the passphrase again to confirm.
*1 This item is available only when Infrastructure is selected for Network Type.

TCP/IP Settings Host Name Specifies the host name.

IP Mode Specifies the IP mode.

IPv4 IP Address Mode Selects the IP address mode.

Manual IP Address Manually sets the IP address.

Manual Subnet Mask Manually sets the subnet mask.

Manual Gateway Address Manually sets the gateway 
address.

IPv6 Use Manual Address To set the IP address manually.

Manual Address Manually sets the IP address. To 
specify an IPv6 address, enter the 
address followed by a slash (/) 
and then "64". For details, 
consult your system 
administrator.

Stateless Address 1-3 Displays the stateless addresses.

Link Local Address Displays the link local address.

Manual Gateway Address Manually sets the gateway 
address.

Auto Configure Gateway 
Address

Displays the gateway address.
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E-Mail Alert
Purpose:

To configure settings for E-Mail Alert. This page can also be displayed by clicking E-Mail Alert in the left frame.
Values:

DNS DNS Domain Name Specifies the domain name of the domain name server. Up to 255 
alphanumeric characters, periods, and hyphens can be used. If you 
need to specify more than one domain name, separate them using a 
comma or semicolon.

IPv4 Get DNS Server Address from 
DHCP

Specifies whether to get the 
DNS server address 
automatically from the DHCP 
server.

Manual DNS Server Address Sets the DNS server address.

IPv6 Manual DNS Server Address Sets the DNS server address.

LPD Connection Time-Out Sets the connection time-out period from 1 to 1000 seconds.

IP Filter (IPv4) Specifies the IP address and subnet mask to be permitted or denied 
access to the printer.

Port9100 Port Number Sets the port number from 9000 to 9999.

Connection Time-Out Sets the connection time-out period between 1 and 1000 seconds.

IP Filter (IPv4) Specifies the IP address and subnet mask to be permitted or denied 
access to the printer.

HTTP Port Number Sets the port number. This must be 80 or between 8000 and 9999.

Simultaneous Connections Displays the maximum number of connections received 
simultaneously by the client.

Connection Time-Out Sets the connection time-out period from 1 to 255 seconds.

WSD Port Number Sets the port number. This must be 80 or between 8000 and 9999.

Receive 
Time-Out

Sets the receive time-out period from 1 to 65535 seconds.

Notification Delivery Time-
Out

Sets the notification time-out period from 1 to 60 seconds.

Maximum Number of TTL Sets the maximum number of TTL from 1 to 10.

Maximum Number of 
Notification

Sets the maximum number of notifications from 10 to 20.

E-Mail Server Settings Primary SMTP Gateway Sets the primary SMTP gateway.

SMTP Port Number Specifies the SMTP port number. This must be 25, 587 or between 
5000 and 65535.

E-Mail Send Authentication Specifies the authentication method for outgoing e-mail.

SMTP Login User Specifies the SMTP login user. Up to 63 alphanumeric characters, 
periods, hyphens, underscores, and at symbols (@) can be used. If 
specifying more than one address, separate them using commas.

SMTP Login Password Specifies the SMTP account password using up to 31 alphanumeric 
characters.

Re-enter SMTP Login 
Password

Enter the SMTP account password again to confirm.
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Bonjour (mDNS)

Purpose:

To configure the detailed settings for Bonjour.

Values:

POP3 Server Address Specifies the POP3 server address in IP address format of 
"aaa.bbb.ccc.ddd" or as a DNS host name using up to 63 characters.

POP3 Port Number Specifies the POP3 server port number. This must be 110 or 
between 5000 and 65535.

POP User Name Specifies the POP3 account user name. Up to 63 alphanumeric 
characters, periods, hyphens, underscores, and at symbols (@) can 
be used. If specifying more than one address, separate them using 
commas.

POP User Password Specifies the POP3 account password using up to 31 alphanumeric 
characters.

Re-enter POP User Password Enter the password again to confirm.

Reply Address Designates the reply e-mail address sent with each e-mail alert.

SMTP Server Connection Displays the status of the SMTP server connection.

E-Mail Alert Settings E-Mail List 1 Sets acceptable e-mail addresses for the e-mail alert feature using 
up to 255 alphanumeric characters.

Select Alerts for List 1 Supplies Alerts Specifies whether to receive an 
e-mail alert for consumables.

Paper Handling Alerts Specifies whether to receive an 
e-mail alert for paper handling 
and/or service calls.

E-Mail List 2 Sets acceptable e-mail addresses for the e-mail alert feature using 
up to 255 alphanumeric characters.

Select Alerts for List 2 Supplies Alerts Specifies whether to receive an 
e-mail alert for consumables.

Paper Handling Alerts Specifies whether to receive an 
e-mail alert for paper handling 
and/or service calls.

Host Name Specifies the host name up to 63 alphanumeric characters and "-" (dash). The original setting will 
remain valid if nothing is entered.

Printer Name Specifies the printer name up to 63 alphanumeric characters and symbol sets.
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SNMP
Purpose:

To configure the detailed settings of SNMP.
Values:

Community Name Community Name 
(Read only)

Specifies the community name to access (read only) data using up 
to 31 alphanumeric characters.
The original setting will remain valid if nothing is entered. 
Characters entered for community name in the previous settings 
will not be displayed on the screen. The default Read Community 
is public.

Re-enter Community Name (Read 
only)

Enter the community name to access (read only) data again to 
confirm.

Community Name (Read/Write) Specifies the community name to access (read and write) data 
using up to 31 alphanumeric characters.
The original setting will remain valid if nothing is entered. 
Characters entered for community name in the previous settings 
will not be displayed on the screen. The default Read/Write 
Community is private.

Re-enter Community Name 
(Read/Write)

Enter the community name to access (read and write) data again 
to confirm.

Community Name (Trap) Specifies the community name used for trap up to 31 
alphanumeric characters. 
The original settings will remain valid if nothing is entered. 
Characters entered for community name in the previous settings 
will not be displayed on the screen. The default Trap Community 
is public.

Re-enter Community Name (Trap) Enter the community name used for trap again to confirm.

Trap Notification 1-4 Trap Address Type Select the trap address type from the list. Selecting Off clears the 
settings in Trap Address, Port Number, and Notify, and does not 
notify trap occurrence. Selecting IPv4 or IPv6 allows you to enter 
Trap Address.

Trap Address Specifies the IP address and IP socket in the following format:

• IPv4

Specifies the IP address and IP socket in the 
nnn.nnn.nnn.nnn:mmmmm format. Each section of "nnn" is a 
variable value between 0 and 255. Note that values 127 and 224-
254 are not valid for the first three-digits only. The IP socket 
mmmmm is a variable value between 0 and 65535.

• IPv6

Specifies the IP address and IP socket in the 
xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:mmmmm format. 
Each section of "xxxx" is a hexadecimal variable value between 0 
and ffff. The IP socket mmmmm is a variable value between 0 
and 65535.

Trap Notification (IP) Port 
Number

Enter the SNMP trap destination port number.

Notify Specifies whether to notify trap occurrence. 

Authenticate Error Trap Specifies whether to notify Authenticate Error Trap.
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Scan to PC
Purpose:

To specify the client when scanning data.
Values:

Reset Print Server
Purpose:

To initialize NVM (non-volatile memory) for the network feature and reboot the printer. You can also initialize the 
NVM of the printer from Reset Defaults in the Printer Settings menu.
Values:

Security

The Security tab contains the Set Password and IP Filter (IPv4) pages.

Set Password
Purpose:

To set or change the password that is required to access the setup parameters of the printer from the Dell Printer 
Configuration Web Tool.

This page can also be displayed by clicking Set Password in the left frame.

 NOTE: If you forgot your password, initialize NVM (non-volatile memory) to restore the password to the default (NULL). See 
"Reset Print Server" on page 132.

 NOTE: When you change the password to lock the operator panel, set the password from Panel Lock Set in the Printer Settings.

Values:

FTP Client Connection Time-Out Sets the connection time-out period from 1 to 60 seconds.

FTP Passive Sets whether to enable the FTP Passive mode.

SMB Client Connection Time-Out Sets the connection time-out period from 1 to 60 seconds.

Initialize NIC NVRAM 
memory and restart printer.

Click Start to initialize NVM. Network settings will revert to the factory default settings and 
reboot the network capability.

Restart Printer Click Start to reboot the printer.

Administrator Password Sets the password using up to 10 alphanumeric characters. The password will appear as asterisks 
(*) in the field when it is entered.

Re-enter Administrator 
Password

Enter the password again to confirm.
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IP Filter (IPv4)

Purpose:

To specify the IP address and subnet mask to be permitted or denied access to the printer.

Values:

Print Volume
Use the Print Volume menu to verify the number of printed pages.
Values:

Address Book
The Address Book menu contains the Fax/E-Mail and Server Address pages.

Fax/E-Mail

The Fax/E-Mail page contains the following subpages.

Address Book - Top Page
Purpose:

To view the Address Book entries registered on the Address Book page.
Values:

Address Specifies the IP addresses that are permitted or denied access to the printer. Enter a numeric value 
between 0 and 255 in each field.

Address Mask Specifies the subnet mask that are permitted or denied access to the printer. Enter a numeric 
value between 0 and 255 in each field.

Active Mode Permit Permits printing from specified network address.

Reject Rejects printing from specified network address.

Disable Disables the IP Filter feature for the specified IP address.

Printer Page Count Displays the total number of pages printed since the printer was shipped from the factory.

Paper Used Displays the number of pages printed for each paper size.

Address Book Allows you to view, edit, or create Address Book entries.

Fax Group Allows you to view, edit, or create fax group entries.

E-Mail Group Allows you to view, edit, or create e-mail group entries.

E-Mail Default Setup Allows you to view, edit, or set the default e-mail subject and message.

Address List to: Selecting each button displays a list of entries for the group of user IDs indicated on the button.

ID:Name Displays a user ID and the name of the user registered under that user ID. IDs without an entry 
show (Not in Use) in the Name column.

Phone Number Displays the phone number of the user.

E-Mail Address Displays the e-mail address of the user.

Delete Deletes the entry for the selected user ID. 
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Address Book (Confirm/Change, Create)
Purpose:

To view or edit the Address Book entries on the Address Book page, or create a new entry. The following items are in 
the dialog box that appears when you click Confirm/Change or Create on the Address Book top page.
Values:

Address Book (Delete)
Purpose:

To delete the Address Book entries registered on the Address Book page. The following items are in the dialog box 
that appears when you click Delete on the Address Book top page.
Values:

Confirm/Change Displays a dialog box where you can edit the entry of the selected user ID.

Create Displays a dialog box where you can create a new entry under the selected user ID.

ID (Fax Speed Dial) Displays the selected user ID.

Name Allows you to view or edit the name of the user registered under the user ID, or enter a name for 
the new entry.

Phone Number Allows you to view or edit the phone number of the user, or enter a phone number for the new 
entry.

E-mail Address Allows you to view or edit the e-mail address of the user, or enter an e-mail address for the new 
entry.

Delete Click this button to delete the entry for the user ID. This button is available only on the dialog 
box for editing an existing entry. 

Apply New Settings Click this button to apply the new settings. 

Restore Settings Click this button to restore the previous settings. 

Back Click this button to return to the top page.

ID (Fax Speed Dial) Displays the selected user ID.

Name Displays the name of the of the user registered under the selected user ID.

Phone Number Displays the phone number of the user.

E-mail Address Displays the e-mail address of the user.

Apply New Settings Click this button to apply the new settings. 

Back Click this button to return to the top page.
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FAX Group - Top Page
Purpose:

To view the fax group entries registered on the Fax Group page.
Values:

FAX Group (Confirm/Change, Create)
Purpose:

To view or edit the fax number group entries on the Fax Group page, or create a new entry. The following items are 
in the dialog box that appears when you click Confirm/Change or Create on the Fax Group top page.
Values:

FAX Group (Delete)
Purpose:

To delete the fax number group entries registered on the Fax Group page. The following items are in the dialog box 
that appears when you click Delete on the Fax Group top page.
Values:

GroupID:Name Displays a fax group ID and the assigned group name. IDs without an entry show (Not in Use) in 
the Name column.

Delete Deletes the entry for the selected group ID. 

Confirm/Change Displays a dialog box where you can edit the entry for the selected group ID.

Create Displays a dialog box where you can create a new entry under the selected group ID.

Fax Group ID Displays the selected group ID.

Name Allows you to view or edit the name assigned for the group ID, or 
enter a new group name.

FAX Speed Dial Address List to: Selecting each button displays a list of entries for the group of 
speed dial codes indicated on the button. 

ID:Name Displays a speed dial code and the names of an entry registered 
under the speed dial code. Speed dial codes without an entry show 
(Not in Use) in the Name column.

Phone Number Allows you to view or edit the fax number of an entry registered 
under the selected speed dial code, or enter a fax number for the 
new entry.

Apply New Settings Click this button to apply the new settings.

Restore Settings Click this button to restore the previous settings.

Back Click this button to return to the top page.

ID Displays the selected group ID.

Name Displays the name assigned for the group ID.

Apply New Settings Click this button to apply the new settings. 

Back Click this button to return to the top page.
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E-Mail Group - Top Page
Purpose:

To view the e-mail address entries registered on the E-Mail Group page.
Values:

E-Mail Group (Confirm/Change, Create)
Purpose:

To view or edit the e-mail address group entries on the E-Mail Group page, or create a new entry. The following 
items are in the dialog box that appears when you click Confirm/Change or Create on the E-Mail Group top page.
Values:

E-Mail Group (Delete)
Purpose:

To delete the e-mail group entries registered on the E-Mail Group page. The following items are in the dialog box 
that appears when you click Delete on the E-Mail Group top page.
Values:

GroupID:Name Displays a group ID and the assigned group name. IDs without an entry show (Not in Use) in the 
Name column.

Delete Deletes the entry for the selected group ID. 

Confirm/Change Displays a dialog box where you can edit the entry for the selected group ID.

Create Displays a dialog box where you can create a new entry under the selected group ID.

E-Mail Group ID Displays the selected group ID.

Name Allows you to view or edit the name assigned for the group ID, or 
enter a new group name.

E-Mail Address Address List to: Selecting each button displays a list of entries for the group of IDs 
indicated on the button. 

ID:Name Displays a user ID and the name of the user registered under that 
user ID. IDs without an entry show (Not in Use) in the Name 
column.

Address Allows you to view or edit the e-mail address of an entry registered 
under the selected user ID, or enter an e-mail address for the new 
entry.

Apply New Settings Click this button to apply the new settings.

Restore Settings Click this button to restore the previous settings.

Back Click this button to return to the top page.

ID Displays the selected group ID.

Name Displays the name assigned for the group ID.

Apply New Settings Click this button to apply the new settings. 

Back Click this button to return to the top page.
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E-Mail Default Setup
Purpose:

To set the default e-mail subject and message.
Values:

Server Address

Server Address - Top Page
Purpose:

To view the server address entries registered on the Server Address page.
Values:

Server Address (Confirm/Change, Create)
Purpose:

To view or edit the server address entries on the Server Address page, or create a new entry. The following items are 
in the dialog box that appears when you click Confirm/Change or Create on the Server Address top page.
Values:

Default Subject Allows you to enter the default e-mail subject. Up to 50 alphanumeric characters can be entered.

Body Text Allows you to enter the default e-mail message. Up to 200 alphanumeric characters can be 
entered.

Apply New Settings Click this button to apply the new settings. 

Restore Settings Click this button to restore the previous settings. 

Address List to: Selecting each button displays a list of entries for the group of IDs indicated on the button.

ID:Name Displays a server ID and the name of a file directory registered under that server ID. IDs without 
an entry show (Not in Use) in the Name column.

Server Address Displays the address of the file directory.

Delete Deletes the entry for the selected server ID. 

Confirm/Change Displays a dialog box where you can edit the entry for the selected server ID.

Create Displays a dialog box where you can create a new entry under the selected server ID.

ID Displays the selected server ID.

Name Allows you to view or change the server name assigned to the server ID, or enter a new server 
name.

Server Type FTP Select this to store scanned documents on a server via the FTP protocol.

SMB Select this to store scanned documents on a computer via the Server Message 
Block (SMB) protocol.

Server Address Allows you to view or edit the server address registered under the server ID, or enter a new server 
address.

Share Name Allows you to view or edit the assigned shared name, or enter a new shared name, when Server 
Type is set to SMB.

Server Path Allows you to view or edit the assigned server path, or enter a new path.
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Server Address (Delete)
Purpose:

To delete the server address entries registered on the Server Address page. The following items are in the dialog box 
that appears when you click Delete on the Server Address top page.
Values:

Tray Settings
Use the Tray Settings menu to set the paper size and type of paper loaded in the Multipurpose Feeder (MPF).
Values:

Server Port Number Allows you to view or edit the assigned server port number, or enter a new port number. If you 
leave the text box blank, the default port number (FTP: 21, SMB: 139) will be used.

Login Name Allows you to view or edit the login name that is required to access the selected protocol, or enter 
a new login name.

Login Password Allows you to view or edit the password that is required to access the selected protocol, or enter a 
new password.

Re-enter Password Enter the password again to confirm.

Apply New Settings Click this button to apply the new settings. 

Restore Settings Click this button to restore the previous settings. 

Back Click this button to return to the top page.

ID Displays the selected server ID.

Name Displays the name assigned for the server ID.

Server Address Displays the server address registered under the server ID.

Apply New Settings Click this button to apply the new settings. 

Back Click this button to return to the top page.

MPF Paper Type Sets the type of paper loaded in the MPF.

MPF Paper Size Sets the size of paper loaded in the MPF.

MPF Custom Size - Y Sets the length of custom size paper loaded in the MPF.

MPF Custom Size - X Sets the width of custom size paper loaded in the MPF.

Display Popup Sets whether to display a popup menu that prompts the user to set Paper Type and Paper Size 
when the paper is loaded in the MPF.

Apply New Settings Click this button to apply the new settings. 

Restore Settings Click this button to restore the previous settings. 
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14
Understanding the Tool Box Menus
The Tool Box allows you to view or specify the system settings. You can also diagnose the system settings by using 
the Tool Box.

The Tool Box consists of the Printer Settings Report, Printer Maintenance, and Diagnosis tabs.

 NOTE: The Password dialog box appears the first time you try to change settings on Tool Box when Panel Lock is set on the 
printer. In this case, enter the password you specified, and click OK to apply the settings.

Starting the Tool Box
Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Tool Box.

 NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this case, 
click Dell C1765nf Color Multifunction Printer or Dell C1765nfw Color Multifunction Printer listed in Printer Name.

The Tool Box opens.

Using the Tool Box to Change the Printer Settings
You can select menu items and corresponding values from the Tool Box.

To select a new value as a setting:

1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Tool Box.

 NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this 
case, click Dell C1765nf Color Multifunction Printer or Dell C1765nfw Color Multifunction Printer listed in Printer Name.

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select the desired menu item.

Each menu item has a list of values for the menu item. A value can be:

• A phrase or word to describe a setting

• A numerical value that can be changed

• An On or Off setting

4 Select the desired value, and then click the associated button with each menu item.

Driver settings may have precedence over changes previously made and may require you to change the Tool Box 
defaults.
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Printer Settings Report
The Printer Settings Report tab contains the Printer Information, Menu Settings, Reports, TCP/IP Settings, Tray 
Settings, Defaults Settings, and Fax Settings pages.

Printer Information
Purpose:

To display the information of your printer. 

Values:

Menu Settings
Purpose:

To display the current settings of your printer.

Values:

Dell Service Tag Number Displays the service tag number of your printer.

Express Service Code Displays the express service code of the printer.

Printer Serial Number Displays the serial number of the printer.

Printer Type Displays the type of the printer.

Asset Tag Number Displays the asset tag of the printer.

Memory Capacity Displays the memory capacity.

Processor Speed Displays the processing speed.

Firmware Version Displays the version of the controller.

Network Firmware Version Displays the Network Interface Card (NIC) version.

MCU Firmware Version Displays the version of the Machine Control Unit (MCU) firmware.

Printing Speed (Color) Displays the speed for color printing.

Printing Speed (Monochrome) Displays the speed for monochrome printing.

Boot Code Version Displays the boot code version.

Color Table Version Displays the color table version.

System Settings Sleep Displays the time taken by the printer before it enters 
Sleep mode after it finishes a job.

Deep Sleep Displays the time taken by the printer before it enters 
Deep Sleep mode after it goes into Sleep mode.

Auto Reset Displays the time taken by the printer before it 
automatically resets the settings for Copy, Scan, or Fax on 
the operator panel to the defaults when no additional 
settings are made.

Panel Select Tone Displays the volume of the tone that is emitted when the 
operator panel input is correct. Off indicates that the tone 
is disabled.

Panel Alert Tone Displays the volume of the tone that is emitted when the 
operator panel input is incorrect. Off indicates that the 
tone is disabled.
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Job Tone Displays the volume of the tone that is emitted when a job 
is complete. Off indicates that the tone is disabled.

Alert Tone Displays the volume of the tone that is emitted when a 
problem occurs. Off indicates that the tone is disabled.

Out of Paper Tone Displays the volume of the tone that is emitted when the 
printer runs out of paper. Off indicates that the tone is 
disabled.

Auto Clear Alert Tone Displays the volume of the tone that is emitted 5 seconds 
before the printer performs auto clear. Off indicates that 
the tone is disabled.

All Tones Displays the volume of all the alert tones. Off indicates 
that all the tones are disabled.

Job Time-Out Displays the amount of time that the printer waits for data 
to arrive from the computer.

Fault Time-Out Displays the time taken by the printer before it cancels 
jobs that stop abnormally.

Panel Language Displays the language used on the operator panel.

Auto Log Print Displays whether to automatically print a job history 
report after every 20 jobs.

Disable printing with larger paper size Displays whether to disable printing if the paper size set in 
the printer driver and the paper size set in the tray of the 
printer does not match (the paper set in the tray is larger).

mm/inch Displays the measurement unit used after the numeric 
value on the operator panel.

Date & Time Date Format Displays the default date format.

Time Format Displays the default time format; 24H or 12H.

Time Zone Displays the default time zone.

Set Date Displays the date setting.

Set Time Displays the time setting.

Paper Density Plain Displays the paper density of plain paper.

Label Displays the paper density of labels.

Adjust Transfer Roller Plain Displays the voltage setting of the transfer roller for plain 
paper.

Plain Thick Displays the voltage setting of the transfer roller for thick 
plain paper.

Recycled Displays the voltage setting of the transfer roller for 
recycled paper.

Covers Displays the voltage setting of the transfer roller for cover 
paper.

Coated Displays the voltage setting of the transfer roller for coated 
paper.

Envelope Displays the voltage setting of the transfer roller for 
envelopes.

Label Displays the voltage setting of the transfer roller for labels.
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Reports
Purpose:

To print the settings and history information of your printer. 

The reports are printed in the paper size specified in system settings.

Values:

Adjust Fusing Unit Plain Displays the temperature setting of the fusing unit for 
plain paper.

Plain Thick Displays the temperature setting of the fusing unit for 
thick plain paper.

Recycled Displays the temperature setting of the fusing unit for 
recycled paper.

Covers Displays the temperature setting of the fusing unit for 
cover paper.

Coated Displays the temperature setting of the fusing unit for 
coated paper.

Envelope Displays the temperature setting of the fusing unit for 
envelopes.

Label Displays the temperature setting of the fusing unit for 
labels.

Auto Registration 
Adjustment

Displays whether to automatically adjust color 
registration.

Adjust Altitude Displays the altitude of the location where the printer is 
installed.

Non-Dell Toner Displays whether to use toner cartridge of another 
manufacturer.

Transfer Roller Refresh 
Mode

Displays whether to execute counter measures for 
curling/separating discharge of the paper.

Web Link 
Customization

Select Reorder URL Displays a link used for ordering consumables.

Regular Displays the regular web address 
(http://accessories.us.dell.com/sna/PrinterSeg.aspx).

Premier Displays the premier web address 
(http://premier.dell.com).

System Settings Click to print a detailed list of the system settings.

Panel Settings Click to print a detailed list of the panel settings.

Job History Click to print the completed jobs history.

Error History Click to print the error history.

Color Test Page Click to print the Color Test Page.

Address Book List Click to print the list of Personal Address, Fax Group, and E-Mail Group stored as 
Address Book.

http://accessories.us.dell.com/sna/PrinterSeg.aspx
http://premier.dell.com
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TCP/IP Settings
Purpose:

To display the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) protocol.

Values:

Tray Settings
Purpose:

To display the paper size and type of paper loaded in the Multipurpose Feeder (MPF).

Values:

IP Address Mode Displays the method for acquiring the IP address.

IP Address Displays the IP address of your printer.

Subnet Mask Displays the subnet mask.

Gateway Address Displays the gateway address.

Paper Type Displays the paper type setting of the MPF.

Paper Size Displays the paper size setting of the MPF.

Custom Size - Y Displays the length of custom size paper loaded in the MPF.

Custom Size - X Displays the width of custom size paper loaded in the MPF.

Display Popup Displays whether to use a popup menu that prompts the user to set Paper Type 
and Paper Size when the paper is loaded in the MPF.
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Defaults Settings
Purpose:

To display the default scan, fax, and copy settings of the printer.

Values:

Scan Defaults File Format Displays the file format to save the scanned image.

Color Displays whether to scan in color or in black and white.

Resolution Displays the default scan resolution.

Document Size Displays the default document size.

Lighter/Darker Displays the default scan density level.

Sharpness Displays the default sharpness level.

Auto Exposure Displays whether to suppress the background of the original to enhance text 
on the scanned image.

Margin Top/Bottom Displays the value of the top and bottom margins.

Margin Left/Right Displays the value of the left and right margins.

Margin Middle Displays the value of the middle margin.

TIFF File Format Displays the TIFF file format.

Image Compression Displays the image compression level.

Max E-Mail Size Displays the maximum size of e-mail that can be sent.

Fax Defaults Resolution Displays the resolution level to be used for fax transmission.

Document Type Displays the type of document.

Lighter/Darker Displays the default density level to be used for fax transmission.

Delayed Start Displays the fax transmission start time.

Copy Defaults Color Displays whether to make copies in color or in black and white.

Reduce/Enlarge Displays the default copy reduction/enlargement ratio.

Original Type Displays the default document type.

Document Size Displays the default document size.

Lighter/Darker Displays the default copy density level.

Sharpness Displays the default sharpness level.

Auto Exposure Displays whether to suppress the background of the original to enhance text 
on the copy.

Color Balance (Red) Displays the color balance level of red.

Color Balance (Green) Displays the color balance level of green.

Color Balance (Blue) Displays the color balance level of blue.

Gray Balance Displays the gray balance level.

Multiple-Up Displays whether to enable the Multiple-Up feature.

Collated Displays whether to sort the copy job.

Margin Top/Bottom Displays the value of the top and bottom margins.

Margin Left/Right Displays the value of the left and right margins.

Margin Middle Displays the value of the middle margin.
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Fax Settings
Purpose:

To display the basic fax settings.

Values:

Receive Mode Displays the fax receiving mode.

Auto Rec Fax Displays the interval at which the printer goes into the fax receive mode after 
receiving an incoming call.

Auto Rec Fax/Tel Displays the interval at which the printer goes into the fax receive mode after the 
external telephone receives an incoming call.

Auto Rec Ans/Fax Displays the interval at which the printer goes into the fax receive mode after the 
external answering machine receives an incoming call.

Line Monitor Displays the volume of the line monitor, which audibly monitors a transmission 
through the internal speaker until a connection is made.

Ring Tone Volume Displays the volume of the ring tone, which indicates that an incoming call is a 
telephone call through the internal speaker when Receive Mode is set to 
Telephone/Fax.

Line Type Displays the line type.

Tone/Pulse Displays the dialing type.

Resend Delay Displays the interval between transmission attempts.

Redial Attempts Displays the number of redial attempts.

Redial Delay Displays the interval between redial attempts.

Junk Fax Setup Displays whether to reject faxes sent from unwanted numbers.

Remote Receive Displays whether to receive faxes by pressing a remote receive code on the external 
telephone.

Remote Rcv Tone Displays the remote receive code to start Remote Receive.

Fax Header Displays whether to print the information of sender on the header of faxes.

Fax Header Name Displays the name of sender to be printed on the header of faxes.

Fax Number Displays the fax number to be printed on the header of faxes.

Fax Cover Page Displays whether to attach a cover page to faxes.

DRPD Pattern Displays the Distinctive Ring Pattern Detection (DRPD) setting.

Sent Fax Fwd Displays whether to forward incoming faxes to a specified destination.

Fax Fwd Number Displays the fax number of the destination to which incoming faxes are to be 
forwarded.

Prefix Dial Displays whether to set a prefix dial number.

Prefix Dial Num Displays a prefix dial number. This number dials before any auto dial number is 
started.

Discard Size Displays whether to discard text or images at the bottom of a fax page when the 
entire page does not fit onto the output paper.

ECM Displays whether to enable the Error Correction Mode (ECM).

Modem Speed Displays the fax modem speed when a fax transmission or reception error occurs.

Fax Activity Displays whether to automatically print a fax activity report after every 50 
incoming and outgoing fax communications.
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Printer Maintenance
The Printer Maintenance tab contains the System Settings, Date & Time, Paper Density, Adjust Transfer Roller, 
Adjust Fusing Unit, Registration Adjustment, Adjust Altitude, Reset Defaults, Non-Dell Toner, Transfer Roller 
Refresh Mode, Web Link Customization, TCP/IP Settings, Tray Settings, EWS, Scan Defaults, Fax Defaults, 
Copy Defaults, and Fax Settings pages.

System Settings
Purpose:

To configure the power saving mode, auto clear time, warning tones, time-out time, operator panel language 
settings, job log auto print, and mm/inch setting.

Values:

Fax Transmit Displays whether to print a transmission report after every fax transmission or only 
when an error occurs.

Fax Broadcast Displays whether to print a transmission report after every fax transmission to 
multiple destinations or only when an error occurs.

Fax Protocol Displays whether to print a protocol monitor report after every fax transmission or 
only when an error occurs.

Country Displays the country where the printer is used.

Power Saver Timer Sleep*1 Available Range:
5– 30 minutes

Specifies the time taken by the printer before it enters Sleep 
mode after it finishes a job.

Deep Sleep Available Range:
1–6 minutes

Specifies the time taken by the printer before it enters Deep 
Sleep mode after it goes into Sleep mode.

Auto Reset 45 seconds Specifies the time taken by the printer before it automatically resets the settings for 
Copy, Scan, or Fax on the operator panel to the defaults when no additional 
settings are made.

1 minute

2 minutes

3 minutes

4 minutes

Alert Tone Panel Select 
Tone

Off Does not emit a tone when the operator panel input is correct.

Low Emits a tone at the specified volume when the operator panel 
input is correct.Medium

High

Panel Alert Tone Off Does not emit a tone when the operator panel input is 
incorrect.

Low Emits a tone at the specified volume when the operator panel 
input is incorrect.Medium

High

Job Tone Off Does not emit a tone when a job is complete.

Low Emits a tone at the specified volume when a job is complete.

Medium

High
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Alert Tone Off Does not emit a tone when a problem occurs.

Low Emits a tone at the specified volume when a problem occurs.

Medium

High

Out of Paper 
Tone

Off Does not emit a tone when the printer runs out of paper.

Low Emits a tone at the specified volume when the printer runs out 
of paper.Medium

High

Auto Clear Alert 
Tone

Off Does not emit a tone before the printer performs auto clear.

Low Emits a tone at the specified volume 5 seconds before the 
printer performs auto clear.Medium

High

All Tones Off Disables all the alert tones.

Low Specifies the volume of all the alert tones at once.

Medium

High

Job Time-Out 0 Disables the job time-out.

Available Range:
5–300 seconds

Specifies the amount of time that the printer waits for data to arrive from the 
computer. The print job is canceled if it times out.

Fault Time-Out 0 Disables the fault time-out.

Available Range:
3–300 seconds

Specifies the time taken by the printer before it cancels jobs that stop abnormally. 
The print job is canceled if it times out.

Panel Language English Specifies the language to be used on the operator panel.

French

Italian

German

Spanish

Dutch

Danish

Norwegian

Swedish

Simplified 
Chinese*2

Auto Log Print Off Does not automatically print a job history report.

On Automatically prints a job history report after every 20 jobs.
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Date & Time
Purpose:

To set the date and time, and regional time zone of the printer.

Values:

Paper Density
Purpose:

To specify the paper density.

Values:

Disable printing with 
larger paper size*3

Off Prints even if the paper set in the tray of the printer is larger than the paper size set 
in the printer driver (the paper size does not have to match).

On Disables printing if the paper size set in the printer driver differs from the paper set 
in the tray of the printer (the paper set in the tray is larger).

mm/inch millimeter (mm) Specifies the measurement unit displayed after the numeric value on the operator 
panel.inch (")

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.
*1 Enter 5 in Sleep to put the printer in the Sleep mode five minutes after it finishes a job. This uses less energy, but requires more warm-

up time for the printer. Enter 5 if your printer shares an electrical circuit with room lighting and you notice lights flickering.
Select a high value if your printer is in constant use. In most circumstances, this keeps the printer ready to operate with minimum 
warm-up time. Select a value between 5 and 30 minutes for the power saver timer mode if you want a balance between energy 
consumption and a shorter warm-up period.
The printer automatically returns to the standby mode from the Sleep mode when it receives data from the computer. You can also 
return the printer to the standby mode by pressing any button on the operator panel.

*2 This item is available only for DellTM C1765nf Color Multifunction Printer.
*3 Disable printing with larger paper size is available only in the Dell Printer Configuration Web Tool and the Tool Box.

Date Format Specifies the date format; yy/mm/dd, mm/dd/yy, or dd/mm/yy.

Time Format Specifies the time format; 12H or 24H.

Time Zone Specifies the time zone.

Set Date Specifies the current date.

Set Time Specifies the current time.

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.

Plain Light Specifies the paper density of plain paper. 

Normal

Label Light Specifies the paper density of labels.

Normal

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.
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Adjust Transfer Roller
Purpose:

To specify the optimum voltage settings for printing for the transfer roller. To decrease the voltage, set negative 
values. To increase, set positive values.

The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 
increase the voltage. If you see white spots on the print output, try to decrease the voltage.

 NOTE: The print quality changes depending on the values you select for this item.

Values:

Adjust Fusing Unit
Purpose:

To specify the optimum temperature settings for printing for the fusing unit. To decrease the temperature, set 
negative values. To increase, set positive values.

The default settings may not give the best output on all paper types. When the printed paper has curled, try to 
decrease the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.

 NOTE: The print quality changes depending on the values you select for this item.

Values:

Plain Available Range:
-3 – +3

Plain Thick Available Range:
-3 – +3

Recycled Available Range:
-3 – +3

Covers Available Range:
-3 – +3

Coated Available Range:
-3 – +3

Envelope Available Range:
-3 – +3

Label Available Range:
-3 – +3

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.

Plain Available Range:
-3 – +3

Plain Thick Available Range:
-3 – +3

Recycled Available Range:
-3 – +3

Covers Available Range:
-3 – +3

Coated Available Range:
-3 – +3



150 Understanding the Tool Box Menus

Registration Adjustment
Purpose:

To set Color Registration Adjustment (individual yellow, magenta, cyan correction) settings. When Auto 
Registration Adjustment is set to On, the printer prints the color registration chart and adjusts the color registration 
by using the chart. Color registration adjustment need to be made during the initial setup of the printer or when the 
printer is moved to a different location.

Values:

Envelope Available Range:
-3 – +3

Label Available Range:
-3 – +3

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.

Auto Registration 
Adjustment

Off Does not automatically adjust color registration.

On Automatically adjusts color registration.

Auto Correct*1 Click Start to automatically correct color registration.

Print Color Regi Chart*1,*2 Click Start to print a color registration chart.

Color Registration 
Adjustment 1 (Lateral)*1

Yellow Available Range:
-5–+5

Specifies lateral (perpendicular to paper feed 
direction) color adjustment values individually.

Magenta Available Range:
-5–+5

Cyan Available Range:
-5–+5

Color Registration 
Adjustment 2 (Process)*1

LY(Left Yellow) Available Range:
-5–+5

Specifies process (paper feed direction) color 
adjustment values individually.

LM(Left Magenta) Available Range:
-5–+5

LC(Left Cyan) Available Range:
-5–+5

RY(Right Yellow) Available Range:
-5–+5

RM(Right Magenta) Available Range:
-5–+5

RC(Right Cyan) Available Range:
-5–+5

Apply New Settings After you complete the settings, click Apply New Settings to apply the 
changes.

*1 This item is available only when Auto Registration Adjustment is set to Off.
*2 The color registration chart prints a lattice pattern of yellow, magenta, and cyan lines. On the chart, find the values on the right side that 

are next to the line that is perfectly straight for each of the three colors. If the value for this line is 0, color registration is not needed. If 
the value for this line is any value other than 0, specify the adjustment values under Color Registration Adjustment.
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Adjust Altitude
Purpose:

To specify the altitude of the location where the printer is installed. 

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 
performed by specifying the altitude of the location where the printer is being used.

 NOTE: An incorrect altitude adjustment setting leads to poor printing quality, incorrect indication of remaining toner.

Values:

Reset Defaults
Purpose:

To initialize NVM (non-volatile memory) for system parameters or Address Book data. After executing this function 
and rebooting the printer, the menu parameters or data are reset to their default values.

For details, see "Resetting Defaults" on page 162.

Values:

Non-Dell Toner
Purpose:

To use toner cartridge of another manufacturer.

 NOTE: Using non-Dell-brand toner cartridges may make some printer features unusable, reduce print quality and decrease the 
reliability of your printer. Dell recommends only new Dell-brand toner cartridges for your printer. Dell does not provide warranty 
coverage for problems caused by using accessories, parts, or components not supplied by Dell.

 NOTE: Before you use toner cartridge of another manufacturer, be sure to restart the printer.

Values:

0 meter Specifies the altitude of the location where the printer is installed. 

1000 meters

2000 meters

3000 meters

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.

System Section Click to initialize the system parameters.

User Fax Section Click to initialize the fax number entries in the Address Book.

User Scan Section Click to initialize the e-mail and server address entries in the Address Book.

Non-Dell Toner Off Does not use toner cartridge of another manufacturer.

On Uses toner cartridge of another manufacturer.

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.
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Transfer Roller Refresh Mode
Purpose:

To execute counter measures for curling/separating discharge of the paper.

Values:

Web Link Customization
Purpose:

To specify a link used for ordering consumables.

Values:

TCP/IP Settings
Purpose:

To configure TCP/IP settings.

Values:

Transfer Roller 
Refresh Mode

Off Does not automatically execute counter measures for curling/separating discharge 
of the paper.

On Automatically executes counter measures for curling/separating discharge of the 
paper.

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.

Select Reorder URL Select the Regular or Premier URL.

Regular Displays the regular web address 
(http://accessories.us.dell.com/sna/PrinterSeg.aspx).

Premier Displays the premier web address (http://premier.dell.com).

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.

IP Address Mode AutoIP Automatically sets the IP address.

BOOTP Uses BOOTP to set the IP address.

RARP Uses RARP to set the IP address.

DHCP Uses DHCP to set the IP address.

Panel Manually sets the IP address.

IP Address Manually sets the IP address allocated to the printer.

Subnet Mask Manually sets the subnet mask.

Gateway Address Manually sets the gateway address.

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.

Restart printer to apply new settings Click Restart printer to apply new settings to apply the changes.

http://accessories.us.dell.com/sna/PrinterSeg.aspx
http://premier.dell.com
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Tray Settings
Purpose:

To specify the paper size and type of paper loaded in the Multipurpose Feeder (MPF).

Values:

Paper Type Plain Specifies the type of paper loaded in the MPF.

Plain Thick

Covers

Coated

Labels

Recycled

Envelope

Plain - Side 2

Plain Thick - Side 2

Covers - Side 2

Coated - Side 2

Recycled - Side 2

Paper Size A4 Specifies the size of paper loaded in the MPF.

A5

B5

Letter

Folio

Legal

Executive

Envelope #10

Monarch

Monarch Landscape

DL

DL Landscape

C5

Custom Size

Custom Size - Y Available Range:
127–355 mm/
5.0–14.0 inch

Specifies the length of custom size paper.

Custom Size - X Available Range:
77–215 mm/3.0–8.5 
inch

Specifies the width of custom size paper.

Display Popup On Displays a popup menu that prompts the user to set Paper Type and Paper Size 
when the paper is loaded in the MPF.

Off Does not display a popup menu.

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.
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EWS (Embedded Web Server or Dell Printer Configuration Web Tool)
Purpose:

To display the server settings of the Dell Printer Configuration Web Tool.

 NOTE: When the printer is connected to the USB port, this setting cannot be displayed. 

Values:

Scan Defaults
Purpose:

To create your own default scan settings.

Values:

Print Server Settings Click Display to display the server settings for the Dell Printer Configuration 
Web Tool.

Display of EWS On Turns on the display of the server settings for the Dell Printer Configuration Web 
Tool.

Off Turns off the display of the server settings for the Dell Printer Configuration Web 
Tool.

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.

Restart printer to apply new settings  Click Restart printer to apply new settings to apply the changes.

File Format TIFF Saves the scanned image in TIFF.

PDF Saves the scanned image in PDF.

JPEG Saves the scanned image in JPEG.

Color Black & White Scans in black and white mode.

GrayScale Scan in grayscale mode.

Color Scans in color mode.

Color (Photo) Scans in color mode. This is suitable for photographic images.

Resolution 200 Scans an image at 200dpi.

300 Scans an image at 300dpi.

400 Scans an image at 400dpi.

600 Scans an image at 600dpi.

Document Size A4 Sets the document size to A4.

A5 Sets the document size to A5.

B5 Sets the document size to B5.

Letter Sets the document size to Letter.

Folio Sets the document size to Folio.

Legal Sets the document size to Legal.

Executive Sets the document size to Executive.
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Lighter/Darker Lighter2 Makes the scanned image lighter than the original. Works well with dark print.

Lighter1

Normal Works well with standard typed or printed documents. 

Darker1 Makes the scanned image darker than the original. Works well with light print or 
faint pencil markings.Darker2

Sharpness Softest Makes the scanned image softer than the original.

Softer

Normal Does not make the scanned image sharper or softer than the original.

Sharper Makes the scanned image sharper than the original.

Sharpest

Auto Exposure On Suppresses the background of the original to enhance text on the scanned image.

Off Does not suppress the background.

Margin Top/Bottom Available Range:
0–50 mm/0.0–2.0 
inch

Specifies the value of the top and bottom margins. 

Margin Left/Right Available Range:
0–50 mm/0.0–2.0 
inch

Specifies the value of the left and right margins. 

Margin Middle Available Range:
0–50 mm/0.0–2.0 
inch

Specifies the value of the middle margin.

TIFF File Format TIFF V6 Sets the TIFF file format to TIFF V6.

TTN2 Sets the TIFF file format to TTN2.

Image Compression High Sets the image compression level to High.

Medium Sets the image compression level to Medium.

Low Sets the image compression level to Low.

Max E-Mail Size Sets the maximum size of e-mail that can be sent, within the range of 50 K bytes 
to 16384 K bytes.

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.
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Fax Defaults
Purpose:

To create your own default Fax settings.

Values:

Resolution Standard Suitable for documents with normal sized characters.

Fine Suitable for documents containing small characters or thin lines or documents 
printed using a dot-matrix printer.

Super Fine Suitable for documents containing extremely fine detail. The super fine mode is 
enabled only if the remote machine also supports the Super Fine resolution.

Ultra Fine Suitable for documents containing photographic images.

Document Type Text Improves the image quality of documents with text.

Photo Improves the image quality of documents with photos.

Lighter/Darker Lighter2 Makes the fax lighter than the original. Works well with dark print.

Lighter1

Normal Works well with standard typed or printed documents. 

Darker1 Makes the fax darker than the original. Works well with light print or faint pencil 
markings.Darker2

Delayed Start Available Range:
00:00–23:59

Sets the fax transmission start time when sending a fax at a specified time.

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.
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Copy Defaults
Purpose:

To create your own default Copy settings.

Values:

Color Black & White Prints in black and white mode.

Color Prints in color mode. 

Reduce/Enlarge mm series 200% Sets the default enlargement ratio when you set 
the default measurement unit to millimeter.A5->A4 (141%)

A5->B5 (122%)

100% Does not enlarge or reduce the size of a copied 
image.

B5->A5 (81%) Sets the default reduction ratio when you set 
the default measurement unit to millimeter.A4->A5 (70%)

50%

Custom Sets the default reduction/enlargement ratio to 
the custom size.

inch series 200% Sets the default enlargement ratio when you set 
the default measurement unit to inch.Statement->Legal (154%)

Statement->Letter (129%)

100% Does not enlarge or reduce the size of a copied 
image.

Legal->Letter (78%) Sets the default reduction ratio when you set 
the default measurement unit to inch.Ledger->

Letter (64%)

50%

Custom Sets the default reduction/enlargement ratio to 
the custom size.

Custom Reduce/Enlarge Available Range:
25–400%

Reduces or enlarges the image to the custom 
size when Reduce/Enlarge is set to Custom.

Original Type Text Suitable for documents with text.

Text & Photo Suitable for documents with both text and 
photos/gray tones.

Photo Suitable for documents with photos.

Document Size A4 Sets the document size to A4.

A5 Sets the document size to A5.

B5 Sets the document size to B5.

Letter Sets the document size to Letter.

Folio Sets the document size to Folio.

Legal Sets the document size to Legal.

Executive Sets the document size to Executive.
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Lighter/Darker Lighter2 Makes the copy lighter than the original. Works 
well with dark print.Lighter1

Normal Works well with standard typed or printed 
documents. 

Darker1 Makes the copy darker than the original. Works 
well with light print or faint pencil markings.Darker2

Sharpness Softest Makes the copy softer than the original.

Softer

Normal Does not make the copy sharper or softer than 
the original.

Sharper Makes the copy sharper than the original.

Sharpest

Auto Exposure On Suppresses the background of the original to 
enhance text on the copy.

Off Does not suppress the background.

Color Balance (Red) Available Range:
-2– 2

Sets the color balance level of red. 

Color Balance (Green) Available Range:
-2– 2

Sets the color balance level of green.

Color Balance (Blue) Available Range:
-2– 2

Sets the color balance level of blue. 

Gray Balance Available Range:
-2– 2

Sets the gray balance level.

Multiple-Up Off Does not perform multiple-up printing.

Auto Automatically reduces the original pages to fit 
onto one sheet of paper.

Manual Prints the original pages onto the one sheet of 
paper in the size specified in Reduce/Enlarge.

Collated Uncollated Does not sort the copy job.

Collated Sorts the copy job.

Auto Automatically determines which output mode 
for the copy job.

Margin Top/Bottom Available Range:
0-50 mm/0.0-2.0 
inch

Specifies the value of the top and bottom 
margins.

Margin Left/Right Available Range:
0-50 mm/0.0-2.0 
inch

Specifies the value of the left and right margins.

Margin Middle Available Range:
0-50 mm/0.0-2.0 
inch

Specifies the value of the middle margin.

Apply New Settings After you complete the settings, click Apply 
New Settings to apply the changes.
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Fax Settings
Purpose:

To configure the basic fax settings.

Values:

Receive Mode Telephone Automatic fax reception is turned off. You can receive a fax by picking up the 
handset of the external telephone, and then pressing the remote receive code.

Fax Automatically receives faxes.

Telephone/Fax When the printer receives an incoming fax, the external telephone rings for the 
time specified in Auto Rec Fax/Tel, and then the printer automatically receives a 
fax. If an incoming call is not a fax, the printer beeps from the internal speaker 
indicating that the call is a telephone call.

Ans Machine/Fax The printer can share a telephone line with an answering machine. In this mode, 
the printer will monitor the fax signal and pick up the line if there are fax tones. If 
the phone communication is using serial transmission in your country (such as 
Germany, Sweden, Denmark, Austria, Belgium, Italy, France and Switzerland), this 
mode is not supported.

DRPD Before using the Distinctive Ring Pattern Detection (DRPD) option, a distinctive 
ring service must be installed on your telephone line by the telephone company. 
After the telephone company has provided a separate number for faxing with a 
distinctive ring pattern, configure the fax setup to monitor for that specific ring 
pattern.

Auto Rec Fax Available Range:
0–255 seconds

Sets the interval at which the printer goes into the fax receive mode after receiving 
an incoming call.

Auto Rec Fax/Tel Available Range:
0–255 seconds

Sets the interval at which the printer goes into the fax receive mode after the 
external telephone receives an incoming call.

Auto Rec Ans/Fax Available Range:
0–255 seconds

Sets the interval at which the printer goes into the fax receive mode after the 
external answering machine receives an incoming call.

Line Monitor Off Turns off the volume of the line monitor.

Low Specifies the volume of the line monitor, which audibly monitors a transmission 
through the internal speaker until a connection is made.Medium

High

Ring Tone Volume Off Turns off the volume of the ring tone.

Low Specifies the volume of the ring tone, which indicates that an incoming call is a 
telephone call through the internal speaker when Receive Mode is set to 
Telephone/Fax.

Medium

High

Line Type PSTN Sets the line type to PSTN.

PBX Sets the line type to PBX.

Tone/Pulse Tone Sets the dialing type to Tone.

Pulse (10PPS) Sets the dialing type to Pulse (10 pulse per second).

Pulse (20PPS)*1 Sets the dialing type to Pulse (20 pulse per second).

Resend Delay Available Range:
3–255 seconds

Specifies the interval between transmission attempts.

Redial Attempts Available Range:
0–9

Specifies the number of redial attempts to make when the destination fax number 
is busy. If you enter 0, the printer will not redial.
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Redial Delay Available Range:
1–15 minutes

Specifies the interval between redial attempts.

Junk Fax Setup Off Does not reject faxes sent from unwanted numbers.

On Rejects faxes sent from unwanted numbers by accepting faxes only from the fax 
numbers registered in the Phone Book.

Remote Receive Off Disables the remote receive feature.

On Receives a fax by pressing a remote receive code on the external telephone after 
picking up the handset of the telephone.

Remote Rcv Tone Available Range:
00–99

Specifies the remote receive code in two digits to start Remote Receive.

Fax Header On Prints the information of sender on the header of faxes.

Off Does not print the information of sender on the header of faxes.

Fax Header Name Sets the name of sender to be printed on the header of faxes. Up to 30 
alphanumeric characters can be entered.

Fax Number Sets the fax number of the printer to be printed on the header of faxes.

Fax Cover Page Off Does not attach a cover page to faxes.

On Attaches a cover page to faxes.

DRPD Pattern Pattern1–7 Provides a separate number for faxing with a distinctive ring pattern.

Sent Fax Fwd Off Does not forward incoming faxes.

Forward Always forwards incoming faxes to a specified destination.

Print and Forward Always forwards incoming faxes to a specified destination and prints all forwarded 
incoming faxes.

Fax Fwd Number Specifies the fax number of the destination to which incoming faxes will be 
forwarded.

Prefix Dial Off Does not set a prefix dial number.

On Sets a prefix dial number.

Prefix Dial Num Sets a prefix dial number of up to five digits. This number dials before any auto 
dial number is started. It is useful for accessing the Private Automatic Branch 
Exchange (PABX).

Discard Size Off Prints any excess at the bottom of a fax page without discarding it.

On Discards any excess at the bottom of a fax page.

Auto Reduction Automatically reduces a fax page to fit it onto the output paper.

ECM On Enables the ECM. To use the ECM, the remote machines must also support the 
ECM. 

Off Disables the ECM.

Modem Speed 2.4 Specifies the fax modem speed when a fax transmission or reception error occurs.

4.8

9.6

14.4

33.6

Fax Activity Auto Print Automatically prints a fax activity report after every 50 incoming and outgoing fax 
communications.

No Auto Print Does not automatically print a fax activity report.
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Diagnosis
The Diagnosis tab contains the Chart Print, Environment Sensor Info, Clean Developer, and Refresh Mode pages.

Chart Print
Purpose:

To print various charts that can be used for diagnosing your printer.

Values:

Environment Sensor Info
Purpose:

To output the internal environment sensor information of the printer to Result by clicking Get Environment Sensor 
Info.

Fax Transmit Print Disable Does not print a transmission report after a fax transmission.

Print On Error Prints a transmission report only when an error occurs.

Print Always Prints a transmission report after every fax transmission.

Fax Broadcast Print Disable Does not print a transmission report after a fax transmission to multiple 
destinations.

Print On Error Prints a transmission report only when an error occurs.

Print Always Prints a transmission report after every fax transmission to multiple destinations.

Fax Protocol Print Disable Does not print a protocol monitor report.

Print On Error Prints a protocol monitor report only when an error occurs.

Print Always Prints a protocol monitor report after every fax transmission.

Country Selects the country where the printer is used.

Apply New Settings After you complete the settings, click Apply New Settings to apply the changes.

Restart printer to apply new settings Click Restart printer to apply new settings to apply the changes.
*1 Pulse (20PPS) is available only in certain regions.

Pitch Configuration Chart Click to print full halftone pages for yellow, magenta, cyan, and black. Also outputs 
pages to check the pitch.

Ghost Configuration Chart Click to print a chart to check for ghost printing.

4 Colors Configuration Chart Click to print bands of yellow, magenta, cyan, and black with varying density.

MQ Chart Click to print charts to check for the binding.

Alignment Chart Click to print a chart, and then check for proper alignment of the print image on 
the paper.

Drum Refresh Configuration Chart Click to print a chart to check the light fatigue of the drum unit.
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Clean Developer
Purpose:

To rotate the developer motor and stir the toner in the toner cartridge. 

Values:

Refresh Mode
Purpose:

To use up a toner cartridge when you need to replace it before the end of its life, or to stir the toner in a new toner 
cartridge.

 NOTE: Using the Refresh Mode consumes extra toner.

Values:

Resetting Defaults
After executing this function and rebooting the printer, the menu parameters or data are reset to their default values.

1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Tool Box.

 NOTE: When multiple printer drivers are installed on your computer, the Select Printer window appears. In this case, click 
Dell C1765nf Color Multifunction Printer or Dell C1765nfw Color Multifunction Printer listed in Printer Name.

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select Reset Defaults from the list at the left side of the page.

The Reset Defaults page is displayed.

4 Select the desired option button.

The printer restarts automatically to apply the settings.

Clean Developer Click Start to stir the toner.

Toner Refresh Mode Yellow Click to clean the toner in the yellow toner cartridge.

Magenta Click to clean the toner in the magenta toner cartridge.

Cyan Click to clean the toner in the cyan toner cartridge.

Black Click to clean the toner in the black toner cartridge.
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15
Understanding the Printer Menus
When your printer is configured as a network printer available to a number of users, the access to the Admin Menu 
menus can be limited. This prevents unauthorized users from using the operator panel to inadvertently change the 
default menu settings that has been set by the administrator. However, you can use select settings for individual 
print jobs using the printer driver. Print settings selected from the printer driver have precedence over the default 
menu settings selected from the operator panel.

Defaults Settings
Use the Defaults Settings menu to configure the default copy, scan, and fax settings of the printer.

Copy Defaults
Use the Copy Defaults menus to configure a variety of copy features.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Color

Purpose:

To set whether to make copies in color or in black and white.

Values:

Collated

Purpose:

To sort the copy job.

Values:

Black & White Prints in black and white mode.

Color* Prints in color mode. 

Uncollated* Does not sort the copy job. 

Collated Sorts the copy job. 

Auto Automatically determines which output mode for the copy job.
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Reduce/Enlarge

Purpose:

To set the default copy reduction/enlargement ratio.

Values:

mm series

inch series

 NOTE: You can also use the numeric keypad to input the desired zoom ratio from 25% to 400%, or press  to enlarge the zoom 
ratio or press  to reduce the zoom ratio in 1% intervals.

 NOTE: This item is available only when Multiple-Up is set to Off or Manual.

200%

A5->A4(141%)

A5->B5(122%)

100%*

B5->A5(81%)

A4->A5(70%)

50%

200%

Stmt->Lgl(154%)

Stmt->Ltr(129%)

100%*

Lgl->Ltr (78%)

Ldgr->Ltr(64%)

50%
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Document Size

Purpose:

To specify the default document size.

Values:

Original Type

Purpose:

To select the copy image quality.

Values:

Lighter/Darker

Purpose:

To set the default copy density level.

Values:

A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Letter (8.5 x 11")*1

Folio (8.5 x 13")

Legal (8.5 x 14")

Executive (7.25 x 10.5")
*1 The default for 

Document Size varies 
depending on country-specific 
factory default.

Text Suitable for documents with text.

Text & Photo* Suitable for documents with both text and photos/gray tones. 

Photo Suitable for documents with photos. 

Lighter2 Makes the copy lighter than the original. Works well with dark print. 

Lighter1

Normal* Works well with standard typed or printed documents. 

Darker1 Makes the copy darker than the original. Works well with light print or faint pencil markings. 

Darker2
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Sharpness

Purpose:

To set the default sharpness level.

Values:

Auto Exposure

Purpose:

To suppress the background of the original to enhance text on the copy.

Values:

Color Balance R

Purpose:

To specify the default color balance level of red within the range of -2 to +2.

Color Balance G

Purpose:

To specify the default color balance level of green within the range of -2 to +2.

Color Balance B

Purpose:

To specify the default color balance level of blue within the range of -2 to +2.

Gray Balance

Purpose:

To specify the default gray balance level within the range of -2 to +2.

Sharpest Makes the copy sharper than the original. 

Sharper

Normal* Does not make the copy sharper or softer than the original. 

Softer Makes the copy softer than the original.

Softest

Off Does not suppress the background.

On* Suppresses the background of the original to enhance text on the copy.
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Multiple-Up

Purpose:

To print two original pages to fit onto one sheet of paper.

Values:

Margin Top/Bottom

Purpose:

To specify the value of the top and bottom margins.

Values:

Margin Left/Right

Purpose:

To specify the value of the left and right margins.

Values:

Margin Middle

Purpose:

To specify the value of the middle margin.

Values:

Off* Does not perform multiple-up printing. 

Auto Automatically reduces the original pages to fit onto one sheet of paper. 

Manual Prints the original pages onto the one sheet of paper in the size specified in Reduce/Enlarge.

4 mm*/0.2 inch* Specify the value in increments of 1 mm/0.1 inch.

Available Range:
0-50 mm/0.0-2.0 inch

4 mm*/0.2 inch* Specify the value in increments of 1 mm/0.1 inch.

Available Range:
0-50 mm/0.0-2.0 inch

0 mm*/0.0 inch* Specify the value in increments of 1 mm/0.1 inch.

Available Range:
0-50 mm/0.0-2.0 inch
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Scan Defaults
Use the Scan Defaults menus to configure a variety of scanner features.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

File Format

Purpose:

To specify the file format to save the scanned image.

Values:

Color

Purpose:

To set whether to scan in color or in black and white.

Values:

Color Button Set

Purpose:

To assign color mode to the color mode switch button.

Values:

Resolution

Purpose:

To specify the default scan resolution.

Values:

PDF*

TIFF

JPEG 

Black & White Scans in black and white mode.

Color* Scans in color mode.

B&W Button Black & White* Scans in black and white when Black & White is selected for a color mode.

Grayscale Scans in gray scale when Black & White is selected for a color mode.

Color Button Color* Scans in color when Color is selected for a color mode.

Color(Photo) Scans in color (Photo) when Color is selected for a color mode. This is suitable 
for photographic images.

200 x 200dpi*

300 x 300dpi

400 x 400dpi

600 x 600dpi
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Document Size

Purpose:

To specify the default document size.

Values:

Lighter/Darker

Purpose:

To set the default scan density level.

Values:

A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Letter (8.5 x 11")*1

Folio (8.5 x 13")

Legal (8.5 x 14")

Executive (7.25 x 10.5")
*1 The default for 

Document Size varies 
depending on country-specific 
factory default.

Lighter2 Makes the scanned image lighter than the original. Works well with dark print. 

Lighter1

Normal* Works well with standard typed or printed documents. 

Darker1 Makes the scanned image darker than the original. Works well with light print or faint pencil markings. 

Darker2
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Sharpness

Purpose:

To set the default sharpness level.

Values:

Auto Exposure

Purpose:

To suppress the background of the original to enhance text on the scanned image.

Values:

Margin Top/Bottom

Purpose:

To specify the value of the top and bottom margins.

Values:

Margin Left/Right

Purpose:

To specify the value of the left and right margins.

Values:

Sharpest Makes the scanned image sharper than the original.

Sharper

Normal* Does not make the scanned image sharper or softer than the original.

Softer Makes the scanned image softer than the original.

Softest

Off Does not suppress the background.

On* Suppresses the background of the original to enhance text on the scanned image.

2 mm*/0.1 inch* Specify the value in increments of 1 mm/0.1 inch.

Available Range:
0-50 mm/0.0-2.0 inch

2 mm*/0.1 inch* Specify the value in increments of 1 mm/0.1 inch.

Available Range:
0-50 mm/0.0-2.0 inch
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Margin Middle

Purpose:

To specify the value of the middle margin.

Values:

TIFF File Format

Purpose:

To specify the default TIFF file format.

Values:

Image Compression

Purpose:

To specify the image compression level.

Values:

Max E-Mail Size

Purpose:

To specify the maximum size of e-mail that can be sent, within the range of 50 K bytes to 16384 K bytes. The default 
is 2048 K bytes.

0 mm*/0.0 inch* Specify the value in increments of 1 mm/0.1 inch.

Available Range:
0-50 mm/0.0-2.0 inch

TIFF V6* Sets the default TIFF file format to TIFF V6.

TTN2 Sets the default Tiff file format to TTN2.

High Sets the image compression level to High.

Medium* Sets the image compression level to Medium.

Low Sets the image compression level to Low.
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Fax Defaults
Use the Fax Defaults menus to configure a variety of fax features.

 NOTE: The FAX service cannot be used unless you set up a country code under Country. If Country is not set up, a 
message Set The Country Code appears on the display.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Resolution

Purpose:

To specify the resolution level to be used for fax transmission.

Values:

 NOTE: Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving device.

Original Type

Purpose:

To select the default document type.

Values:

Lighter/Darker

Purpose:

To set the default copy density level.

Values:

Standard* Suitable for documents with normal sized characters. 

Fine Suitable for documents containing small characters or thin lines or documents printed using a dot-matrix 
printer. 

Super Fine Suitable for documents containing extremely fine detail. The Super Fine mode is enabled only if the 
remote machine also supports the super fine resolution. See the notes below.

Ultra Fine Suitable for documents containing photographic images.

Text* Suitable for documents with text.

Photo Suitable for documents with photos.

Lighter2 Makes the fax lighter than the original. Works well with dark print. 

Lighter1

Normal* Works well with standard typed or printed documents. 

Darker1 Makes the fax darker than the original. Works well with light print or faint pencil markings. 

Darker2
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Delayed Start

Purpose:

This feature enables you to set a specific time for the fax transmission to start. Once Delayed Start mode is 
activated, your printer stores all of the documents to be faxed into its memory and sends them at the specified time. 
After faxing in the Delayed Start mode is complete, the data in the memory is cleared.

Values:

 NOTE: A maximum of 19 delayed fax jobs can be stored in this printer.

Print from USB Defaults

Layout

Purpose:

To automatically enlarge print documents when you print directly from a USB storage device.

Values:

Tray Settings
Use the Tray Settings menu to set the paper size and type of paper loaded in the Multipurpose Feeder (MPF).

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

MPF
Purpose:

To specify the paper loaded in the MPF.

Values:

21:00*/PM9:00* Specify the fax transmission start time when sending a fax at a specified time. 

0:00 - 23:59 / 
AM/PM1:00 - 12:59

Auto* Automatically enlarges print documents to fit on the paper.

Off Does not enlarge print documents.

Paper Size A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Letter (8.5 x 11")*1

Folio (8.5 x 13")

Legal (8.5 x 14")

Executive (7.25 x 10.5")

Envelope #10 (4.1x9.5")

Monarch Env. (3.9x7.5")

Monarch Env. L (7.5x3.9")
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 NOTE: For more information on supported paper sizes, see "Supported Paper Sizes" on page 208.

Report / List
Use the Report / List menu to print various types of reports and lists.

 NOTE: A password is required to enter the Report / List menu when Panel Lock Set is set to Enable. In this 
case, enter the password you specified, and press the  (Set) button.

System Settings
Purpose:

To print a list of the information such as the printer name, service tag, the status of the printer, consumables, and 
the network settings.

Panel Settings
Purpose:

To print a detailed list of all the settings on the operator panel menus.

DL Env. (110x220 mm)

DL Env. L (220x110 mm)

C5 Envelope (162 x 229 mm)

Custom Size Portrait(Y) 297mm*/11.7inch* Specifies the length of the custom size 
paper.Available Range:

127-355 mm/5.0-14.0 inches

Landscape(X) 210mm*/8.3inch* Specifies the width of the custom size 
paper.Available Range:

77-215 mm/3.0-8.5 inches

Paper Type Plain*

Plain Thick

Covers

Coated

Labels

Recycled

Envelope

Plain S2

Plain Thick S2

Covers S2

Coated S2

Recycled S2

Display Popup Off Does not display a popup menu.

On* Displays a popup menu that prompts the user to set Paper Size and Paper Type 
when the paper is loaded in the MPF.

*1 The default for Paper Size varies depending on country-specific factory default.
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Job History
Purpose:

To print a detailed list of the print, copy, fax, or scan jobs that have been processed. This list contains the last 20 jobs.

Error History
Purpose:

To print a detailed list of paper jams and fatal errors.

Color Test Page
Purpose:

To print a page for testing colors.

Protocol Monitor
Purpose:

To print a detailed list of monitored protocols.

Address Book
Purpose:

To print the list of all addresses stored as Address Book information.

Fax Activity
Purpose:

To print the report of faxes you recently received or sent.

Printing a Report/List Using the Operator Panel
1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Report / List is highlighted, and then press the  (Set) button.

4 Press the  button until the desired report or list is highlighted, and then press the  (Set) button.

The selected report or list is printed.

Printing a Report/List Using the Tool Box
1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Tool Box.

 NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this 
case, click Dell C1765nf Color Multifunction Printer or Dell C1765nfw Color Multifunction Printer listed in Printer Name.

The Tool Box opens.

2 Click the Printer Settings Report tab.

3 Select Reports from the list at the left side of the page.

The Reports page is displayed.

4 Click the button for the desired report or list.

The report or list is printed.
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Admin Menu
Use the Admin Menu menu to configure a variety of printer features.

 NOTE: A password is required to enter the Admin Menu menu when Panel Lock Set is set to Enable. In this case, 
enter the password you specified, and press the  (Set) button.

Phone Book
Use the Phone Book menu to configure the speed dial and group dial settings.

Speed Dial

Purpose:

To store up to 99 frequently dialed numbers in speed dial locations.

See also:

"Setting Speed Dial" on page 289.

Group Dial

Purpose:

To create a group of fax destinations and register it under a two-digit dial code. Up to 6 group dial codes can be 
registered.

See also:

"Setting Group Dial" on page 291.

Network
Use the Network menu to change the printer settings affecting jobs sent to the printer through the wired or 
wireless network.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Ethernet

Purpose:

To specify the communication speed and the duplex settings of Ethernet. The change takes effect after the printer is 
turned off and then on.

Values:

 NOTE: For Dell C1765nfw Color Multifunction Printer, this item is not displayed when the Ethernet cable is disconnected and 
Wi-Fi is set to On.

Auto* Detects the Ethernet settings automatically.

10BASE-T Half Uses 10base-T half-duplex.

10BASE-T Full Uses 10base-T full-duplex.

100BASE-TX Half Uses 100base-TX half-duplex.

100BASE-TX Full Uses 100base-TX full-duplex.
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Wireless Status (Dell™ C1765nfw Color Multifunction Printer only)

Purpose:

To display the information on the wireless signal strength. No changes can be made on the operator panel to improve 
the status of the wireless connection.

Values:

 NOTE: This item is displayed when the Ethernet cable is disconnected and Wi-Fi is set to On.

Wireless Setup (Dell C1765nfw Color Multifunction Printer only)

Purpose:

To configure the wireless network interface.

Values:

Connection Good Indicates good signal strength.

Acceptable Indicates marginal signal strength.

Low Indicates insufficient signal strength.

No Reception Indicates that no signal is received.

SSID Displays the name that identifies the wireless network.

Encryption Type Displays the encryption type.

Select Access Select the access point from the list.

WEP Key Entry When you select an access point using WEP as the security method, 
enter the WEP key. For 64bit keys, up to 10 hexadecimal characters can 
be entered. For 128bit keys, up to 26 hexadecimal characters can be 
entered.

PassPhrase Entry When you select an access point using WPA, WPA2, or Mixed as the 
encryption type, enter the passphrase of 8 to 63 alphanumeric 
characters.

Manual Setup Enter Network 
(SSID)

Specify a name to identify the wireless network. Up to 32 alphanumeric 
characters can be entered.

Infrastructure Select when you configure the wireless setting through the access point 
such as a wireless router.

No Security* Specify No Security to configure the wireless setting without specifying 
a security method from WEP, WPA-PSK-TKIP, and WPA2-PSK-AES.

Mixed mode PSK Select to configure the wireless setting with the encryption type of 
Mixed mode PSK. Mixed mode PSK automatically selects the 
encryption type from either WPA-PSK-TKIP, WPA-PSK-AES, or 
WPA2-PSK-AES.

PassPhrase 
Entry

Specifies the passphrase of alphanumeric characters 
from 8 to 63.

WPA-PSK-TKIP Select to configure the wireless setting with the security method of 
WPA-PSK-TKIP.

PassPhrase 
Entry

Specify the passphrase of alphanumeric characters 
from 8 to 63.
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 NOTE: This item is displayed when the Ethernet cable is disconnected and Wi-Fi is set to On.

WPS (Dell C1765nfw Color Multifunction Printer only)

Purpose:

To configure the wireless network using WPS.

Values:

 NOTE: WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed mode PSK, WPA-PSK 
AES, WPA2-PSK AES, WPA-PSK TKIP, Open (No Security)

 NOTE: This item is displayed when the Ethernet cable is disconnected and Wi-Fi is set to On.

WPA2-PSK-AES Select to configure the wireless setting with the security method of 
WPA2-PSK-AES or WPA-PSK-AES.

PassPhrase 
Entry

Specify the passphrase of alphanumeric characters 
from 8 to 63.

WEP Specifies the WEP key to use through the wireless network. For 64bit 
keys, up to 10 hexadecimal characters can be entered. For 128bit keys, 
up to 26 hexadecimal characters can be entered.

Transmit Key Specifies the transmit key from WEP Key 1*, WEP 
Key 2, WEP Key 3, and WEP Key 4.

Ad-hoc Select to configure the wireless setting without the access point such as 
a wireless router.

No Security* Specify No Security to configure the wireless setting without specifying 
the security method from WEP.

WEP Specifies the WEP key to use through the wireless network. For 64bit 
keys, up to 10 hexadecimal characters can be entered. For 128bit keys, 
up to 26 hexadecimal characters can be entered.

Transmit Key Specifies the transmit key from WEP Key 1*, WEP 
Key 2, WEP Key 3, and WEP Key 4.

Push Button Control PBC Start*1 No*  Disables the security method of WPS-PBC.

Yes  Configures the wireless setting with the security method of 
WPS-PBC.

PIN Code Start Configuration Configures the wireless setting using the PIN code assigned 
automatically by the printer.

Print PIN Code Prints the PIN code. Confirm it when you enter the PIN code to 
your computer.

*1 You can also start  WPS-PBC by pressing and holding the  (Wi-Fi | WPS) button.



Understanding the Printer Menus 179

Reset Wireless (Dell C1765nfw Color Multifunction Printer only)

Purpose:

To initialize wireless network settings. After executing this function and rebooting the printer, all wireless network 
settings are reset to their default values.

 NOTE: This item is displayed when the Ethernet cable is disconnected and Wi-Fi is set to On.

TCP/IP

Purpose:

To configure TCP/IP settings. The change takes effect after the printer is turned off and then on.

Values:

Protocol

Purpose:

To enable or disable each protocol. The change takes effect after the printer is turned off and then on.

Values:

No* Does not reset the wireless setting.

Yes Resets the wireless setting.

IP Mode Dual Stack* Uses both IPv4 and IPv6 to set the IP address.

IPv4 Mode Uses IPv4 to set the IP address.

IPv4 Get IP Address AutoIP* Automatically sets the IP address.

BOOTP Uses BOOTP to set the IP address.

RARP Uses RARP to set the IP address.

DHCP Uses DHCP to set the IP address.

Panel Enables the IP address entered on the operator panel.

IP Address Manually sets the IP address allocated to the printer.

Subnet Mask Manually sets the subnet mask.

Gateway Address Manually sets the gateway address.

LPD Disable Disables the Line Printer Daemon (LPD) port.

Enable* Enables the LPD port.

Port9100 Disable Disables the Port9100 port.

Enable* Enables the Port9100 port.

WSD Disable Disables the Web Services on Devices (WSD) port.

Enable* Enables the WSD port.

SNMP Disable Disables the Simple Network Management Protocol (SNMP) UDP port.

Enable* Enables the SNMP UDP port.

E-Mail Alert Disable Disables the E-Mail Alert feature.

Enable* Enables the E-Mail Alert feature.
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IP Filter

Purpose:

To block data received from certain IP addresses through the wired or wireless network. You can set up to five IP 
addresses. The change takes effect after the printer is turned off and then on.

Values:

 NOTE: This item is only available for LPD or Port9100.

Initialize NVM

Purpose:

To initialize network data stored in NVM (non-volatile memory). After executing this function and rebooting the 
printer, all network settings are reset to their default values.

Values:

Wi-Fi (Dell C1765nfw Color Multifunction Printer only)

Purpose:

To enable the wireless connection.

Values:

 NOTE: This item is displayed only when the Ethernet cable is disconnected.

 NOTE: When you use the USB connection and do not use the wireless connection, you need to disable the wireless LAN.

EWS Disable Disables an access to Dell Printer Configuration Web Tool embedded in the printer.

Enable* Enables an access to Dell Printer Configuration Web Tool embedded in the printer.

Bonjour(mDNS) Disable Disables the Bonjour (mDNS).

Enable* Enables the Bonjour (mDNS).

No. n/Address 
(n is 1-5.)

Sets the IP address for Filter n.

No. n/Mask 
(n is 1-5.)

Sets the address mask for Filter n.

No. n/Mode 
(n is 1-5.)

Reject Rejects an access from the specified IP address.

Accept Accepts an access from the specified IP address.

Off* Disables the  feature for Filter n.

Yes Initializes network data stored in NVM.

No* Does not initialize network data stored in NVM.

Off Disables the wireless connection.

On* Enables the wireless connection.
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Fax Settings
Use the Fax Settings menu to configure the basic fax settings. 

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Receive Mode

Purpose:

To select the default fax receiving mode.

Values:

Auto Rec Fax

Purpose:

To set the interval at which the printer goes into the fax receive mode after receiving an incoming call. The interval 
can be specified within the range of 0 to 255 seconds. The default is 0 second.

Auto Rec TEL/FAX

Purpose:

To set the interval at which the printer goes into the fax receive mode after the external telephone receives an 
incoming call. The interval can be specified within the range of 0 to 255 seconds. The default is 6 seconds.

Auto Rec Ans/FAX

Purpose:

To set the interval at which the printer goes into the fax receive mode after the external answering machine receives 
an incoming call. The interval can be specified within the range of 0 to 255 seconds. The default is 21 seconds.

Telephone Automatic fax reception is turned off. You can receive a fax by picking up the handset of the 
external telephone, and then pressing the remote receive code.

FAX* Automatically receives faxes.

Telephone/Fax When the printer receives an incoming fax, the external telephone rings for the time specified in 
Auto Rec TEL/FAX, and then the printer automatically receives a fax. If an incoming call is 
not a fax, the printer beeps from the internal speaker indicating that the call is a telephone call.

Ans Machine/Fax The printer can share a telephone line with an answering machine. In this mode, the printer will 
monitor the fax signal and pick up the line if there are fax tones. If the phone communication is 
using serial transmission in your country (such as Germany, Sweden, Denmark, Austria, Belgium, 
Italy, France and Switzerland), this mode is not supported. 

DRPD Before using the Distinctive Ring Pattern Detection (DRPD) option, a distinctive ring service 
must be installed on your telephone line by the telephone company. After the telephone company 
has provided a separate number for faxing with a distinctive ring pattern, configure the fax setup 
to monitor for that specific ring pattern.
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Line Monitor

Purpose:

To set the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a 
connection is made.

Values:

Ring Tone Volume

Purpose:

To set the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal 
speaker when Receive Mode is set to Telephone/Fax.

Values:

Line Type

Purpose:

To select the line type.

Values:

Tone/Pulse

Purpose:

To select the dialing type.

Values:

Off Turns off the volume of the line monitor.

Low Sets the volume of the line monitor.

Medium*

High

Off Turns off the volume of the ring tone.

Low Sets the volume of the ring tone.

Medium

High*

PSTN* Sets the line type to PSTN.

PBX Sets the line type to PBX.

Tone* Sets the dialing type to Tone.

Pulse (10pps) Sets the dialing type to Pulse (10 pulse per second).

Pulse (20pps)*1 Sets the dialing type to Pulse (20 pulse per second).
*1 Pulse(20pps) is available only in certain regions.
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Resend Delay

Purpose:

To specify the interval between transmission attempts within the range of 3 to 255 seconds. The default is 8 seconds.

Redial Attempts

Purpose:

To specify the number of redial attempts to make when the destination fax number is busy, within the range of 0 to 
9. If you enter 0, the printer will not redial. The default is 3.

Redial Delay

Purpose:

To specify the interval between redial attempts within the range of 1 to 15 minutes. The default is 1 minute.

Junk Fax Setup

Purpose:

To reject faxes sent from unwanted numbers by accepting faxes only from the fax numbers registered in the Phone 
Book.

Values:

 NOTE: Ensure to specify Fax Number before using Junk Fax Setup.

Remote Receive

Purpose:

To receive a fax by pressing a remote receive code on the external telephone after picking up the handset of the 
telephone.

Values:

Remote Rcv Tone

Purpose:

To specify the remote receive code in two digits to start Remote Receive. 

Off* Does not reject faxes sent from unwanted numbers.

On Rejects faxes sent from unwanted numbers.

Off* Does not receive a fax by pressing a remote receive code on the external telephone.

On Receives a fax by pressing a remote receive code on the external telephone.
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Fax Header

Purpose:

To print the information of sender on the header of faxes.

Values:

Fax Header Name

Purpose:

To set the name of sender to be printed on the header of faxes. Up to 30 alphanumeric characters can be entered.

Fax Number

Purpose:

To set the fax number of the printer to be printed on the header of faxes.

Fax Cover Page

Purpose:

To set whether to attach a cover page to faxes.

Values:

Off Does not print the information of sender on the header of faxes.

On* Prints the information of sender on the header of faxes.

Off* Does not attach a cover page to faxes.

On Attaches a cover page to faxes.
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DRPD Pattern

Purpose:

To provide a separate number for faxing with a distinctive ring pattern.

Values:

Forward Settings

Purpose:

To set whether to forward incoming faxes to a specified destination.

Values:

Pattern1-7 DRPD is a service provided by some telephone companies. DRPD Patterns are specified by your 
telephone company. The patterns provided with your printer are shown below:

Ask your telephone company which pattern you need to select to use this service. For example, Pattern 7 is 
the New Zealand FaxAbility distinctive ringing pattern: rings for 400ms, stops for 800ms, rings for 400ms 
and stops for 1400ms. This pattern is repeated over and over again. This printer only responds to 
Distinctive Alert cadence(s) DA4 in New Zealand.

Off* Does not forward incoming faxes.

Forward Only Forwards the incoming faxes to a specified destination.

Print and Forward Prints the incoming fax and forwards it to a specified destination.

Pattern1

Pattern2

Pattern3

Pattern4*

Pattern5

Pattern6

Pattern7
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Fax Fwd Number

Purpose:

To enter the fax number of the destination to which incoming faxes will be forwarded.

Prefix Dial

Purpose:

To select whether to set a prefix dial number.

Values:

Prefix Dial Num

Purpose:

To set a prefix dial number of up to five digits. This number dials before any auto dial number is started. It is useful 
for accessing the Private Automatic Branch Exchange (PABX).

Discard Size 

Purpose:

To set whether to discard text or images at the bottom of a fax page when the entire page does not fit onto the 
output paper.

Values:

ECM

Purpose:

To set whether to enable the Error Correction Mode (ECM). To use the ECM, the remote machines must also 
support the ECM.

Values:

Off* Does not set a prefix dial number.

On Sets a prefix dial number.

Off Prints any excess at the bottom of a fax page without discarding it.

On Discards any excess at the bottom of a fax page.

Auto Reduction* Automatically reduces a fax page to fit it onto the output paper.

Off Disable the ECM.

On* Enables the ECM.
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Modem Speed

Purpose:

To specify the fax modem speed when a fax transmission or reception error occurs.

Values:

Fax Activity

Purpose:

To set whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.

Values:

Fax Transmit

Purpose:

To set whether to print a transmission report after every fax transmission or only when an error occurs.

Values:

Fax Broadcast

Purpose:

To set whether to print a transmission report after every fax transmission to multiple destinations or only when an 
error occurs.

Values:

2.4 Kbps

4.8 Kbps

9.6 Kbps

14.4 Kbps

33.6 Kbps*

Auto Print* Automatically prints a fax activity report after every 50 incoming and outgoing fax communications.

No Auto Print Does not automatically print a fax activity report.

Print Always Prints a transmission report after every fax transmission.

Print On Error* Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission.

Print Always* Prints a transmission report after every fax transmission.

Print On Error Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission to multiple destinations.
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Protocol Monitor

Purpose:

To set whether to print a protocol monitor report, which helps you identify the cause of a communication problem.

Values:

Country

Purpose:

To select the country where the printer is used.

System Settings
Use the System Settings menu to configure a variety of printer features. 

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Power Saving Timer

Purpose:

To specify the time for transition to power saver mode.

Values:

Enter 5 in Sleep to put the printer in the power saver timer mode five minutes after it finishes a job. This uses less 
energy, but requires more warm-up time for the printer. Enter 5 if your printer shares an electrical circuit with room 
lighting and you notice lights flickering.

Select a high value if your printer is in constant use. In most circumstances, this keeps the printer ready to operate 
with minimum warm-up time. Select a value between 5 and 30 minutes for the power saver timer mode if you want 
a balance between energy consumption and a shorter warm-up period.

The printer automatically returns to the standby mode from the power saver timer mode when it receives data from 
the computer. You can also return the printer to the standby mode by pressing any button on the operator panel.

Print Always Prints a protocol monitor report after every fax transmission.

Print On Error Prints a protocol monitor report only when an error occurs.

Print Disable* Does not print a protocol monitor report after a fax transmission.

Sleep 5min* Specifies the time taken by the printer before it enters Sleep mode after it finishes a 
job.Available Range:

5–30min

Deep Sleep 6min* Specifies the time taken by the printer before it enters Deep Sleep mode after it goes 
into Sleep mode.Available Range:

1–6min
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Auto Reset

Purpose:

To automatically reset the settings for COPY, SCAN, or FAX to the defaults and return to the standby mode after you 
do not specify any settings for the specified time.

Values:

Fault Time-out

Purpose:

To specify the time taken by the printer before it cancels jobs that stop abnormally. The print job is canceled if it 
times out.

Values:

Job Time-out

Purpose:

To specify the amount of time that the printer waits for data to arrive from the computer. The print job is canceled if 
it times out. 

Values:

45sec*

1min

2min

3min

4min

Off Disables the fault time-out.

On* 60sec* Specifies the time taken by the printer before it cancels for jobs that stop abnormally.

Available Range:
3–300sec

Off Disables the job time-out.

On* 60sec* Specifies the amount of time that the printer waits for data to arrive from the computer.

Available Range:
5–300sec
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Date & Time

Purpose:

To set the date and time, and regional time zone of the printer.

Values:

Alert Tone

Purpose:

To configure settings for tones emitted by the printer during operation or when a warning message appears. 

Values:

Set Date Specifies the current date.

Set Time Specifies the current time.

Date Format*1 yy/mm/dd Specifies the date format.

mm/dd/yy

dd/mm/yy

Time Format 12H* Specifies the time format.

24H

Time Zone Specifies the time zone.
*1 The default for Date Format varies depending on country-specific factory default.

Panel Select Tone Off* Does not emit a tone when the operator panel input is correct.

Low Emits a tone at the specified volume when the operator panel input is correct.

Medium

High

Panel Alert Tone Off* Does not emit a tone when the operator panel input is incorrect.

Low Emits a tone at the specified volume when the operator panel input is incorrect.

Medium

High

Auto Clear Alert Off* Does not emit a tone before the printer performs auto clear.

Low Emits a tone at the specified volume 5 seconds before the printer performs auto clear.

Medium

High

Job Tone Off Does not emit a tone when a job is complete.

Low Emits a tone at the specified volume when a job is complete.

Medium*

High

Alert Tone Off Does not emit a tone when a problem occurs.

Low Emits a tone at the specified volume when a problem occurs.

Medium*

High
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mm / inch

Purpose:

To specify the measurement unit displayed after the numeric value on the operator panel.

Values:

 NOTE: The default for mm/inch varies depending on country-specific factory default.

Auto Log Print

Purpose:

To automatically print a job history report after every 20 jobs.

Values:

 NOTE: The job history report can also be printed using the Report List menu.

Low Toner Alert Msg

Purpose:

To specify whether to show the alert message when the toner is low.

Values:

Out of Paper Off Does not emit a tone when the printer runs out of paper.

Low Emits a tone at the specified volume when the printer runs out of paper.

Medium*

High

All Tones Off Disables all the alert tones.

Low Sets the volume of all the alert tones at once.

Medium*

High

Millimeters (mm) Specifies the default measurement unit.

Inches (")

Off* Does not automatically print a job history report.

On Automatically prints a job history report.

Off Does not show the alert message when the toner is low.

On* Shows the alert message when the toner is low.
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Power On Wizard

Purpose:

To perform initial setup for the printer.

Values:

Maintenance
Use the Maintenance menu to initialize NVM (non-volatile memory), configure the plain paper quality 
adjustment settings, and configure the security settings.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

F/W Version

Purpose:

To display the version of the controller.

Service Tag

Purpose:

To display the service tag of the printer.

Express Code

Purpose:

To display the express service code of the printer.

Paper Density

Purpose:

To specify the paper density.

Values:

Yes Performs the initial setup for the printer.

No* Does not perform the initial setup for the printer.

Plain Light

Normal*

Label Light

Normal*
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Adjust Transfer Roller

Purpose:

To specify the optimum voltage settings for printing for the transfer roller. To decrease the voltage, set negative 
values. To increase the voltage, set positive values.

The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 
increase the voltage. If you see white spots on the print output, try to decrease the voltage.

 NOTE: The print quality changes depending on the values you select for this item.

Values:

Adjust Fusing Unit

Purpose:

To specify the optimum temperature settings for printing for the fusing unit. To decrease the temperature, set 
negative values. To increase the temperature, set positive values.

The default settings may not give the best output on all paper types. When the printed paper has curled, try to 
decrease the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.

 NOTE: The print quality changes depending on the values you select for this item.

Values:

Plain 0*

Available Range: -3 – +3

Plain Thick 0*

Available Range: -3 – +3

Covers 0*

Available Range: -3 – +3

Coated 0*

Available Range: -3 – +3

Label 0*

Available Range: -3 – +3

Recycled 0*

Available Range: -3 – +3

Envelope 0*

Available Range: -3 – +3

Plain 0*

Available Range: -3 – +3

Plain Thick 0*

Available Range: -3 – +3

Covers 0*

Available Range: -3 – +3

Coated 0*

Available Range: -3 – +3
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Auto Regi Adjust

Purpose: 

To specify whether to automatically adjust color registration.

Values:

Adjust ColorRegi

Purpose:

To automatically adjust color registration.

Color registration adjustment need to be made during the initial setup of the printer or when the printer is moved to 
a different location.

 NOTE: This item is available only when Auto Regi Adjust is set to Off.

Values:

Clean Developer

Purpose:

To rotate the developer motor and stir the toner in the toner cartridge.

Values:

Label 0*

Available Range: -3 – +3

Recycled 0*

Available Range: -3 – +3

Envelope 0*

Available Range: -3 – +3

Off Does not automatically adjust color registration.

On* Automatically adjusts color registration.

Auto Adjust Yes Automatically adjusts color registration.

No* Does not automatically adjust color registration.

Yes Stirs the toner in a new toner cartridge.

No* Does not stir the toner in a new toner cartridge.
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Toner Refresh

Purpose:

To use up a toner cartridge when you need to replace it before the end of its life, or to stir the toner in a new toner 
cartridge.

Values:

Transfer Roller Refresh

Purpose:

Specify whether to execute counter measures for curling/separating discharge of the paper.

Values:

Initialize NVM

Purpose:

To initialize NVM (non-volatile memory) for system parameters, Address Book data for fax, or Address Book data for 
e-mail. After executing this function and rebooting the printer, the menu parameters or data are reset to their default 
values.

For details, see "Resetting Defaults" on page 201.

Values:

Yellow Yes Cleans the toner in the yellow toner cartridge.

No* Does not clean the toner in the yellow toner cartridge.

Magenta Yes Cleans the toner in the magenta toner cartridge.

No* Does not clean the toner in the magenta toner cartridge.

Cyan Yes Cleans the toner in the cyan toner cartridge.

No* Does not clean the toner in the cyan toner cartridge.

Black Yes Cleans the toner in the black toner cartridge.

No* Does not clean the toner in the black toner cartridge.

Off* Does not automatically execute counter measures for curling/separating discharge of the paper.

On Automatically executes counter measures for curling/separating discharge of the paper.

User Fax Section Yes Initializes the fax number entries in the Address Book.

No* Does not initialize the fax number entries in the Address Book.

User Scan Section Yes Initializes the e-mail and server address entries in the Address Book.

No* Does not initialize the e-mail and server address entries in the Address Book.

System Section Yes Initializes the system parameters.

No* Does not initialize the system parameters.
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Non-Dell Toner

Purpose:

To use toner cartridge of another manufacturer.

 NOTE: Using non-Dell-brand toner cartridges may make some printer features unusable, reduce print quality and decrease the 
reliability of your printer. Dell recommends only new Dell-brand toner cartridges for your printer. Dell does not provide warranty 
coverage for problems caused by using accessories, parts, or components not supplied by Dell.

 NOTE: Before you use toner cartridge of another manufacturer, be sure to restart the printer.

Values:

Adjust Altitude

Purpose:

To specify the altitude of the location where the printer is installed. 

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 
performed by specifying the altitude of the location where the printer is being used. 

 NOTE: An incorrect altitude adjustment setting leads to poor printing quality, incorrect indication of remaining toner. 

Values:

Off* Does not use toner cartridge of another manufacturer.

On Uses toner cartridge of another manufacturer.

0m* Specifies the altitude of the location where the printer is installed.

1000m

2000m

3000m
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Secure Settings
Use the Secure Settings menu to set a password to limit access to the menus. This prevents items from being 
changed accidentally.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Panel Lock

Purpose:

To restrict access to Admin Menu and Report / List.

For details see "Panel Lock Function" on page 200.

 NOTE: You can select Disable for Panel Lock Set when all items under Function Enabled are set to On and 
Secure Receive Set is set to Disable.

Values:

Function Enabled

Purpose:

To specify whether to enable each of the printer services or to require a password to use the services, and to set or 
change the password.

 NOTE: You can access to the items under Function Enabled only when Panel Lock Set is set to Enable.

Values:

Panel Lock Set Disable* Does not restrict access to Admin Menu and Report / List.

Enable Restricts access to Admin Menu and Report / List with a password.

Change Password Available Range:
0000–9999

Sets or changes the password required to access Admin Menu and 
Report / List.

COPY On* Enables the Copy service.

Off Disables the Copy service.

On(Password) Enables the Copy service, but requires a password.

On(Color Password) Enables the Copy service with a color mode, but requires a password.

FAX On* Enables the Fax service.

Off Disables the Fax service (the printer will not send or receive faxes).

On(Password) Enables the Fax services, but requires a password to send faxes (does not require 
a password to receive incoming faxes).

SCAN On* Enables the Scan service. 

Off Disables the Scan service.

On(Password) Enables the Scan service, but requires a password.

USB-Print On* Enables the USB-Print service.

Off Disables the USB-Print service.

On(Password) Enables the USB-Print service, but requires a password.

On(Color Password) Enables the USB-Print service with a color mode, but requires a password.

Change Password Sets or changes the password required to use the Copy, Scan, Fax, and 
USB-Print services.
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Secure Receive

Purpose:

To specify whether to require a password to print incoming faxes, and to set or change the password. When Secure 
Receive Set is set to Enable, the printer stores incoming faxes and prints them when the correct password is 
entered on the operator panel.

 NOTE: You can access to the items under Secure Receive Set only when Panel Lock Set is set to Enable.

Values:

Software Download

Purpose:

To enable or disable download of firmware updates.

Values:

Scan to E-Mail
Use the Scan to E-Mail menu to edit the transmission source.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Edit From Field

Purpose:

To specify whether to enable editing of the transmission source when you use Scan to E-Mail.

Values:

Secure Receive Set Disable* Does not require a password to print incoming faxes.

Enable Requires a password to print incoming faxes.

Change Password Available Range:
0000–9999

Sets or changes the password required to print incoming faxes.

Disable Disables firmware updates.

Enable* Enables firmware updates.

Disable Disables editing of the transmission source.

Enable* Enables editing of the transmission source.
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USB Settings
Use the USB Settings menu to change printer settings affecting a USB port.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

USB port

Purpose:

To enable or disable the USB interface. The change takes effect after the printer is turned off and then on.

Values:

Panel Language
Purpose:

To specify the language to be used on the operator panel.

Values:

Enable* Enables the USB interface.

Disable Disables the USB interface.

English*

Français

Italiano

Deutsch

Español

Nederlands

Dansk

Norsk

Svenska
*1

*1 Dell C1765nf Color Multifunction 
Printer only
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Panel Lock Function
This feature prevents unauthorized users from changing settings made by the administrator. However, you can select 
settings for individual print jobs using the printer driver.

Enabling the Panel Lock
1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Secure Settings is highlighted, and then press the  (Set) button.

5 Ensure that Panel Lock is highlighted, and then press the  (Set) button.

6 Ensure that Panel Lock Set is highlighted, and then press the  (Set) button.

7 Press the  button until Enable is highlighted, and then press the  (Set) button.

 NOTE: The factory-default panel password is 0000.

 NOTE: Be sure to remember the password. The procedure described below allows you to reset the password, but the 
settings for Address Book and Phone Book are cleared.

• Turn off the printer. Then, while holding the  (Menu) button, turn on the printer.

 NOTE: If you change the password while Panel Lock is Enable, perform steps 1 to 5. Press the  button until 
Change Password is highlighted, and then press the  (Set) button. Enter the new password, and then press the  
(Set) button. This will change the password.

Disabling the Panel Lock
1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Enter the password, and then press the  (Set) button.

5 Press the  button until Secure Settings is highlighted, and then press the  (Set) button.

6 Ensure that Panel Lock is highlighted, and then press the  (Set) button.

7 Ensure that Panel Lock Set is highlighted, and then press the  (Set) button.

8 Press the  button until Disable is highlighted, and then press the  (Set) button.
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Resetting Defaults
After executing this function and rebooting the printer, the menu parameters or data are reset to their default values.

 NOTE: A password is required to enter the Admin Menu menu when Panel Lock Set is set to Enable. In this case, 
enter the password you specified, and press the  (Set) button.

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Maintenance is highlighted, and then press the  (Set) button.

5 Press the  button until Initialize NVM is highlighted, and then press the  (Set) button.

6 Press the  button until the desired setting is highlighted, and then press the  (Set) button.

7 Press the  button until Yes is highlighted, and then press the  (Set) button.

The printer restarts automatically to apply the settings.
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16
Print Media Guidelines
Print media can be paper, labels, envelopes, and coated paper among others. Your printer provides high-quality 
printing on a variety of print media. Selecting the appropriate print media for your printer helps avoid printing 
troubles. This section describes selecting print media, caring for print media, and loading the print media in 
Multipurpose Feeder (MPF) or Priority Sheet Inserter (PSI).

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

Paper
For the best print quality in color, use 75 g/m2 (20 lb) xerographic, grain long paper. For the best print quality in 
black and white, use 90 g/m2 (24 lb) xerographic, grain long paper. Before buying large quantities of any print media, 
it is recommended that you try a sample first.

When loading paper, identify the recommended print side on the paper package, and load the paper accordingly. See 
"Loading Print Media in the Multipurpose Feeder (MPF)" on page 211 and "Loading Print Media in the Priority 
Sheet Inserter (PSI)" on page 219 for detailed loading instructions. 

Paper Characteristics
The following paper characteristics affect print quality and reliability. It is recommended that you follow these 
guidelines when evaluating new paper stock. 

Weight

Both MPF and PSI automatically feed paper whose weights range from 60 to 163 g/m2 (16 to 44 lb bond) grain long. 
Paper lighter than 60 g/m2 (16 lb) may not feed properly, and could cause paper jams. For best performance, use 75 
g/m2 (20 lb bond) grain long paper.

Curl

Curl is the tendency of print media to curve at its edges. Excessive curl can cause paper feeding problems. Curl 
usually occurs after the paper passes through the printer, where it is exposed to high temperatures. Storing paper 
unwrapped, even in the feeder, can contribute to paper curling prior to printing and cause feeding problems 
regardless of humidity. When printing on curled paper, straighten the paper and then insert it into the MPF or PSI.

Smoothness

The degree of paper smoothness directly affects print quality. If the paper is too rough, the toner does not fuse to the 
paper properly, resulting in poor print quality. If the paper is too smooth, it can cause paper feeding problems. 
Smoothness between 150 and 250 Sheffield points produces the best print quality.

Moisture Content

The amount of moisture in the paper affects both print quality and the ability of the printer to feed the paper 
properly. Leave the paper in its original packaging until you are ready to use it. This limits the exposure of the paper 
to moisture changes that can degrade its performance. 

Grain Direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of 
the paper, or grain short, running the width of the paper. For 60 to 135 g/m2 (16 to 36 lb bond) paper, grain long 
fibers are recommended. For paper heavier than 135 g/m2 (36 lb bond), grain short is preferred. 
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Fiber Content

Most high-quality xerographic paper is made from 100% chemically pulped wood. Paper containing fibers such as 
cotton possess characteristics that can result in degraded paper handling. 

Recommended Paper
To ensure the best print quality and feed reliability, use dry 75 g/m2 (20 lb) xerographic paper. Business paper 
designed for general business use also provide acceptable print quality. Only use paper able to withstand high 
temperatures without discoloring, bleeding, or releasing hazardous emissions. The laser printing process heats paper 
to high temperatures. Check with the manufacturer or vendor to determine whether the paper you have chosen is 
acceptable for laser printers.

 NOTE: Always print several samples before buying large quantities of any type of print media. When choosing any print media, 
you should consider the weight, fiber content, and color.

Unacceptable Paper
The following paper types are not recommended for use with the printer:

• Chemically treated paper used to make copies without carbon paper, also known as carbonless paper, carbonless 
copy paper (CCP), or no carbon required (NCR) paper

• Preprinted paper with chemicals that may contaminate the printer

• Preprinted paper that can be affected by the temperature in the fusing unit

• Preprinted paper that require a registration (the precise print location on the page) greater than ±0.09 inches, such 
as optical character recognition (OCR) forms

In some cases, you can adjust registration with your software program to successfully print on these forms.

• Coated paper (erasable bond), synthetic paper, thermal paper

• Rough-edged, rough or heavily textured surface paper, or curled paper

• Recycled paper containing more than 25% post-consumer waste that do not meet DIN 19 309

• Multiple-part forms or documents

• Print quality may deteriorate (blank spaces or blotches may appear in the text) when printing on talc or acid paper.

• Moist paper that may cause wrinkle

Selecting Paper
Proper paper selection helps prevent jams and ensures trouble-free printing. 

To help avoid jams or poor print quality:

• Always use new, dry, and undamaged paper.

• Before loading the paper, identify the recommended print side of the paper. This information is usually indicated 
on the paper package. 

• Do not use paper that you have cut or trimmed yourself. 

• Do not mix print media sizes, weights, or types in the same source. This may result in a paper jam. 

• Do not remove the PSI while a job is printing.

• Ensure that the paper is properly loaded in the MPF or PSI. 

• Flex paper back and forth, and then fan them. Straighten the edges of the stack on a level surface.
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Selecting Preprinted Media and Letterhead
When selecting preprinted media and letterhead paper for the printer:

• Use grain long paper for best results.

• Use only forms and letterhead printed using an offset lithographic or engraved printing process.

• Select paper that absorb ink, but do not bleed.

• Avoid paper with rough or heavily textured surfaces.

• Use paper printed with heat-resistant inks designed for use in xerographic copying machines. The ink must 
withstand temperatures of 225°C (437°F) without melting or releasing hazardous emissions.

• Use inks that are not affected by the resin in toner or the silicone in the fusing unit. Inks that are oxidation-set or 
oil-based should meet these requirements; latex inks might not. If you are in doubt, contact your paper supplier. 

Printing on Letterhead
Check with the manufacturer or vendor to determine whether the pre-printed letterhead you have selected is 
acceptable for laser printers.

Page orientation is important when printing on letterhead. Use the following illustration for help when loading 
letterhead in the print media sources.

Loading Letterhead
Load the letterhead in the printer with the print side facing up. Ensure that the title on the letterhead enters the 
printer first.

Multipurpose Feeder (MPF) Priority Sheet Inserter (PSI)
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Selecting Pre-Punched Paper
Pre-punched paper brands can differ in the number and placement of holes and in manufacturing techniques. 
However, it may not be possible to print on the paper to depending on the placement of holes on the paper.

To select and use pre-punched paper:

• Test paper from several manufacturers before ordering and using large quantities of pre-punched paper.

• Paper should be punched at the paper manufacturer and not drilled into paper already packaged in a ream. Drilled 
paper can cause jams when multiple sheets feed through the printer. This may result in a paper jam.

• Pre-punched paper can include more paper dust than standard paper. Your printer may require more frequent 
cleaning and feed reliability may not be as good as standard paper.

• Weight guidelines for pre-punched paper are the same as non-punched paper.

Envelopes
Depending on the choice of envelopes, it is possible to expect variable levels of light wrinkling. Before buying large 
quantities of any print media, it is recommended that you try a sample first. See "Loading Print Media in the 
Multipurpose Feeder (MPF)" on page 211 or "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 219 
for instructions on loading an envelope.

When printing on envelopes:

• Use only high-quality envelopes that are designed for use in laser printers. 

• Set the print media source to MPF or PSI. Set the paper type to Envelope, and select the correct size of envelope 
from the printer driver. 

• For best performance, use envelopes made from 75 g/m2 (20 lb bond) paper. You can use up to 105 g/m2 (28 lb 
bond) weight for the envelope feeder as long as the cotton content is 25% or less. Envelopes with 100% cotton 
content must not exceed 90 g/m2 (24 lb bond) weight.

• Use only freshly unpackaged, undamaged envelopes. 

• Use envelopes that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or 
releasing hazardous emissions. If you have any doubts about the envelopes you are considering, check with the 
envelope supplier. 

• Adjust the guide to fit the width of the envelopes. 

• To load envelope in MPF or PSI, the print side must be facing up.

• See "Loading an Envelope in the Multipurpose Feeder (MPF)" on page 216 or "Loading an Envelope in the 
Priority Sheet Inserter (PSI)" on page 221 for instructions on loading an envelope.

• Use one envelope size during a print job.

• Ensure that the humidity is low because high humidity (more than 60%) and the high printing temperatures may 
seal the envelopes.

• For best performance, do not use envelopes that:

– Have excessive curl or twist

– Are stuck together or damaged in any way

– Contain windows, holes, perforations, cutouts, embossing

– Use metal clasps, string ties, or metal folding bars

– Have an interlocking design

– Have postage stamps attached

– Have nicked edges or bent corners
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– Have rough, cockle, or laid finishes

Labels
Your printer can print on many labels designed only for use with laser printers.

When selecting labels:

• Label adhesives, face sheet (printable stock), and topcoats must be able to withstand temperatures of 205°C 
(401°F) and pressure of 25 pounds per square inch (psi).

• Use labels that can be without sealing, excessive curling, wrinkling, or releasing hazardous emissions.

• Do not use label sheets with a slick backing material.

 CAUTION: Before buying large quantities of any print media, it is recommended that you try a sample first.

When printing on labels:

• Use labels that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or 
releasing hazardous emissions.

• Set the paper type to Label from the printer driver. 

• Do not load labels together with paper in the same tray.

• Do not print within 1 mm (0.04 inches) of the die-cut.

• Do not print within 1 mm (0.04 inches) of the edge of the label, of the perforations, or between die-cuts of the 
label.

• Do not print a label through the printer more than once.

• Portrait orientation is preferred, especially when printing bar codes. 

• Do not use labels that have exposed adhesive.

• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam.

• Do not use label sheets that have adhesive to the edge of the sheet. It is recommended that zone coating of the 
adhesive is done at least 1 mm (0.04 inches) away from edges. Adhesive material contaminates your printer and 
could void your warranty. 

 WARNING: Otherwise a jam occurs in the printer and contaminate your printer and your cartridges with adhesive. As a result, 
could void your printer and cartridge warranties.

Storing Print Media
For proper print media storage, the following guidelines help avoid media feeding problems and uneven print 
quality.

• For best results, store print media in an environment where the temperature is approximately 21°C (70°F) and the 
relative humidity is 40%.

• Store cartons of print media on a pallet or shelf, rather than directly on the floor. 

• If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so 
that the edges do not buckle or curl. 

• Do not place anything on top of the print media packages. 
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Identifying Print Media and Specifications
This section provides information on supported paper sizes, types, and specification.

Supported Paper Sizes

Multipurpose Feeder (MPF) Priority Sheet Inserter (PSI)

A4 (210x297 mm) Y Y

B5 (182x257 mm) Y Y

A5 (148x210 mm) Y Y

C5 (162x229 mm) Y Y

Monarch (3.875x7.5 in) Y Y

Monarch LEF (7.5x3.875 in)*1 Y Y*4

Envelope #10 (4.125x9.5 in) Y Y

DL (110x220 mm) Y Y

DL LEF (220x110 mm)*1 Y Y*4

Letter (8.5x11 in) Y Y

Legal (8.5x14 in) Y Y

Folio (8.5x13 in) Y Y

Executive (7.25 x 10.5 in) Y Y

Custom*2*3 Y Y

*1 You can place the originals in a long-edge feed direction or in a short-edge feed direction. The following illustration shows SEF and LEF. 
The arrow mark in the illustration shows the orientation of the paper loading.

NOTE: Not available when the XML Paper Specification (XPS) printer driver is used.
*2 Custom width: 76.2 mm (3.00 inches) to 215.9 mm (8.50 inches)

The maximum width for envelope (DL LEF): 220.0 mm (8.66 inches)
Custom length: 127.0 mm (5.00 inches) to 355.6 mm (14.00 inches)
The maximum length for envelope (Monarch LEF): 98.4 mm (3.87 inches)

*3 Only the administrator user can set the custom size from the printer driver.
*4 Be sure to fully insert the envelope until it stops. Otherwise, print media that is loaded on the MPF will be fed.

SEF LEF
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Supported Paper Types

Paper Type Specifications

Media Multipurpose Feeder (MPF) Priority Sheet Inserter (PSI)

Plain Y* Y*

Plain Side 2 Y Y

Plain Thick Y Y

Plain Thick Side 2 Y Y

Recycled Y Y

Recycled Side 2 Y Y

Label Y Y

Covers Y Y

Covers Side 2 Y Y

Envelope Y Y

Coated Y Y

Coated Side 2 Y Y

* Values marked by an asterisk (*) are the factory default menu settings.

Paper type Weight (gsm) Remarks

Plain Paper 60-90 -

Plain Thick Paper 91-105 -

Covers 106-163 -

Coated 106-163 Inkjet printer paper cannot be used.

Label - Inkjet printer paper cannot be used.

Envelopes - -

Recycled 60-105 -
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17
Loading Print Media
Loading print media properly helps prevent jams and ensures trouble-free printing.

Before loading print media, identify the recommended print side of the print media. This information is usually on 
the print media package.

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

 NOTE: After loading paper in the feeder, specify the same paper type on the operator panel.

Capacity
Multipurpose Feeder (MPF) can hold:

• 150 sheets of standard paper

• 16.2 mm (0.64 inches) of thick paper

• One sheet of coated paper

• 16.2 mm (0.64 inches) of post cards

• Five envelopes

• 16.2 mm (0.64 inches) of labels

Priority Sheet Inserter (PSI) can hold:

• 10 sheets of standard paper or one sheet of other paper

Print Media Dimensions
Both MPF and PSI accept print media within the following dimensions:

• Width — 76.2 mm (3.00 inches) to 215.9 mm (8.50 inches)

• Length — 127.0 mm (5.00 inches) to 355.6 mm (14.00 inches)

Loading Print Media in the Multipurpose Feeder (MPF)
 NOTE: Use only laser print media. Do not use ink jet paper in this printer.

1 Open the front cover.
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2 Pull the PSI out.

3 Pull the length guide forward until it stops.

4 Pull the MPF extension forward until it stops.
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5 Adjust the paper width guides to their maximum.

6 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack 
on a level surface.

7 Load print media on the MPF with the top edge first and with the recommended print side facing up.
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8 Adjust the width guides until they rest lightly against the edges of the stack of print media.

9 Slide the length guide towards the printer until it touches the print media.

 NOTE: Depending on the size of print media, first slide the MPF extension backward until it stops, and then pinch the 
length guide and slide it backward until it touches print media.
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10 Insert the PSI into the printer and then align the PSI to the marking on the paper tray.

11 Select the paper type from the operator panel if any print media other than plain print media is loaded. If a 
user-specified print media is loaded in the MPF, you must specify the paper size setting by using the operator 
panel.

 NOTE: For standard-size papers, adjust the guides first and then set papers.
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Loading an Envelope in the Multipurpose Feeder (MPF)

 NOTE: When you print on envelopes, be sure to specify the envelope setting on the printer driver. If not specified, the print 
image will be rotated 180 degrees.

When Loading Envelope #10, DL, or Monarch

Load envelopes with the side to be printed on facing up, the flap side facing down, and the flap turned to the right.

To prevent DL and Monarch from being wrinkled, they are recommended to be loaded with the print-side facing up, 
flap opened, and facing you.



Loading Print Media 217

When Loading C5

Load envelopes with the side to be printed on facing up, with the flap open.

 CAUTION: Never use envelopes with windows, or coated linings. These lead to paper jams and can cause damage to the 
printer.

 NOTE: If you do not load envelopes in the MPF right after they have been removed from the packaging, they may bulge. To avoid 
jams, flatten them as shown below when loading them in the MPF.
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 NOTE: If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration.
The amount of the bending shall be 5 mm (0.20 inches) or less.

 NOTE: To confirm the correct orientation of each print media such as envelopes, see the instruction on the Envelope/Paper 
Setup Navigator on the printer driver.

Loading Letterhead
Load the letterhead in the printer with the print side facing up. Ensure that the title on the letterhead enters the 
printer first.
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Loading Print Media in the Priority Sheet Inserter (PSI)
 NOTE: To avoid paper jams, do not remove the PSI while printing is in progress.

 NOTE: Use only laser print media. Do not use ink jet paper in this printer.

1 Open the front cover.

2 Slide the PSI forward, and then align the PSI to the marking on the paper tray.

3 Adjust the paper width guides to their maximum.
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4 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack 
on a level surface.

5 Load print media on the PSI with the top edge first and with the recommended print side facing up.

6 Adjust the width guides until they rest lightly against the edges of the stack of print media.

7 Select the paper type from the printer driver if the loaded print media is not standard plain paper. If a 
user-specified print media is loaded in the PSI, you must specify the paper size setting by using the printer driver.
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Loading an Envelope in the Priority Sheet Inserter (PSI)

 NOTE: Be sure to fully insert the envelope until it stops. Otherwise, print media that is loaded on the MPF will be fed.

 NOTE: When you print on envelopes, be sure to specify the envelope setting on the printer driver. If not specified, the print 
image will be rotated 180 degrees.

When Loading Envelope #10, DL, or Monarch

Load envelopes with the side to be printed on facing up, the flap side facing down, and the flap turned to the right.

To prevent DL and Monarch from being wrinkled, they are recommended to be loaded with the print-side facing up, 
flap opened, and facing you.
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When Loading C5

Load envelopes with the side to be printed on facing up, with the flap open.

 CAUTION: Never use envelopes with windows, or coated linings. These lead to paper jams and can cause damage to the 
printer.

 NOTE: If you do not load envelopes in the PSI right after they have been removed from the packaging, they may bulge. To avoid 
jams, flatten them as shown below when loading them in the PSI.
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 NOTE: If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration.
The amount of the bending shall be 5 mm (0.20 inches) or less.

 NOTE: To confirm the correct orientation of each print media such as envelopes, see the instruction on the Envelope/Paper 
Setup Navigator on the printer driver.

Loading Letterhead
Load the letterhead in the printer with the print side facing up. Ensure that the title on the letterhead enters the 
printer first.
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Loading Print Media When Manual Duplex Printing
 NOTE: When printing on curled paper, straighten the paper and then insert it into the feeder.

When you start manual duplex printing, the instruction window appears. Note that the window cannot be reopened 
once it is closed. Do not close the window until duplex printing is complete.

Manual duplex printing can be done using the MPF or PSI.

When Using the Multipurpose Feeder (MPF)
1 First print the even pages (rear sides).

For a six page document, rear sides are printed in the order of page 6, page 4, then page 2.

Ready / Error LED blinks and the message appears on the operator panel when the even pages finish printing.

2 After the even pages are printed, remove the paper stack from the output tray and set them as they are (with the 
blank side facing up) into the MPF.

 NOTE: Warped or curled prints can cause paper jams. Straighten them before setting them.

 NOTE: Printing on both sides of the paper is not possible if the document consists of various sizes of papers.

3 Ensure that Insert Output to Tray Press  to Continue Printing is highlighted, and then 
press the  (Set) button. Print pages in the order page 1 (rear of page 2), page 3 (rear of page 4), then page 5 
(rear of page 6).
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When Using the Priority Sheet Inserter (PSI)
1 First print the even pages (rear sides).

For a six page document, even pages are printed in the order page 6, page 4, then page 2.

Ready / Error LED blinks and the message appears on the operator panel when the even pages finish printing.

2 After the even pages are printed, remove the paper stack from the output tray and set them as they are (with the 
blank side facing up) into the PSI.

 NOTE: Warped or curled prints can cause paper jams. Straighten them before setting them.

 NOTE: Printing on both sides of the paper is not possible if the document consists of various sizes of papers.

3 Ensure that Insert Output to Tray Press  to Continue Printing is highlighted, and then 
press the  (Set) button. Print pages in the order page 1 (rear of page 2), page 3 (rear of page 4), then page 5 
(rear of page 6).
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Using the Output Tray Extension
The output tray extension is designed to prevent print media from falling from the printer after the print job is 
complete.

Before printing a document, ensure that the output tray extension is fully extended.

 NOTE: When you pull out envelopes or small size print media, lift up the scanner unit.
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Printing
This chapter covers tips for printing, how to print certain lists of information from your printer, and how to cancel a 
job.

Tips for Successful Printing

Tips on Storing Print Media
Store your print media properly. For more information, see "Storing Print Media" on page 207.

Avoiding Paper Jams

 NOTE: It is recommended that you try a limited sample of any print media you are considering using with the printer before 
purchasing large quantities.

By selecting appropriate print media and loading it properly, you can avoid paper jams. See the following instructions 
on loading print media:

• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 211

• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 219

• "Avoiding Jams" on page 331

If you experience a jam, see "Jam" on page 358 for instructions.

Sending a Job to Print
Install the printer driver to use all the features of the printer. When you choose Print from an application, a window 
representing the printer driver opens. Select the appropriate settings for the specific job you are sending to print. 
Print settings selected from the driver have precedence over the default menu settings selected from the operator 
panel or Tool Box.

You may need to click Preferences from the initial Print box to see all the available system settings you can change. If 
you are not familiar with a feature in the printer driver window, open the online Help for more information.

To print a job from a typical Microsoft® Windows® application:

1 Open the file you want to print.

2 From the File menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the system settings as needed (such as the pages 
you want to print or the number of copies).

4 To adjust system settings not available from the first screen, such as Quality, Paper Size, or Image Orientation, click 
Preferences.

The Printing Preferences dialog box appears.

5 Specify the print settings. For more information, click Help.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print to send the job to the selected printer.
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Canceling a Print Job
There are several methods for canceling a print job.

Canceling From the Operator Panel
To cancel a job after it has started printing:

1 Press the  (Cancel) button.

 NOTE: Printing is canceled only for the current job. All the following jobs will continue to print.

Canceling a Job From the Computer Running Windows

Canceling a Job From the Taskbar

When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1 Double-click the printer icon. 

A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press <Delete> on the keyboard.

Canceling a Job From the Desktop

1 Minimize all programs to reveal the desktop.

Click Start → Devices and Printers (for Windows 7 and Windows Server® 2008 R2).

Click Start → Printers and Faxes (for Windows XP and 2003).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista®).

Click Start → Control Panel → Printers (for Windows Server 2008).

Right-click the bottom left corner of the screen, and then click Control Panel → Hardware and Sound → 
Devices and Printers (for Windows 8 and Windows 8.1).

Right-click the bottom left corner of the screen, and then click Control Panel → Hardware → 
Devices and Printers (for Windows Server 2012 and Windows Server 2012 R2).

A list of available printers appears. 

2 Right-click the printer that you selected when you sent the job for print, and then select See what's printing.

3 Select the printer driver.

A list of print jobs appears in the printer window.

4 Select the job you want to cancel.

5 Press <Delete> on the keyboard.
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Direct Print Using the USB Storage Device
The Print From USB Memory feature allows you to print files stored in a USB storage device by operating from the 
operator panel.

 NOTE: If the Function Enabled setting for USB-Print is set to On(Password), you need to enter the four digit password 
to use the print function. If the Function Enabled setting for USB-Print is set to Off, the print function is disabled. For 
details, see "Function Enabled" on page 197.

Supported File Formats
Files in the following file formats can be printed directly from a USB storage device.

• PDF

• TIFF (single page only)

• JPEG

 NOTE: Only PDF/TIFF/JPEG files created using the scan features of your printer can be printed through USB Direct Print.

Printing a File in a USB Storage Device
1 Insert a USB storage device to the USB port of the printer.

2 Press the  button until Print From is highlighted, and then press the  (Set) button.

Select Document appears.

You can also print a file by the following steps.

a Press the  button.

b Ensure that Print From USB Memory is highlighted, and then press the  (Set) button.

3 Press the  button until the desired file is highlighted, and then press the  (Set) button.

4 Select printing options as required.

5 Ensure that Start Print is highlighted, and then press the  (Start) button.

Printing a Report Page
By using the Report / List menu, you can print a various of settings for your printer including printer settings, 
panel settings, job history, error history, color test page, protocol monitor, Address Book, and fax activity. For details 
about how to print reports or lists, see "Report / List" on page 174. 
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Copying

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

 NOTE: If the Function Enabled setting for COPY is set to On(Password), you need to enter the four digit password to use 
the copy function. If the Function Enabled setting for COPY is set to Off, the copy function is disabled. For details, see 
"Function Enabled" on page 197.

Loading Paper for Copying
The instructions for loading print documents are the same whether you are printing, faxing, or copying. For more 
details, see "Loading Print Media" on page 211.

Preparing a Document
You can use the document glass or the Automatic Document Feeder (ADF) to load an original document for 
copying, scanning and sending a fax. You can load up to 15 sheets of 75 g/m2 (20 lb) documents for one job using the 
ADF or one sheet at a time using the document glass.

 WARNING: Avoid loading documents that are smaller than 5.83 in. by 8.27 in. (148.0 mm by 210.0 mm) or larger than 8.5 in. by 14 
in. (215.9 mm by 355.6 mm), different sizes or weights together, or booklets, pamphlets, transparencies, or documents having 
other unusual characteristics in ADF.

 WARNING: Carbon-paper or carbon-backed paper, coated paper, onion skin or thin paper, wrinkled or creased paper, curled 
or rolled paper or torn paper cannot be used in ADF.

 WARNING: Do not use the documents with staples, paper clips or exposed to adhesives or solvent based materials such as 
glue, ink and correcting fluid in ADF.

 NOTE: To get the best scan quality, especially for color or gray scale images, use the document glass instead of the ADF.

Making Copies From the Document Glass
 NOTE: A computer connection is not required for copying. 

 NOTE: Ensure that no document is in the ADF. If any document is detected in the ADF, it takes priority over the document on the 
document glass.

 NOTE: Contaminants on the document glass may cause black spots on the copy printout. For best results, clean the document 
glass before use. For more information, see "Cleaning the Scanner" on page 328.
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To make a copy from the document glass:

1 Open the document cover.

2 Place the document face down on the document glass and align it with the registration guide on the top left corner 
of the glass.

3 Close the document cover.

 NOTE: Leaving the document cover open while copying may affect the copy quality and increase the toner consumption.

 NOTE: If you are copying a page from a book or magazine, lift the document cover until its hinges are caught by the 
stopper and then close the cover. If the book or magazine is thicker than 20 mm, start copying with the cover open. 

4 Customize the copy settings including the number of copies, copy size, the contrast, and the image quality. For 
more information, see "Setting Copy Options" on page 235.

To clear the settings, use the AC (All Clear) button.

5 Ensure that Start Copy is highlighted, and then press the  (Start) button to begin copying.

 NOTE: Press the  (Cancel) button to cancel a copy job while scanning a document.
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Making Copies From the ADF
 CAUTION: Do not load more than 15 sheets into the ADF or allow more than 15 sheets to be fed to the ADF output tray. The ADF 

output tray should be emptied before it exceeds 15 sheets or your original documents may be damaged. 

 NOTE: To get the best scan quality, especially for gray scale images, use the document glass instead of the ADF.

 NOTE: A computer connection is not required for copying. 

1 Load up to 15 sheets of 75 g/m2 (20 lb) documents face up on the ADF with top edge of the documents in first. 
Then adjust the document guides to the correct document size.

 NOTE: Ensure that you use the document guides before copying a legal-size document.

2 Customize the copy settings including the number of copies, copy size, contrast, and image quality. For more 
information, see "Setting Copy Options" on page 235.

To clear the settings, use the AC (All Clear) button.

3 Ensure that Start Copy is highlighted, and then press the  (Start) button to begin copying.

 NOTE: Press the  (Cancel) button to cancel a copy job while scanning a document.

Setting Copy Options
Set the following options for the current copy job before pressing the  (Start) button to make copies.

 NOTE: The copy options automatically return to their default status after copying. 

Number of Copies
To specify the number of copies from 1 to 99:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Enter the number of copies using the numeric keypad to select the desired value.
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Color
To select mode for color or black and white copying:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  (Color Mode) button to select the desired color mode.

You can also select the desired color mode by selecting Preferences on the operator panel.

 NOTE: If the Function Enabled setting for COPY is set to On(Color Password), you need to enter the four digit 
password to use the copy function. If the Function Enabled setting for COPY is set to Off, the copy function is disabled. For 
details, see "Function Enabled" on page 197.

Collated
To sort the copy output: For example, if you make two copies of three page documents, one complete three page 
document will print followed by the second complete document.

 NOTE: Copying documents with a large amount of data may exhaust available memory. 
If a memory shortage occurs, cancel the collating by turning Collated to Uncollated on the operator panel.

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Ensure that Collated is highlighted, and then press the  (Set) button.

5 Press the  button to select the desired setting, and then press the  (Set) button.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

6 If necessary, customize the copy settings including the number of copies, contrast, and image quality. See "Setting 
Copy Options" on page 235.

Uncollated* Does not sort the copy job

Collated Sorts the copy job

Auto Automatically determines which output mode for the copy job
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Reduce/Enlarge
To reduce or enlarge the size of a copied image, from 25 percent to 400 percent when you copy original documents 
from the document glass or ADF:

 NOTE: When you make a reduced copy, black lines may appear at the bottom of your copy.

 NOTE: This item is available only when Multiple-Up is set to Off or Manual.

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Reduce/Enlarge is highlighted, and then press the  (Set) button.

5 Press the  button to select the desired settings, and then press the  (Set) button.

mm series

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

inch series

 NOTE: You can also use the numeric keypad to input the desired zoom ratio from 25% to 400%, or press the  button to 
enlarge the zoom ratio or press the  button to reduce the zoom ratio in 1% intervals.

200%

A5->A4(141%)

A5->B5(122%)

100%*

B5->A5(81%)

A4->A5(70%)

50%

200%

Stmt->Lgl(154%)

Stmt->Ltr(129%)

100%*

Lgl->Ltr (78%)

Ldgr->Ltr(64%)

50%
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Document Size
To specify the default document size:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Document Size is highlighted, and then press the  (Set) button.

5 Press the  button to select the desired settings, and then press the  (Set) button.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Original Type
To select the copy image quality:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Original Type is highlighted, and then press the  (Set) button.

5 Press the  button to select the desired settings, and then press the  (Set) button.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Letter (8.5 x 11")*1

Folio (8.5 x 13")

Legal (8.5 x 14")

Executive (7.25 x 10.5")
*1 The default for 

Document Size varies 
depending on country specific 
factory default.
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Lighter/Darker
To adjust the contrast to make the copy lighter or darker than the original:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Lighter/Darker is highlighted, and then press the  (Set) button.

5 Press the  or  button to select the desired settings, and then press the  (Set) button.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Sharpness
To adjust the sharpness to make the copy sharper or softer than the original:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Sharpness is highlighted, and then press the  (Set) button.

5 Press the  button to select the desired settings, and then press the  (Set) button.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Text Suitable for documents with text.

Text & Photo* Used for documents with both text and photos.

Photo Suitable for documents with photos.

Lighter2 Makes the copy lighter than the original. Works well with dark print.

Lighter1

Normal* Works well with standard typed or printed documents.

Darker1 Makes the copy darker than the original. Works well with light print or faint pencil markings.

Darker2
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Auto Exposure
To suppress the background of the original to enhance text on the copy:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Auto Exposure is highlighted, and then press the  (Set) button.

5 Press the  button until On is highlighted, and then press the  (Set) button.

Sharpest Makes the copy sharper than the original.

Sharper

Normal* Does not make the copy sharper or softer than the original.

Softer Makes the copy softer than the original.

Softest
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Multiple-Up
To print two original images to fit onto one sheet of paper:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Multiple-Up is highlighted, and then press the  (Set) button.

5 Press the  button to select the desired setting, and then press the  (Set) button.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Off* Does not perform multiple-up printing.

Auto Automatically reduces the original images to fit onto one sheet of paper.

Manual Prints the original images onto the one sheet of paper in the size specified in Reduce/Enlarge.

Auto:
Automatically 
reduces the images 
to fit in one page.

Manual:
Reduces the images in the 
custom size depending on 
the setting of the 
Reduce/Enlarge 
menu.



242 Copying

6 If necessary, customize the copy settings including the number of copies, contrast, and image quality. See "Setting 
Copy Options" on page 235.

7 Ensure that Start Copy is highlighted, and then press the  (Start) button to begin copying.

When you are using the document glass and Multiple-Up is set to Auto, or Manual, the display prompts you 
for another page. Press the  button to select Yes or No, and then press the  (Set) button.

If you select Yes, press the  button to select Continue or Cancel, and then press the  (Set) button.

Margin Top/Bottom
To specify the top and bottom margins of the copy:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Margin Top/Bottom is highlighted, and then press the  (Set) button.

5 Press the  or  button or enter the desired value using the numeric keypad, and then press the  (Set) 
button.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Margin Left/Right
To specify the left and right margins of the copy:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Margin Left/Right is highlighted, and then press the  (Set) button.

5 Press the  or  button or enter the desired value using the numeric keypad, and then press the  (Set) 
button.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

4 mm*/0.2 inch* Specify the value in increments of 1 mm/0.1 inch.

Available Range:
0-50 mm/0.0-2.0 inch
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Margin Middle
To specify the middle margin of the copy:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Copy) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Margin Middle is highlighted, and then press the  (Set) button.

5 Press the  or  button or enter the desired value using the numeric keypad, and then press the  (Set) 
button.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

4 mm*/0.2 inch* Specify the value in increments of 1 mm/0.1 inch.

Available Range:
0-50 mm/0.0-2.0 inch

0 mm*/0.0 inch* Specify the value in increments of 1 mm/0.1 inch.

Available Range:
0-50 mm/0.0-2.0 inch
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Using the ID Copy
You can copy both sides of ID card on one side of a sheet of paper in its original size by selecting Start ID Copy. 

To make a copy:

1 Place an ID card facing down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the Document Glass" on page 233.

2 Press the  (Copy) button.

3 To specify the copy options below, press the  button until Preferences is highlighted, and then press the 
 (Set) button.

• Lighter/Darker

• Sharpness

• Auto Exposure

• Color

For details about copy options, see "Setting Copy Options" on page 235.

4 Press the  button until Start ID Copy is highlighted, and then press the  (Set) button.

After the front side of the ID card is scanned, the display prompts you to turn it over.

a To scan the rear side of the ID card, turn it over and press the  button until Continue is highlighted, and 
then press the  (Set) button.

b To finish copying without scanning the rear side of the ID card, press the  button until Print Now is 
highlighted, and then press the  (Set) button.

 NOTE: If the Function Enabled setting for COPY is set to On(Color Password), you need to enter the four digit 
password to start copying in color. For details, see "Function Enabled" on page 197.
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Changing the Default Settings
The COPY menu options, including contrast, and image quality can be set to the most frequently used modes. 
When you copy a document, the default settings are used unless they are changed by using the corresponding 
buttons on the operator panel.

 NOTE: While you set copy options, pressing the AC (All Clear) button cancels the changed settings and returns to the default 
status.

To create your own default settings:

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Ensure that Defaults Settings is highlighted, and then press the  (Set) button.

4 Ensure that Copy Defaults is highlighted, and then press the  (Set) button.

5 Press the  button until the desired menu item is highlighted, and then press the  (Set) button.

6 Press the  or  button until the desired setting is highlighted or enter the value using the numeric keypad, and 
then press the  (Set) button.

7 Repeat steps 5 and 6, as needed.

8 To return to the previous screen, press the  (Back) button.
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Scanning

Scanning Overview
 NOTE: If the Function Enabled setting for SCAN is set to On(Password), you need to enter the four digit password to use 

the scan function. If the Function Enabled setting for SCAN is set to Off, the scan function is disabled. For details, see 
"Function Enabled" on page 197.

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

You can use your Dell™ C1765nf/C1765nfw Color Multifunction Printer to turn pictures and text into editable 
images on your computer. 

PaperPort® is a program that allows you to organize, find and share all your paper and digital documents, and is 
supplied with your printer.

 NOTE: PaperPort may not be supported depending on the operating systems.

 NOTE: PaperPort application is available only on the PaperPort 14 disc provided with the printer. The licensed software 
application is not available for download from www.dell.com/support.

The resolution setting to use when you scan an item depends on the item type and how you plan to use the image or 
document after you scan it in to your computer. For the best results, use these recommended settings. 

Scanning beyond these recommended resolutions may exceed the capabilities of the application. If you require a 
resolution above those recommended in the above table, you should reduce the size of the image by previewing (or 
pre-scan) and cropping before scanning the image.

 NOTE: You can use PaperPort's built-in Optical Character Recognition (OCR) software to copy text from scanned documents so 
that you can use and edit the text in any text editing, word processing, or spreadsheet program. The OCR process requires 
textual images scanned at 150–600 dpi and 300 dpi or 600 dpi is recommended for graphics.

Dell ScanCenter is a PaperPort application that allows you to scan items and send them directly to PaperPort or 
other programs on your computer without first running PaperPort. Dell ScanCenter runs as a separate application 
from the Microsoft® Windows® start menu and displays the Dell ScanCenter bar. For more information about 
using Dell ScanCenter, refer to the PaperPort's Help menu.

Type Resolution

Documents 300 dpi black-and-white or 200 dpi grayscale or color

Documents of poor quality or that contain small text 400 dpi black-and-white or 300 dpi grayscale

Photographs and pictures 100–200 dpi color or 200 dpi grayscale

Images for an inkjet printer 150–300 dpi

Images for a high-resolution printer 300–600 dpi

http://www.dell.com/support
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Icons on the Dell ScanCenter bar represent the programs that are limited to PaperPort and to Dell ScanCenter. To 
scan and send an item to a program, click the program icon and then scan the item. Dell ScanCenter automatically 
starts the selected program when the scan is complete.

Scanning From the Operator Panel - Using an Application
 NOTE: Ensure that the printer is connected to the computer using the USB cable.

 NOTE: You must use ScanButton Manager on your computer to configure the output destination of the scanned file and to 
select whether to open the file using the related application. For details, see "ScanButton Manager" on page 301.

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Scan) button.

3 Press the  button until Scan to Computer is highlighted, and then press the  (Set) button.

4 Press the  button until Computer is highlighted, and then press the  (Set) button.

5 Configure the scan settings as necessary. 

Settings such as file format and color mode are available. To configure these settings, press the  button until 
Preferences is highlighted, and then press the  (Set) button. For details about setting items, see "Scan 
Defaults" on page 168.

6 Ensure that Start Scan is highlighted, and then press the  (Start) button.

The scanned file image is displayed on the screen of your computer and is saved in the destination specified with 
ScanButton Manager.

 NOTE: If the following dialog box appears on your computer, select Dell C1765 MFP Scan Button Manager, and then click 
OK.
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Scanning From the Operator Panel - Using WSD
If the printer is connected to a computer via network using Web Services on Devices (WSD) protocol, you can use 
the protocol to send scanned images to a computer.

 NOTE: To scan using WSD, you need to setup connection using WSD.

 NOTE: WSD is supported only on Windows Vista®, Windows 7, Windows 8, and Windows 8.1.

Printer Setup for Scanning via WSD
Setup the printer and computer for connection using WSD.

Checking the Printer Setting

Set WSD to Enable in the printer settings. See "Protocol" on page 179 for details.

Setting Up the Computer

 NOTE: For Windows 8 and Windows 8.1, the computer automatically connects the printer using WSD. There is no need to install 
the printer manually.

For Windows 7:

1 Click Start → Computer → Network

2 Right-click the icon for the printer, and then click Install. The printer is connected using WSD.

For Windows Vista:

1 Click Start → Network

2 Right-click the icon for the printer, and then click Install.

3 Click Continue. The printer is connected using WSD.
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Procedures for Scanning via WSD
1 Load the document(s) facing up with top edge in first into the ADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Scan) button.

3 Press the  button until Scan to Computer is highlighted, and then press the  (Set) button.

4 Press the  button until the desired computer you want to send the scan job to is highlighted, and then press the 
 (Set) button.

5 Press the  button until Event is highlighted, and then press the  (Set) button.

6 Press the  button until the desired scan event is highlighted, and then press the  (Set) button.

 NOTE: Which application each scan event is associated with depends on the setting on the computer.

7 Ensure that Start Scan is highlighted, and then press the  (Start) button.

Scanning Using the TWAIN Driver
Your printer supports the TWAIN driver for scanning images. TWAIN is one of the standard components provided 
by Windows XP, Windows Vista, Windows 7, Windows 8, Windows 8.1, Windows Server® 2003, Windows Server 
2008, Windows Server 2008 R2, Windows Server 2012, Windows Server 2012 R2, Mac OS X 10.4, Mac OS X 10.5, 
Mac OS X 10.6, Mac OS X 10.7, OS X 10.8, and OS X 10.9, and works with various scanners.

 NOTE: Ensure that the printer is connected to the computer using the Ethernet or USB cable.

To scan an image from the PaperPort:

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 On the Windows Start menu, click Nuance PaperPort 14 from All Programs, and then click PaperPort (for 
Windows 8 and Windows 8.1, click the PaperPort icon on the Start screen).

3 In the Desktop tab, click Scan Settings in the Function Pane group.

4 Click Select in the Scan or Get Photo pane. 

5 In the Available Scanners dialog box, select TWAIN: Dell C1765 MFP Scanner and then click OK. 

6 Select your scanning preferences and click Preview to display the preview image.

 NOTE: The illustration may vary for different operating systems.
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7 Select the desired properties from the Image Quality and Image Options tabs.

8 Click Scan to start scanning.

9 Follow the on-screen instructions to edit the picture after it is copied to your computer.

Scanning Using the Windows Image Acquisition (WIA) Driver
Your printer also supports the WIA driver for scanning images. WIA is one of the standard components provided by 
Windows XP and later operating systems and works with digital cameras and scanners. Unlike the TWAIN driver, the 
WIA driver allows you to scan an image and easily manipulate those images without using additional software.

 NOTE: Ensure that the printer is connected to the computer using the USB cable.

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Start the drawing software, such as Paint for Windows.

 NOTE: When you use Windows Vista or Windows Server 2008, use Windows Photo Gallery instead of Paint.

3 Click File → From Scanner or Camera (Paint button → From scanner or camera for Windows 7, Windows 8, 
Windows 8.1, Windows Server 2008 R2, Windows Server 2012, and Windows Server 2012 R2).

The Scan using Dell C1765 MFP Scanner window appears.

 NOTE: The illustration may vary for different operating systems.
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4 Select your scanning preferences and click Adjust the quality of the scanned picture to display the 
Advanced Properties dialog box.

5 Select the desired properties including brightness and contrast, and then click OK.

6 Click Scan to start scanning.

7 Click Save As from the File menu.

8 Enter a picture name, and select a file format and destination to save the picture.

Scanning to a PC or Server via SMB/FTP

Overview
The Scan to Network Folder feature allows you to scan documents and send the scanned document to a network 
computer via the FTP or SMB protocol. 

You can select the kind of server and specify a destination to store the scanned document with the 
Dell Printer Configuration Web Tool or Address Book Editor.

The following items are required to use the Scan to Network Folder feature.

Scan
Using FTP

Using SMB

FTP Server

Computer

Computer
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• Using SMB

To transfer data via SMB, your computer must run on one of the following operating systems that includes folder 
sharing.

For Mac OS X, a shared user account is required on the Mac OS X.

• Windows XP

• Windows Vista

• Windows 7

• Windows 8

• Windows 8.1

• Windows Server 2003

• Windows Server 2008

• Windows Server 2008 R2

• Windows Server 2012

• Windows Server 2012 R2

• Mac OS X 10.4

• Mac OS X 10.5

• Mac OS X 10.6

• Mac OS X 10.7

• OS X 10.8

• OS X 10.9

• Using FTP

To transfer data via FTP, one of the following FTP servers and an account to the FTP server (login name and 
password) are required.

• Windows XP

FTP service of Microsoft Internet Information Server 3.0/4.0 or Internet Information Services 5.0/5.1

• Windows Vista, Windows 7, Windows Server 2003, Windows Server 2008, and Windows Server 2008 R2

FTP service of Microsoft Internet Information Services 6.0

• Windows 8 and Windows Server 2012

FTP service of Microsoft Internet Information Services 8.0

• Mac OS X

FTP service of Mac OS X 10.4.2/10.4.4/10.4.8/10.4.9/10.4.10/10.4.11/10.5/10.6/10.7/10.8/10.9

For information on how to configure the FTP service, contact your system administrator.
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Follow the procedure below to use the Scan to Network Folder feature.

Confirming a Login Name and Password

When Using SMB

The Scan to Network Folder feature requires a user login account with a valid and non-empty password for 
authentication. Confirm a login user name and password.

If you do not use a password for your user login, you need to create a password for your user login account with the 
following procedure.

For Windows Vista and Windows 7:

1 Click Start → Control Panel.

2 Click User Accounts and Family Safety.

3 Click User Accounts.

4 Click Create a password for your account and add in a password for your user login account.

For Windows 8 and Windows Server 2012

1 Right-click the bottom left corner of the screen, and then click Control Panel.

2 Click Change PC settings.

"Confirming a Login Name and Password" on page 254

"Specifying a Destination to Store the Document" on page 256

"Configuring the Printer Settings" on page 263

"Sending the Scanned File on the Network" on page 268
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3 Click Users.

4 Click Create a Password and add in a password for your user login account.

For Windows 8.1 and Windows Server 2012 R2:

1 Right-click the bottom left corner of the screen, and then click Control Panel.

2 Click Change PC settings.

3 Click Accounts. 

4 Click Sign-in options. 

5 Click Add under Password, and add in a password for your user login account. 

For Windows XP:

1 Click start → Control Panel → User Accounts.

2 Click Change an account.

3 Select your account.

4 Click Create a password and add in a password for your user login account.

For Windows Server 2008:

1 Click Start → Control Panel.

2 Double-click User Accounts.

3 Click Create a password for your account and add in a password for your user login account.

For Windows Server 2008 R2:

1 Click Start → Control Panel.

2 Select User Accounts.

3 Click User Accounts.

4 Click Create a password for your account and add in a password for your user login account.

For Mac OS X 10.4, Mac OS X 10.5, and Mac OS X 10.6:

1 Click System Preferences → Accounts.

2 Select your account.

3 Select Change Password.

4 Enter a password for your user login account in New Password (New password for Mac OS X 10.6).

5 Re-enter the password in Verify.

6 Click Change Password.

For Mac OS X 10.7, OS X 10.8, and OS X 10.9:

1 Click System Preferences → Users & Groups.

2 Select your account.

3 Select Change Password.

4 Enter a password for your user login account in New password.

5 Re-enter the password in Verify.

6 Click Change Password.
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After you confirmed a login user name and password, go to "Specifying a Destination to Store the Document" on 
page 256.

When Using FTP

The Scan to Network Folder feature requires a user name and a password. For your user name and password, contact 
your system administrator.

Specifying a Destination to Store the Document

When Using SMB

Share a folder to store the scanned document using the following procedure.

For Windows Vista, Windows 7, Windows 8, Windows 8.1, Windows Server 2008, Windows Server 2008 R2, Windows 
Server 2012, and Windows Server 2012 R2

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then select Advanced Sharing.

4 Select the Share this folder check box.

5 Enter a shared name in the Share name box.

 NOTE: Note down the shared name as you need to use this name in the next setting procedure.
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6 Click Permissions to give write permission for this folder.

7 Click Add.

8 Search user login name by clicking Advanced, or enter the user login name in the Enter the object names to select 
box and click Check Names to confirm (Example of user login name, Myself).

9 Click OK when you are done.

10 Click the user login name that you have just entered. Select the Full Control check box. This will grant you 
permission to send the document to this folder.

 NOTE: Do not use Everyone as the user login name.
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11 Click OK.

 NOTE: To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Configuring the Printer Settings" on page 263.

For Windows XP Home Edition:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then select Share this folder on the network.

4 Enter a shared name in the Share name box.

 NOTE: Write down this shared name because you will use this name in the next setting procedure.
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 NOTE: When the following screen appears, click If you understand the security risks but want to share files without 
running the wizard, click here, then select Just enable file sharing, and then click OK.

5 Select Allow network users to change my files.
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6 Click OK.

 NOTE: To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name, MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Configuring the Printer Settings" on page 263.

For Windows XP Professional Edition:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare) and double-click 
the folder.

2 Select Folder Options from Tools.

3 Click the View tab, and then clear the Use simple file sharing (Recommended) check box.

4 Click OK, and then close the window.

5 Right-click the folder, and then select Properties.

6 Select the Sharing tab, and then select Share this folder.

7 Enter a shared name in the Share name box.

 NOTE: Write down this shared name because you will use this name in the next setting procedure.
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8 Click Permissions to create a write permission for this folder.

9 Click Add.

10 Search user login name by clicking Advanced, or enter the user login name in the Enter the object names to select 
box and click Check Names to confirm (Example of user login name, Myself).

11 Click OK.

12 Click the user login name that you have just entered. Select the Full Control check box. This will grant you 
permission to send the document into this folder.

 NOTE: Do not use Everyone as the user login name.
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13 Click OK.

 NOTE: To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Configuring the Printer Settings" on page 263.

For Mac OS X 10.4:

1 Select Go from the Finder menu, and then click Home.

2 Double-click Public.

3 Create a folder (Example of folder name, MyShare).

 NOTE: Note down the folder name as you need to use this name in the next setting procedure.

4 Open System Preferences, and then click Sharing.

5 Check the File Sharing check box and the Windows Sharing check box.

For Mac OS X 10.5 and Mac OS X 10.6:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

 NOTE: Note down the folder name as you need to use this name in the next setting procedure.

2 Select the created folder, and then select Get Info from the File menu.

3 Select the Shared Folder (Shared folder for Mac OS X 10.6) check box, and then close the window.

4 Open System Preferences, and then click Sharing.

5 Select the File Sharing check box, and then click Options.

6 Select the Share files and folders using SMB (Share files and folders using SMB (Windows) for Mac OS X 10.6) 
check box and your account name.

7 Enter your account password, and then click OK.

8 Click Done.
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For Mac OS X 10.7, OS X 10.8, and OS X 10.9:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

 NOTE: Note down the folder name as you need to use this name in the next setting procedure.

2 Select the created folder, and then select Get Info from the File menu.

3 Select the Shared folder check box, and then close the window.

4 Open System Preferences, and then click Sharing.

5 Select the File Sharing check box, and then click Options.

6 Select the Share files and folders using SMB check box and your account name.

7 Enter your account password, and then click OK.

8 Click Done.

When Using FTP

For a destination to store the document, contact your system administrator.

Configuring the Printer Settings
You can configure the printer settings to use the Scan to Network Folder feature with the 
Dell Printer Configuration Web Tool or Address Book Editor.

From the Dell Printer Configuration Web Tool

1 Open a web browser.

2 Enter the IP address of the printer in the address bar and click Go.

The printer's web page appears.

 NOTE: For details on how to check the IP address of the printer, see "Verifying the IP Settings" on page 55.

3 Click Address Book.

The login dialog box appears.

4 Enter the correct user name and password.

 NOTE: The default user name is admin, and the default password is left blank (NULL).

5 Click the Server Address tab.

6 Select any unused number and click Create. 
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The Server Address page appears.

To fill in the fields, enter the information as follows: 

1 Name Enter a friendly name that you want it to appear on the Address Book.

2 Server Type Select SMB if you store the document in a shared folder of your computer.

Select FTP if you use a FTP server.

1

2

3

4

5

6

7

8
9
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After you configured settings, go to "Sending the Scanned File on the Network" on page 268.

3 Server Address Enter a server name or IP address of your computer or the FTP server that you have shared out.

IPv4 and IPv6 are both supported.

The following are examples:

• For FTP:

Server name: myhost.example.com

(myhost: host name, example.com: domain name)

IP address (IPv4): 192.168.1.100

• For SMB:

Server name: myhost

IP address (IPv4): 192.168.1.100

4 Share Name For SMB only.

On the Windows operating system, enter the share name of the folder to store the scanned 
document on the recipient computer.

On the Mac OS, enter the folder name to store the scanned document on the recipient 
computer.

5 Server Path For SMB

To store the scanned document in the share folder directly without creating any subfolder, leave 
the space blank.

To store the scanned document in the folder you created under the share folder, enter the path as 
following.

Example: Share Folder name, MyShare, Second-level folder name: MyPic, Third-level folder 
name: John

You should now see MyShare\MyPic\John in your directory.

In this case, enter the following item.

Server Path: \MyPic\John

For FTP

Enter the server path to store the scanned document.

6 Server Port Number Enter the Server Port Number. If you are unsure, you can enter the default value of 139 for SMB 
and 21 for FTP.

7 Login Name Enter the user account name that has access to the shared folder on your computer or FTP 
server.

8 Login Password Enter the password corresponding to the above login name.

NOTE: Empty password is not valid when scanned documents are sent via the SMB protocol. 
Ensure that you have a valid password for the user login account. (See "Confirming a Login Name 
and Password" on page 254 for details on how to add a password in your user login account.)

9 Re-enter Password Re-enter your password.

MyShare (Share folder)

MyPic

John
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From the Address Book Editor

1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Address Book Editor.

The Select Device window appears.

2 Select your printer from the list.

3 Click OK.

4 Click Tool → New (Device Address Book) → Server.

The Server Address dialog box appears.

To fill in the fields, enter the information as follows: 

1 Name Enter a friendly name that you want it to appear on the Address Book.

2 Server Type Select Computer if you store the document in a shared folder of your computer. 

Select Server if you use a FTP server.

1
2

10

3

4
5
6
7
8
9
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After you configured settings, go to "Sending the Scanned File on the Network" on page 268.

3 Computer Settings 
wizard

Clicking this button opens the wizard screen which guides you through several steps.

When you complete the steps in the wizard, the items 4 to 10 are entered automatically. For 
details, click Help.

4 Sever Name /
IP Address

Enter a server name or IP address of your computer or the FTP server that you have shared out.

IPv4 and IPv6 are both supported.

The following are examples:

• For Computer:

Server name: myhost

IP address (IPv4): 192.168.1.100

• For Server:

Server name: myhost.example.com

(myhost: host name, example.com: domain name)

IP address (IPv4): 192.168.1.100

5 Share Name Enter the name of the shared folder on the recipient computer. For SMB only.

6 Path For SMB

To store the scanned document in the share folder directly without creating any subfolder, leave 
the space blank.

To store the scanned document in the folder you created under the share folder, enter the path as 
following.

Example: Share Folder name, MyShare, Second-level folder name: MyPic, Third-level folder 
name: John

You should now see MyShare\MyPic\John in your directory.

In this case, enter the following item.

Path: \MyPic\John

For FTP 

Enter the path to store the scanned document.

7 Login Name Enter the user account name that has access to the shared folder on your computer or FTP 
server.

8 Login Password Enter the password corresponding to the above login name.

NOTE: Empty password is not valid when scanned documents are sent via the SMB protocol. 
Ensure that you have a valid password for the user login account. (See "Confirming a Login Name 
and Password" on page 254 for details on how to add a password in your user login account.)

9 Confirm Login 
Password

Re-enter your password.

10 Port Number Enter the Server Port Number. If you are unsure, you can enter the default value of 139 for SMB 
and 21 for FTP.

MyShare (Share folder)

MyPic

John
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Sending the Scanned File on the Network
1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233. 

2 Press the  (Scan) button.

3 Press the  button until Scan to Network Folder is highlighted, and then press the  (Set) button.

4 Press the  button to select the destination to store the scanned file in.

• You can also directly find the destination by its ID number on the Address Book. Enter the ID using the 
numeric keypad, and then press the  (Set) button.

• To check the detailed information of the destination, press the # button.

 NOTE: Only one destination can be specified at a time.

5 Ensure that the desired destination is highlighted, and then press the  (Set) button.

6 Configure the scan settings as necessary. 

Settings such as file format and color mode are available. To configure these settings, press the  button until 
Preferences is highlighted, and then press the  (Set) button. For details about setting items, see "Scan 
Defaults" on page 168.

7 Ensure that Start Scan is highlighted, and then press the  (Start) button.

Scanning to USB Storage Device
The Scan to USB Memory feature allows you to scan documents and save the scanned data to a USB storage device. 
With this feature you can also scan both sides of ID card on one side of a page in its original size.

Basic Scanning Procedures
1 Insert a USB storage device to the USB port of the printer.
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2 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233. 

3 Ensure that Scan to is highlighted, and then press the  (Set) button.

You can also scan documents by the following steps.

a Press the  (Scan) button.

b Ensure that Scan to USB Memory is highlighted, and then press the  (Set) button.

4 Press the  button to select the folder to store the scanned file in, and then press the  (Set) button.

If you do not specify the folder, skip this step.

5 Configure the scan settings as necessary.

Settings such as file format and color mode are available. To configure these settings, press the  button until 
Preferences is highlighted, and then press the  (Set) button. For details about setting items, see "Scan 
Defaults" on page 168.

6 Ensure that Start Scan is highlighted, and then press the  (Start) button.

Using the ID Scan
1 Perform steps 1 to 5 in "Basic Scanning Procedures" on page 268.

Be sure to place the ID card on the document glass.

2 Press the  until Start ID Scan is highlighted, and then press the  (Set) button.

After the front side of the ID card is scanned, the display prompts you to turn it over.

a To scan the rear side of the ID card, turn it over, press the  until Continue is highlighted, and then press 
the  (Set) button.

b To finish scanning without scanning the rear side of the ID card, press the  until Save Now is highlighted, 
and then press the  (Set) button.
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Sending an E-Mail With the Scanned Image
To send an e-mail attached with the scanned image from your printer, follow the steps below:

• Set up E-Mail Server Settings of E-Mail Alert on the Dell Printer Configuration Web Tool. See "E-Mail Alert" on 
page 129 for more details. For information about your e-mail server, contact your system administrator or your local 
Internet service provider (ISP).

• Setup the e-mail address book through the Dell Printer Configuration Web Tool. See "Setting an E-Mail Address 
Book" on page 270 for more details.

Setting an E-Mail Address Book
1 Open a web browser. 

2 Enter the IP address of the printer in the address bar and click Go.

The printer's web page appears.

 NOTE: For details on how to check the IP address of the printer, see "Verifying the IP Settings" on page 55.

3 Click Address Book.

The login dialog box appears.

4 Enter the correct user name and password.

 NOTE: The default user name is admin, and the default password is left blank (NULL).
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5 Click Create.

6 Enter a name and e-mail address in the Name and E-Mail Address fields.

7 Click Apply New Settings.

Sending an E-Mail With the Scanned File
1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233. 

2 Press the  (Scan) button.

3 Press the  button until Scan to E-Mail is highlighted, and then press the  (Set) button.

4 Specify an e-mail address using the numeric keypad or the Address Book.
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When specifying destinations, you can select TO or BCC as a destination type.

To enter the e-mail address directly using the numeric keypad:

a Ensure that Enter Address is highlighted, and then press the  (Set) button.

b Enter the e-mail address using the numeric keypad, and then press the  (Set) button.

 NOTE: Only one destination can be specified at a time. To specify multiple destinations, use the Address Book.

 NOTE: The destination type is automatically set to TO.

To select personal addresses from Address Book:

a Press the  button until Address Book is highlighted, and then press the  (Set) button.

OR

Press the  (Contacts) button, press the  button until All Entries is highlighted, and then press the 
 (Set) button.

b Press the  button to move the cursor to the desired destination.

You can also directly find the destination by its ID number on the Address Book. Enter the number using the 
numeric keypad, and then press the  (Set) button.

To check the detailed information of the destination, press the # button.

c Press the  button repeatedly to display TO or BCC as a destination type, and then press the  (Set) 
button.

To select group addresses from Address Book:

a Press the  button until E-Mail Group is highlighted, and then press the  (Set) button.

OR

Press the  (Contacts) button, press the  button until E-Mail Group is highlighted, and then press 
the  (Set) button.

b Press the  button to move the cursor to the desired destination.

You can also directly find the destination by its ID number on the Address Book. Enter the number using the 
numeric keypad, and then press the  (Set) button.

To check the detailed information of the destination, press the # button.

c Press the  button repeatedly to display TO or BCC as a destination type, and then press the  (Set) 
button.

To search destinations from Address Book:

a Press the  button until Search Address Book is highlighted, and then press the  (Set) button.

OR

Press the  (Contacts) button, press the  button until Search is highlighted, and then press the 
(Set) button.

b Use the numeric keypad to enter the first character of the personal or group names whose destinations you 
want to specify, and then press the  (Set) button.

Destinations with names beginning with the specified character are displayed.

c Press the  button to move the cursor to the desired destination.

To check the detailed information of the destination, press the # button.
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d Press the  button repeatedly to display TO or BCC as a destination type, and then press the  (Set) 
button.

5 Press the  button until Preferences is highlighted, and then press the  (Set) button.

6 Ensure that From Setting is highlighted, and then press  (Set) button.

 NOTE: If this setting item is not displayed, make sure that Edit From Field is set to Enable. For details, see "Edit 
From Field" on page 198.

7 Specify the sender address of the e-mail using the numeric keypad or the Address Book.

The specified address is notified to the recipient when the e-mail is sent. If no e-mail address is specified here, the 
address in Reply Address is notified as a sender information instead. For details, see "E-Mail Alert" on 
page 129.

 NOTE: Be sure to specify an e-mail address either in From Setting or in Reply Address. Otherwise, the 
printer cannot start sending the e-mail.

8 Configure the scan settings as necessary.

Settings such as file format and color mode are available. For details about setting items, see "Scan Defaults" on 
page 168.

9 Ensure that Start Scan is highlighted, and then press the  (Start) button.
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 NOTE: If the Function Enabled setting for FAX is set to On(Password), you need to enter the four digit password to use the 
fax function. If the Function Enabled setting for FAX is set to Off, the fax function is disabled. For details, see "Function 
Enabled" on page 197.

 NOTE: If the Panel Lock Set is set to Enable, you need to enter the four digit password to enter the Admin Menu.

 NOTE: Ensure that the telephone line is connected properly. For details, see "Connecting the Telephone Line" on page 43.

Configuring Fax Initial Settings
 NOTE: The following settings can be configured also using Advance Tools on Easy Setup Navigator.

Setting Your Country
You need to set the country where your printer is used for using the fax service on the printer.

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Fax Settings is highlighted, and then press the  (Set) button.

5 Press the  button until Country is highlighted, and then press the  (Set) button.

6 Press the  button to select the country where the printer is used, and then press the  (Set) button.

7 Ensure that Are You Sure? is displayed, press the  button to select Yes, and then press the  (Set) 
button.

The printer restarts automatically to apply the settings.

 NOTE: In case of either one, when you configure the country setting, the information, which is registered to the device, is 
initialized.

Setting the Printer ID
In most countries, you are required by law to indicate your fax number on any fax you send. The printer ID, 
containing your telephone number and name or company name, will be printed at the top of each page sent from 
your printer.

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Fax Settings is highlighted, and then press the  (Set) button.

5 Press the  button until Fax Number is highlighted, and then press the  (Set) button.

6 Enter your fax number using the number keypad.

 NOTE: If you make a mistake while entering numbers, press the  (Backspace) button to delete the last digit.

7 Press the  (Set) button when the number on the display is correct. 

8 Press the  button until Fax Header Name is highlighted, and then press the  (Set) button.
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9 Enter your name or company name using the numeric keypad.

You can enter alphanumeric characters using the numeric keypad, including special symbols by pressing the 1, *, 
and # buttons.

For details on how to use the numeric keypad to enter alphanumeric characters, see "Using the Numeric Keypad to 
Enter Characters" on page 94.

10 Press the  (Set) button when the name on the display is correct.

11 To return to the previous screen, press the  (Back) button.

Setting the Time and Date

 NOTE: It may be necessary to reset the correct time and date if loss of power to the printer occurs.

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until System Settings is highlighted, and then press the  (Set) button.

5 Press the  button until Date & Time is highlighted, and then press the  (Set) button.

6 Ensure that Set Date is highlighted, and then press the  (Set) button.

7 Enter the correct date using the numeric keypad, or press the  button to select the correct date.

 NOTE: If you make a mistake while entering numbers, press the  button to re-enter the digit.

8 Press the  (Set) button when the date on the display is correct.

9 Press the  button until Set Time is highlighted, and then press the  (Set) button.

10 Enter the correct time using the numeric keypad, or press the  button to select the correct time.

11 Press the  (Set) button when the time on the display is correct.

12 To return to the previous screen, press the  (Back) button.

Changing the Clock Mode
You can set the current time using either the 12-hour or the 24-hour format.

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until System Settings is highlighted, and then press the  (Set) button.

5 Press the  button until Date & Time is highlighted, and then press the  (Set) button.

6 Press the  button until Date Format is highlighted, and then press the  (Set) button.

7 Press the  button until the desired format is highlighted, and then press the  (Set) button.

8 To return to the previous screen, press the  (Back) button.
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Setting Sounds

Speaker Volume
1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Fax Settings is highlighted, and then press the  (Set) button.

5 Press the  button until Line Monitor is highlighted, and then press the  (Set) button.

6 Press the  button until the desired volume is highlighted, and then press the  (Set) button.

7 Reboot the printer by turning the power switch off and then on.

Ringer Volume
1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Fax Settings is highlighted, and then press the  (Set) button.

5 Press the  button until Ring Tone Volume is highlighted, and then press the  (Set) button.

6 Press the  button until the desired volume is highlighted, and then press the  (Set) button.

7 Reboot the printer by turning the power switch off and then on.

Specifying the Fax Settings

Changing the Fax Settings Options
1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Fax Settings is highlighted, and then press the  (Set) button.

5 Press the  button until the desired menu item is highlighted, and then press the  (Set) button.

6 Press the  or  button until the desired setting is highlighted or enter the value using the numeric keypad.

7 Press the  (Set) button to save the selection. 

8 If necessary, repeat steps 5 to 7.

9 To return to the previous screen, press the  (Back) button.
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Available Fax Settings Options
You can use the following settings options for configuring the fax system:

Option Description

Receive Mode Telephone Automatic fax reception is turned off. You can receive a fax by picking up the 
handset of the external telephone, and then pressing the remote receive code.

Fax Automatically receives faxes.

Telephone/Fax When the printer receives an incoming fax, the external telephone rings for 
the time specified in Auto Rec TEL/FAX, and then the printer automatically 
receives a fax. If an incoming call is not a fax, the printer beeps from the 
internal speaker indicating that the call is a telephone call.

Ans Machine/Fax The printer can share a telephone line with an answering machine. In this 
mode, the printer will monitor the fax signal and pick up the line if there are 
fax tones. If the phone communication is using serial transmission in your 
country (such as Germany, Sweden, Denmark, Austria, Belgium, Italy, France 
and Switzerland), this mode is not supported. 

DRPD Before using the Distinctive Ring Pattern Detection (DRPD) option, a 
distinctive ring service must be installed on your telephone line by the 
telephone company. After the telephone company has provided a separate 
number for faxing with a distinctive ring pattern, configure the fax setup to 
monitor for that specific ring pattern.

Auto Rec Fax Sets the interval at which the printer goes into the fax receive mode after receiving an incoming call. 

Auto Rec TEL/FAX Sets the interval at which the printer goes into the fax receive mode after the external telephone 
receives an incoming call.

Auto Rec Ans/FAX Sets the interval at which the printer goes into the fax receive mode after the external answering 
machine receives an incoming call.

Line Monitor Sets the volume of the line monitor, which audibly monitors a transmission through the internal 
speaker until a connection is made.

Ring Tone Volume Sets the volume of the ring tone, which indicates that an incoming call is a telephone call through the 
internal speaker when Receive Mode is set to Telephone/Fax.

Line Type Sets the line type.

Tone/Pulse Sets the dialing type.

Resend Delay Specifies the interval between transmission attempts. 

Redial Attempts Specifies the number of redial attempts to make when the destination fax number is busy. If you enter 
0, the printer will not redial.

Redial Delay Specifies the interval between redial attempts.

Junk Fax Setup Sets whether to reject faxes sent from unwanted numbers by accepting faxes only from the fax 
numbers registered in the Phone Book.

Remote Receive Sets whether to receive a fax by pressing a remote receive code on the external telephone.

Remote Rcv Tone Specifies the remote receive code in two digits to start Remote Receive.

Fax Header Sets whether to print the information of sender on the header of faxes.

Fax Header Name Sets the name of sender to be printed on the header of faxes. Up to 30 alphanumeric characters can be 
entered.

Fax Number Sets the fax number of the printer to be printed on the header of faxes.

Fax Cover Page Sets whether to attach a cover page to faxes.

DRPD Pattern Sets the DRPD setting from Pattern 1 to Pattern 7. DRPD is a service provided by some telephone 
companies.
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Prefix Dial

 NOTE: Prefix Dial only supports the environment where you send a fax to the external line number. To use Prefix Dial, you must 
do the following from the operator panel. 

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Fax Settings is highlighted, and then press the  (Set) button.

5 Press the  button until Line Type is highlighted, and then press the  (Set) button.

6 Press the  button until PBX is highlighted, and then press the  (Set) button.

7 Press the  (Back) button to return to the previous menu.

8 Press the  button until Prefix Dial is highlighted, and then press the  (Set) button.

9 Press the  button until On is highlighted, and then press the  (Set) button.

10 Press the  (Back) button to return to the previous menu.

11 Press the  button until Prefix Dial Num is highlighted, and then press the  (Set) button.

12 Enter an up-to-five-digit prefix number from 0–9, *, and #.

13 Press the  (Set) button when the prefix dial number on the display is correct.

14 Reboot the printer by turning the power switch off and then on.

Forward Settings Sets whether to forward incoming faxes to a specified destination.

Fax Fwd Number Specifies the fax number of the destination to which incoming faxes will be forwarded.

Prefix Dial Specifies whether to set a prefix dial number.

Prefix Dial Num Sets a prefix dial number of up to five digits. This number dials before any auto dial number is started. 
It is useful for accessing the Private Automatic Branch Exchange (PABX).

Discard Size Sets whether to discard text or images at the bottom of a fax page when the entire page does not fit 
onto the output paper. Selecting Auto Reduction automatically reduces the fax page to fit it onto the 
output paper, and does not discard any images or text at the bottom of the page.

ECM Sets whether to enable the ECM. To use the ECM, the remote machines must also support the ECM.

Modem Speed Specifies the fax modem speed when a fax transmission or reception error occurs.

Fax Activity Sets whether to automatically print a fax activity report after every 50 incoming and outgoing fax 
communications.

Fax Transmit Sets whether to print a transmission report after every fax transmission or only when an error occurs.

Fax Broadcast Sets whether to print a transmission report after every fax transmission to multiple destinations or 
only when an error occurs.

Protocol Monitor Sets whether to print a protocol monitor report after every fax transmission or only when an error 
occurs.

Country Sets the country where the printer is used.

Option Description
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Sending a Fax
You can fax data from your printer. 

Sending a Fax Automatically
1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the (Fax) button.

3 Enter the fax number of the remote fax machine using the numeric keypad, and then press the  (Set) button.

You can also use speed dial or group dial numbers to specify the fax number. For more information, see "Automatic 
Dialing" on page 289.

 NOTE: To call up the fax number the printer dialed last, press the  (Redial/Pause) button, and then press the  (Set) 
button.

4 Configure the fax settings as necessary. 

Settings such as resolution and contrast are available. To configure these settings, press the  button until 
Preferences is highlighted, and then press the  (Set) button. For details about setting items, see "Setting 
Fax Options" on page 281.

5 Ensure that Start Fax is highlighted, and then press the  (Start) button.

When you are using the document glass, the display prompts you for another page. Press the  button to select 
Yes to add more documents or to select No to begin sending the fax immediately, and then press the  (Set) 
button.

 NOTE: Press the  (Cancel) button to cancel the fax job while sending the fax.

Sending a Fax Manually
1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Fax) button.

3 Enter the fax number of the remote fax machine using the numeric keypad, and then press the  (Set) button.

4 Press the  button until Preferences is highlighted, and then press the  (Set) button.

5 Configure the fax settings as necessary.

Settings such as resolution and contrast are available. For details about setting items, see "Setting Fax Options" on 
page 281.

6 Press the  button until OnHook is highlighted, and then press the  (Set) button.

7 Press the  button until On is highlighted, and then press the  (Set) button.
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8 Enter the fax number of the remote fax machine using the numeric keypad.

You can also use speed dial numbers to specify the fax number. For more information, see "Sending a Fax Using 
Speed Dial" on page 289.

9 Press the  (Start) button.

If the document is loaded on the document glass, press the  button until Manual Send is highlighted, and 
then press the  (Set) button.

 NOTE: Press the  (Cancel) button to cancel the fax job while sending the fax.

Setting Fax Options
Set the following options for the current fax job before pressing the  (Start) button to send faxes.

 NOTE: The fax options automatically return to their default status after faxing.

Resolution

To specify the resolution level to be used for fax transmission:

1 Press the  (Fax) button.

2 Specify a fax number.

For details, see "Sending a Fax Automatically" on page 280 and "Automatic Dialing" on page 289.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Resolution is highlighted, and then press the  (Set) button.

5 Press the  button until the desired menu item is highlighted, and then press the  (Set) button.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

 NOTE: Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving device. 

Original Type

To select the default original type for the current fax job:

1 Press the (Fax) button.

2 Specify a fax number.

For details, see "Sending a Fax Automatically" on page 280 and "Automatic Dialing" on page 289.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Original Type is highlighted, and then press the  (Set) button.

Standard* Suitable for documents with normal sized characters.

Fine Suitable for documents containing small characters or thin lines or documents printed using a dot-
matrix printer.

Super Fine Suitable for documents containing extremely fine detail. The super fine mode is enabled only if the 
remote machine also supports the super fine resolution.

Ultra Fine Suitable for documents containing photographic images.
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5 Press the  button to select the desired setting, and then press the  (Set) button.

.  NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Lighter/Darker

To adjust the contrast to make the fax lighter or darker than the original:

1 Press the (Fax) button.

2 Specify a fax number.

For details, see "Sending a Fax Automatically" on page 280 and "Automatic Dialing" on page 289.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Lighter/Darker is highlighted, and then press the  (Set) button.

5 Press the  or  button to select the desired setting, and then press the  (Set) button.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Confirming Transmissions 
When the last page of your document has been sent successfully, the printer beeps and returns to the standby mode. 

If something goes wrong while sending your fax, an error message appears on the display.

If you receive an error message, press the  (Set) button to clear the message and try to send the document again. 

You can set your printer to print a confirmation report automatically after each fax transmission. For more 
information, see "Printing a Report" on page 296.

Automatic Redialing
If the number you have dialed is busy or there is no answer when you send a fax, the printer will automatically redial 
the number every minute based on the number set in the redial settings.

To change the time interval between redials and the number of redial attempts, see "Available Fax Settings Options" 
on page 278.

 NOTE: The printer will not automatically redial a number that was busy when the number was manually entered.

Text* Suitable for documents with text.

Photo Suitable for documents with photos.

Lighter2 Makes the fax lighter than the original. Works well with dark print.

Lighter1

Normal* Works well with standard typed or printed documents.

Darker1 Makes the fax darker than the original. Works well with light print or faint pencil markings.

Darker2
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Sending a Delayed Fax
The Delayed Start mode can be used to save scanned documents for transmission at a specified time in order to take 
advantage of lower long distance rates. 

1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Fax) button.

3 Enter the fax number of the remote fax machine using the numeric keypad, and then press the  (Set) button.

You can also use speed dial or group dial numbers to specify the fax number. For more information, see "Automatic 
Dialing" on page 289. 

4 Press the  button until Preferences is highlighted, and then press the  (Set) button.

5 Press the  button until Delayed Start is highlighted, and then press the  (Set) button.

6 Press the  button until On is highlighted, and then press the  (Set) button.

7 Use the numeric keypad or press the  or  button to specify the start time, and then press the  (Set) 
button.

8 Configure the fax settings as necessary. 

Settings such as resolution and contrast are available. For details about setting items, see "Setting Fax Options" on 
page 281.

9 Ensure that Start Fax is highlighted, and then press the  (Start) button.

Once the Delayed Start mode is activated, your printer stores all the documents to be faxed to its memory and 
sends them at the specified time. After faxing in the Delayed Start mode is complete, the data in the memory is 
cleared.

Sending a Fax from the Driver (Direct Fax)
You can send a fax directly from your computer by using the driver.

 NOTE: Only black and white faxes can be sent using Direct Fax.

Send data via the Dell C1765nf 
Color MFP FAX or Dell C1765nfw 
Color MFP FAX driver

Sending machine (Dell 
C1765nf/C1765nfw Color 
Multifunction Printer)

Send fax

Receiving machine (fax 
machine/multifunction 
printer)
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For Windows:

 NOTE: The names of the windows and the buttons may be different from those given in the following procedure depending on 
the application you are using. 

 NOTE: To use this feature, you must install the fax driver.

1 Open the file you want to send by fax. 

2 Open the print dialog box from the application, and then select Dell C1765nf Color MFP FAX or Dell C1765nfw 
Color MFP FAX.

3 Click Preferences.

4 The Printing Preferences dialog box appears. Specify the fax settings. For more information, click the Help of the 
driver.

 NOTE: The settings done here are only applied to a single fax job. 

5 Click OK to close the Printing Preferences dialog box. 

6 Click Print. The Set / Check Fax Transmission: dialog box appears. 
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7 Specify the destination for the recipient in one of the following ways:

• Enter a name and phone number directly.

• Select a recipient from a phone book saved on your computer.

• Select a recipient from a database other than a phone book or address book.

For more information on how to specify the destination, see the Help of the driver.

 NOTE: Enter the password in the Password field in the Authorization area before sending a fax if the Fax service is locked 
with a password.

8 Click Start Sending.
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For Macintosh:

 NOTE: The names of the windows and the buttons may be different from those given in the following procedure depending on 
the application you are using.

 NOTE: When using a USB connection on Mac OS 10.4.x, upgrade Common Unix Printing System (CUPS) software to version 
1.2.12 or later. You can download it from CUPS web site.

 NOTE: To use this feature, you must install the fax driver.

1 Open the file you want to send by fax.

2 Open the print dialog box from the application, and then select Dell C1765nf Color MFP Fax or Dell C1765nfw 
Color MFP Fax.

3 Specify the fax settings.

 NOTE: The settings done here are only applied to a single fax job. 

4 Click Print. The Fax Recipient dialog box appears.

5 Specify the destination for the recipient in one of the following ways:

• Enter a name and phone number directly.

• Select a recipient from a phone book saved on your computer.
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 NOTE: Enter the password in the Password field in the Authorization area before sending a fax if the Fax service is locked 
with a password.

6 Click Start Sending.

Receiving a Fax

About Receiving Modes
There are five receiving modes: Telephone, Fax, Telephone/Fax, Ans Machine/Fax, and DRPD.

 NOTE: To use the Telephone/Fax mode or Ans Machine/Fax mode, attach an external telephone or answering 
machine to the phone connector ( ) on the back of your printer.

 NOTE: When the memory is full, the fax is received in the Telephone mode.

Loading Paper for Receiving Faxes 
The instructions for loading paper in the PSI are the same whether you are printing, faxing, or copying, except that 
faxes can only be printed on Letter-, A4-, or Legal-sized paper. For details about loading paper, see "Loading Print 
Media" on page 211. For details about setting the paper type and size in the PSI, see "Print Media Guidelines" on 
page 203.

Receiving a Fax Automatically in the Fax Mode
Your printer is preset to receive a fax automatically at the factory. 

If you receive a fax, the printer automatically goes into the fax receive mode after a specified period of time and 
receives the fax.

To change the interval at which the printer goes into the fax receive mode after receiving an incoming call, see 
"Available Fax Settings Options" on page 278.

Receiving a Fax Manually in the Telephone Mode 
To receive a fax manually, pick up the handset of the external telephone, and follow the instructions below.

1 Press the  (Fax) button when you hear fax tones on the external telephone.

OffHook appears. 

2 Press the  (Start) button.

3 Press the  button until Manual Receive is highlighted, and then press the  (Set) button.

The printer receives the document.

Receiving a Fax Automatically in the Telephone/Fax or Ans Machine/Fax Mode
To use the Telephone/Fax mode or Ans Machine/Fax mode, you must attach an external telephone or 
answering machine to the phone connector ( ) on the back of your printer. 

In the Telephone/Fax mode, if the printer receives an incoming fax, the external telephone rings for the time 
specified in Auto Rec TEL/FAX, and then the printer automatically receives a fax.

In the Ans Machine/Fax mode, if the caller leaves a message, the answering machine stores the message as it 
would normally. If your printer hears a fax tone on the line, it automatically starts to receive a fax. 

 NOTE: If you have set your printer to Ans Machine/Fax and your answering machine is switched off, or no answering 
machine is connected to your printer, your printer will automatically go into the fax receive mode after a predefined time.
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Receiving a Fax Manually Using an External Telephone
This feature works best when you are using an external telephone connected to the phone connector ( ) on the 
back of your printer. You can receive a fax from someone you are talking to on the external telephone without having 
to go to the printer.

When you receive a call on the external telephone and hear fax tones, press the two-digit number on the external 
telephone.

The printer receives the document.

Press the buttons slowly in sequence. If you still hear the fax tone from the remote machine, try pressing the two-
digit keys once again.

The remote receive code is set to Off at the factory. You can change the two-digit number to whatever you choose. 
For details on changing the code, see "Available Fax Settings Options" on page 278.

You can also receive the fax by pressing the  (Fax) button when you hear the fax tones on the external telephone. 
See "Receiving a Fax Manually in the Telephone Mode" on page 287.

 NOTE: Set the dialing system of your external telephone to DTMF.

Receiving Faxes Using the DRPD Mode
The DRPD is a telephone company service which allows a user to use a single telephone line to answer several 
different telephone numbers. The particular number someone uses to call you on is identified by different ringing 
patterns, which consist of various combinations of long and short ringing sounds.

Before using the Distinctive Ring Pattern Detection option, Distinctive Ring service must be installed on your 
telephone line by the telephone company. To set up Distinctive Ring Pattern Detection, you will need another 
telephone line at your location, or someone available to dial your FAX number from outside. 

To set up the DRPD:

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Fax Settings is highlighted, and then press the  (Set) button.

5 Press the  button until DRPD Pattern is highlighted, and then press the  (Set) button.

6 Press the  button until the desired menu item is highlighted, and then press the  (Set) button.

7 To return to the previous screen, press the  (Back) button.

To receive faxes in the DRPD, you need to set the menu to DRPD mode; see "Available Fax Settings Options" on 
page 278.

Your printer provides seven DRPD patterns. If this service is available from your telephone company, ask your 
telephone company which pattern you need to select to use this service.

Receiving Faxes in the Memory
Since your printer is a multi-tasking device, it can receive faxes while you are making copies or printing. If you 
receive a fax while you are copying, printing, or run out of paper or toner, your printer stores incoming faxes in the 
memory. Then, as soon as you finish copying, printing, or re-supply the consumables, the printer automatically prints 
the fax.

Polling Receive
You can receive faxes from the remote fax machine when you want to receive it.

1 Press the  (Fax) button.
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2 Enter the fax number of the remote fax machine using the numeric keypad, and then press the  (Set) button.

3 Press the  button until Preferences is highlighted, and then press the  (Set) button.

4 Press the  button until Polling Receive is highlighted, and then press the  (Set) button.

5 Press the  button until On is highlighted, and then press the  (Set) button.

6 Ensure that Start Fax is highlighted, and then press the  (Start) button.

Automatic Dialing

Speed Dial
You can store up to 99 frequently dialed numbers in speed dial locations (01– 99). 

When the speed dial job specified in the delayed fax or redial exists, you cannot change the speed dial number from 
the operator panel or Dell Printer Configuration Web Tool.

Setting Speed Dial
1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Phone Book is highlighted, and then press the  (Set) button.

5 Ensure that Speed Dial is highlighted, and then press the  (Set) button.

6 Press the  button until the desired speed dial number between 01 and 99 is highlighted, and then press the 
 (Set) button.

The fax numbers registered in the dial numbers between 01 and 04 are also allocated to the One Touch Dial 
buttons between 01 and 04. We recommend that you register the most frequently used destinations in these 
buttons to directly call up.

7 Ensure that Name is highlighted, and then press the  (Set) button.

8 Enter the name, and then press the  (Set) button.

9 Ensure that Phone Number is highlighted, and then press the  (Set) button.

10 Enter the number you want to store using the numeric keypad, and then press the  (Set) button.

To insert a pause between numbers, press the  (Redial/Pause) button. "-" appears on the display.

11 Ensure that Apply Settings is highlighted, and then press the  (Set) button.

12 When Are You Sure? is displayed, ensure that Yes is highlighted, and then press the  (Set) button.

13 To store more fax numbers, repeat steps 6 to 12. 

14 To return to the previous screen, press the  (Back) button.

Sending a Fax Using Speed Dial
1 Load the document(s) face up with top edge in first into the ADF. 

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Fax) button.
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3 Specify a fax number using speed dial.

Speed dial enables you to quickly and easily specify destinations by selecting or searching from a list of destinations 
registered in the Phone Book. You can also directly specify destinations by entering the speed dial numbers or 
pressing the One Touch Dial buttons.

To select destinations directly by entering the speed dial numbers:

a Press the  (Speed Dial) button.

OR

Press the  button until Speed Dial is highlighted, and then press the  (Set) button.

b Enter the speed dial number (01 to 99) using the numeric keypad, and then press the (Set) button.

Entering the asterisk (*) enables you to search and display multiple destinations at a time. For example, if you 
enter "0*," the speed dial numbers beginning with 0 are called up. In this case, all the destinations registered in 
the dial numbers between 01 and 09 are displayed.

To select destinations directly by pressing the One Touch Dial buttons:

a Press the One Touch Dial button (01 to 04).

b Ensure that the desired destination is displayed, and then press the  (Set) button.

To select destinations from Phone Book:

a Press the  button until Phone Book is highlighted, and then press the  (Set) button.

OR

Press the  (Contacts) button, press the  button until All Entries is highlighted, and then press the 
 (Set) button.

b Press the  button to move the cursor to the desired destination.

To check the detailed information of the destination, press the # button.

c Press the  (Set) button to select the destination, and then press the  button.

You can also directly find the destination by its speed dial number. Enter the number using the numeric 
keypad, and then press the  (Set) button.

To search destinations from Phone Book:

a Press the  button until Search Phone Book is highlighted, and then press the  (Set) button.

OR

Press the  (Contacts) button, press the  button until Search is highlighted, and then press the 
(Set) button.

b Use the numeric keypad to enter the first character of the personal names whose destinations you want to 
specify, and then press the  (Set) button.

Destinations with names beginning with the specified character are displayed.

c Press the  button to move the cursor to the desired destination

To check the detailed information of the destination, press the # button.

d Press the  (Set) button to select the destination, and then press the  button.

4 Configure the fax settings as necessary.

Settings such as resolution and contrast are available. To configure these settings, press the  button until 
Preferences is highlighted, and then press the  (Set) button. For details about setting items, see "Setting 
Fax Options" on page 281.
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5 Ensure that Start Fax is highlighted, and then press the  (Start) button.

When you are using the document glass, the display prompts you for another page. Press the  button to select 
Yes to add more documents or to select No to begin sending the fax immediately, and then press the  (Set) 
button.

Group Dial
If you frequently send the same document to several destinations, you can create a group of these destinations and 
set them under a one-digit group dial location. This allows you to use a group dial number setting to send the same 
document to all the destinations in the group.

 NOTE: You need to register fax destinations in the speed dial beforehand.

 NOTE: You cannot include one group dial number within another group dial number.

Setting Group Dial
1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Phone Book is highlighted, and then press the  (Set) button.

5 Press the  button until Group Dial is highlighted, and then press the  (Set) button.

6 Press the  button until the desired group dial number between 1 and 6 is highlighted, and then press the 
 (Set) button.

7 Ensure that Name is highlighted, and then press the  (Set) button.

8 Enter the name, and then press the  (Set) button.

9 Ensure that Speed Dial No is highlighted, and then press the  (Set) button.

10 Press the  button to move the cursor to the speed dial number you want to register in the group dial, press the 
 (Set) button to select the number, and then press the  button.

11 Ensure that Apply Settings is highlighted, and then press the  (Set) button.

12 When Are You Sure? is displayed, ensure that Yes is highlighted, and then press the  (Set) button.

13 To store more group dial numbers, repeat steps 6 to 12. 

14 To return to the previous screen, press the  (Back) button.

Editing Group Dial
You can delete a specific speed dial number from a selected group or add a new number to the selected group.

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Phone Book is highlighted, and then press the  (Set) button.

5 Press the  button until Group Dial is highlighted, and then press the  (Set) button.

6 Press the  button until the group dial number that you want to edit is highlighted, and then press the  (Set) 
button.

To change the group dial name:

a Ensure that Name is highlighted, and then press the  (Set) button.

b Enter a new name, and then press the  (Set) button.
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c Press the  button until Apply Settings is highlighted, and then press the  (Set) button.

d When Are You Sure? is displayed, ensure that Yes is highlighted, and then press the  (Set) button.

To change the speed dial number:

a Press the  button until Speed Dial No is highlighted, and then press the  (Set) button.

b Press the  button to move the cursor to the speed dial number you want to edit, press the  (Set) button 
to select or deselect the number, and then press the  button.

c Press the  button until Apply Settings is highlighted, and then press the  (Set) button.

d When Are You Sure? is displayed, ensure that Yes is highlighted, and then press the  (Set) button.

To delete the group dial:

a Press the  (Backspace) button.

b When Are You Sure? is displayed, ensure that Yes is highlighted, and then press the  (Set) button.

7 If you want to edit another group dial number, repeat step 6.

8 To return to the previous screen, press the  (Back) button.

Sending a Fax Using Group Dial (Multi-address Transmission)
1 Load the document(s) face up with top edge in first into the ADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the ADF" on page 235 or "Making Copies From 
the Document Glass" on page 233.

2 Press the  (Fax) button.

3 Specify a fax number using group dial.

You can specify destinations by selecting or searching from a list of destinations registered in the Phone Book.

To select destinations from Phone Book:

a Press the  button until Group Dial is highlighted, and then press the  (Set) button.

OR

Press the  (Contacts) button, press the  button until Group Dial is highlighted, and then press the 
 (Set) button.

b Press the  button to move the cursor to the desired destination.

To check the detailed information of the destination, press the # button.

c Press the  (Set) button to select the destination, and then press the  button.

You can also directly find the destination by its group dial number. Enter the number using the numeric 
keypad, and then press the  (Set) button.

To search destinations from Phone Book:

a Press the  button until Search Phone Book is highlighted, and then press the  (Set) button.

OR

Press the  (Contacts) button, press the  button until Search is highlighted, and then press the 
(Set) button.
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b Use the numeric keypad to enter the first character of the group names whose destinations you want to specify, 
and then press the  (Set) button.

Destinations with names beginning with the specified character are displayed.

c Press the  button to move the cursor to the desired destination.

To check the detailed information of the destination, press the # button.

d Press the  (Set) button to select the destination, and then press the  button.

4 Configure the fax settings as necessary. 

Settings such as resolution and contrast are available. To configure these settings, press the  button until 
Preferences is highlighted, and then press the  (Set) button. For details about setting items, see "Setting 
Fax Options" on page 281.

5 Ensure that Start Fax is highlighted, and then press the  (Start) button.

When you are using the document glass, the display prompts you for another page. Press the  button to select 
Yes to add more documents or to select No to begin sending the fax immediately, and then press the  (Set) 
button.

Printing an Address Book List
You can check your automatic dial setting by printing an Address Book list.

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Report / List is highlighted, and then press the  (Set) button.

4 Press the  button until Address Book is highlighted, and then press the  (Set) button.

A list of your speed dial and group dial entries is printed.

Other Ways to Fax

Using the Secure Receiving Mode
You may need to prevent your received faxes from being accessed by unauthorized people. You can turn on the secure 
fax mode using the Secure Receive option to restrict printing out all of the received faxes when the printer is 
unattended. In the secure fax mode, all incoming faxes will get saved in the memory. When the mode turns off, any 
faxes stored will be printed.

 NOTE: Before operation, ensure that Panel Lock Set is set to Enable.

To turn the secure receiving mode on:

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Secure Settings is highlighted, and then press the  (Set) button.

5 Press the  button until Secure Receive is highlighted, and then press the  (Set) button.

6 Ensure that Secure Receive Set is highlighted, and then press the  (Set) button.

7 Press the  button until Enable is highlighted, and then press the  (Set) button.

 NOTE: The factory-default password is 0000.

8 To return to the standby mode, press the  (Menu) button.
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When a fax is received in the secure receiving mode, your printer stores it into memory and the Job Status 
screen displays Secure Receive to let you know that there is a fax stored.

 NOTE: If you change the password while Secure Receive Set is Enable, perform steps 1 to 5. Press the  
button until Change Password is highlighted, and then press the  (Set) button. Enter the new password, and then 
press the  (Set) button.

To print received documents:

1 Press the  (Menu) button.

2 Press the  button until Job Status is highlighted, and then press the  (Set) button.

3 Press the  button until Secure Receive is highlighted, and then press the  (Set) button.

4 Enter the password, and then press the  (Set) button.

The faxes stored in memory are printed.

To turn the secure receiving mode off:

1 Access the Secure Receive Set menu by following steps 1 to 6 in "To turn the secure receiving mode on:".

2 Press the  button until Disable is highlighted, and then press the  (Set) button.

3 To return to the previous screen, press the  (Back) button.

Using an Answering Machine

You can connect a telephone answering device (TAD) directly to the back of your printer as shown above.

• Set your printer to the Ans Machine/Fax mode and set Auto Rec Ans/FAX to specify the time for the 
TAD.

• When the TAD picks up the call, the printer monitors and takes the line if fax tones are received and then starts 
receiving the fax.

• If the answering device is off, the printer automatically goes into the fax receive mode after the ring tone sounds 
for a predefined time.

To the wall 
jack

Printer Line Telephone Answering Device Phone
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Using a Computer Modem

If you want to use your computer modem for faxing or for a dial-up Internet connection, connect the computer 
modem directly to the back of your printer with the TAD as shown above.

• Set your printer to the Ans Machine/Fax mode and set Auto Rec Ans/FAX to specify the time for the 
TAD.

• Turn off the computer modem's fax-receive feature.

• Do not use the computer modem if your printer is sending or receiving a fax.

• Follow the instructions provided with your computer modem and fax application to fax via the computer modem.

To the Internet

Printer

Line

Telephone Answering Device Phone

Computer
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Printing a Report
The following reports may be useful when using fax:

Address Book

This list shows all the addresses currently stored in the memory of the printer as Address Book information.

Fax Activity

This report shows information about the faxes you recently received or sent. 

Protocol Monitor

This report shows the status of the protocol when the latest fax was being sent.

Procedures:

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Report / List is highlighted, and then press the  (Set) button.

4 Press the  button until the report or list you want to print is highlighted, and then press the  (Set) button.

The selected report or list is printed.

Changing Fax Defaults
1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Ensure that Defaults Settings is highlighted, and then press the  (Set) button.

4 Press the  button until Fax Defaults is highlighted, and then press the  (Set) button.

5 Press the  button until the desired menu item is highlighted, and then press the  (Set) button.

6 Press the  or  button until the desired setting is highlighted or enter the value using the numeric keypad, and 
then press the  (Set) button.

7 Repeat steps 5 and 6, as needed.

8 To return to the previous screen, press the  (Back) button.
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22
Understanding Your Printer Software 
(Windows® Only)
Use the Software and Documentation disc that shipped with your printer to install a combination of software 
programs, depending on your operating system.

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

Printer Status Window
The Printer Status window alerts you when there is a warning or when an error occurs, for example, when a paper 
jam occurs or toner is running low.

By default, the Printer Status window launches only when an error occurs. When an error occurs, the error message 
appears on the Printer Status window. You can set the Printer Status window to always launch when printing in 
Printing Status Window Properties.

You can also check the toner level of your printer.

Status Monitor Console
Use the Status Monitor Console to manage multiple instances of the Status Window for a particular printer.

Select a printer from the list view (or Printer Selection) by clicking its name to open a Status Window for a 
particular printer. 

Dell Supplies Management System
You can launch the Dell Supplies Management System dialog box from the All Programs menu or the desktop icon. 

You can order consumables by phone or from the web.

1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Dell Supplies 
Management System.

The Dell Supplies Management System window appears.

2 Select your printer from the Select Printer Model list.

3 If you are ordering from the web:

a Select a web address from the Select Reorder URL list.

b Click Visit Dell printer supplies ordering web site.

Dell C1765nf/C1765nfw Color MFP - Dell Supplies Management System window appears.

c Enter the Service Tag, and then click OK.

If you order by phone, call the number that appears in the Order by Phone section.
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Quick Launch Utility
Using the Quick Launch Utility window, you can open the Status Window, Tool Box, Troubleshooting, Address 
Book Editor, and ScanButton Manager.

To use the Quick Launch Utility, select to install the Quick Launch Utility when you install the Dell software.

To open the Quick Launch Utility window:

1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Quick Launch Utility.

The Quick Launch Utility dialog box opens.

2 The Quick Launch Utility window provides five buttons; Status Window, Tool Box, Troubleshooting, Address 
Book Editor, and ScanButton Manager.

To exit, click X at the top-right of the window.

For details, click Help of each application.

Status Window Click to open the Printer Status window. See "Printer Status Window" on page 299.

Tool Box Click to open the Tool Box. See "Understanding the Tool Box Menus" on page 139.

Troubleshooting*1 Click to open the Troubleshooting Guide, which allows you to resolve issues by yourself.

Address Book Editor Click to open the Address Book Editor, which allows you to create and edit Address Book entries.

ScanButton Manager Click to open the ScanButton Manager, which allows you to specify how the ScanButton 
Manager behaves for scan events that the device generates.

*1 Troubleshooting Guide is the Portable Document Format (PDF) file. This item needs software to view the document.
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Address Book Editor

 NOTE: You must install the fax driver before reading or editing the Address Book entries.

For more information about Address Book Editor, see the Help of Address Book Editor.

ScanButton Manager
This software allows you to configure the output destination of the scanned file and to select whether to open the 
file using the related application. These settings are available when scanning to a computer by pressing the 

(Start) button on the operator panel. For details about how to scan documents, see "Scanning From the 
Operator Panel - Using an Application" on page 248.

1 Read the Device Address Book entries from the printer to the Address Book Editor and read the PC Fax Address Book 
entries from the PC to the Address Book Editor.

2 Allows you to edit a selected Address Book entry in the edit dialog box.

3 Deletes a selected Address Book entry.

4 Displays Address Book entries.

1
4

2 3
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Dell ScanCenter
Dell ScanCenter is a PaperPort® application that allows you to scan items and send them directly to PaperPort or 
other programs on your computer without running the PaperPort program first. For more information about using 
Dell ScanCenter, refer to PaperPort's Help menu.

 NOTE: PaperPort may not be supported depending on the operating systems.

 NOTE: PaperPort application is available only on the PaperPort 14 disc provided with the printer. The licensed software 
application is not available for download from www.dell.com/support. 

http://www.dell.com/support
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23
Understanding Printer Messages
The printer operator panel displays messages describing the current state of the printer and indicates possible printer 
problems you must resolve. This chapter describes messages, their meanings, and how to clear the messages.

 CAUTION: When a status code is displayed, the print data remaining on the printer and the information accumulated in the 
memory of the printer are not secured.

Status-Code What you can do

001-360 Turn off the printer, and then on. If this does not solve the problem, contact Dell™. See "Contacting Dell" on 
page 367.003-340

003-356

005-121 Check and clear the paper path. See "Clearing Paper Jams From the ADF" on page 333.

005-301 Close the ADF cover.

006-370 Turn off the printer, and then on. If this does not solve the problem, contact Dell. See "Contacting Dell" on 
page 367.007-340

007-371

009-360 Re-install the specified toner cartridge. See "Installing a Toner Cartridge" on page 320.

009-361

009-362

009-363

009-654 Turn off the printer, and then on. If this does not solve the problem, contact Dell. See "Contacting Dell" on 
page 367.010-354

010-377

016-315

016-317

016-338

016-344

016-347

016-354

016-355

016-370

016-372

016-374

016-375

016-376

016-377

016-393 Turn off the printer, and then on. If this does not solve the problem, contact Dell. See "Contacting Dell" on 
page 367.016-395

016-503 Press the  (Set) button. Check if SMTP server and DNS server are set correctly.

016-504 Press the  (Set) button. Check if user name and password for POP3 server and DNS server are set correctly.

016-507 Press the  (Set) button. Check if user name and password used for SMTP server are set correctly.
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016-700 Press the  (Set) button to cancel the current print job.

016-701

016-720

016-744 Press the  (Set) button. Contact Dell if this message appears repeatedly. See "Contacting Dell" on 
page 367.016-745

016-749 Press the  (Set) button to cancel the current print job.

016-764 Press the  (Set) button. Contact SMTP server administrator.

016-766

016-767 Press the  (Set) button. Check e-mail address, and try scanning again.

016-794 Press the  (Set) button to clear the message.

016-795

016-797

016-920 Press the  (Set) button. Execute the operation again according to the operation procedure.

016-921

016-981 Press the  (Set) button to cancel the current print job. If you are copying using Collated, change the 
setting to Uncollated and try copying again. See "Setting Copy Options" on page 235.

016-985 Press the  (Set) button. Retry scanning by lowering the resolution setting or changing the file format of the 
scanned image.017-970

017-980 Press the  (Set) button to clear the message.

017-981

017-988

024-914 Load the specified paper. See "Loading Print Media in the Multipurpose Feeder (MPF)" on page 211 or 
"Loading Print Media in the Priority Sheet Inserter (PSI)" on page 219.

024-969 Load the appropriate paper. See "Loading Print Media in the Multipurpose Feeder (MPF)" on page 211 or 
"Loading Print Media in the Priority Sheet Inserter (PSI)" on page 219.

026-720 Press the  (Set) button to clear the message.

026-721

026-722

026-723

026-750

026-751

026-752

027-446 Change IP address to avoid duplication. Turn off the printer, and turn it on again.

027-452

031-521 Press the  (Set) button. Confirm login-able computer with your system administrator.

031-526 Press the  (Set) button. Check DNS connection, or check if forwarding destination server is registered with 
DNS.

031-529 Press the  (Set) button. Check if password is correct.

031-530 Press the  (Set) button. Check if storage location is correct. Storage location you specified is DFS setting, 
and check if it is linked to other server. Specify directly linked server, share name, and storage location.

Status-Code What you can do
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031-533 Press the  (Set) button. Check the following:

• If the file name you specified is not used by other users.

• If file or folder that has the same name as the one you specified already exists.

031-534

031-535 Press the  (Set) button. Check if other user is not operating file in storage location you specified.

031-536

031-537 Press the  (Set) button. Check if storage location has free space.

031-555 Press the  (Set) button to clear the message.

031-556

031-557 Press the  (Set) button. Change the file name that already exists on FTP server.

031-558 Press the  (Set) button to clear the message.

031-571

031-574 Press the  (Set) button. Check DNS connection, or check if name of forwarding destination server is 
registered with DNS.

031-575 Press the  (Set) button. Set DNS address, or set forwarding destination server address as IP address.

031-576 Press the  (Set) button. Check if the printer communicates with forwarding destination FTP server. For 
example, check connection of network cable and if the IP address of the server is correct.

031-578 Press the  (Set) button. Check if login name (user name) and password are correct.

031-579 Press the  (Set) button. Check if storage location is correct.

031-582 Press the  (Set) button. Check if the file name you specified can be created in storage location. Check if 
storage location has free space.

031-584 Press the  (Set) button. Check if the folder name you specified can be created in storage location. Check if 
the folder that has the same name as the one you specified already exists.

031-585 Press the  (Set) button. Check server access rights.

031-587

031-588 Press the  (Set) button. Check if storage location has free space.

031-589 Press the  (Set) button to clear the message.

031-594 Press the  (Set) button. Execute the operation again according to the operation procedure. Contact Dell if 
this message appears repeatedly. See "Contacting Dell" on page 367.

031-598 Press the  (Set) button. Check append access right to the file and if server supports FTP append 
command.

033-503 Press the  (Set) button to clear the message.

033-513 Press the  (Set) button. Print the received fax, or wait for a while until sending a fax is completed.

033-517 Press the  (Set) button. Check if password is correct.

033-518 Press the  (Set) button. Check if your country code is set correctly.

033-519 Press the  (Set) button to clear the message.

033-787

033-788 Press the  (Set) button. Remove the received fax, or wait for a while until sending a fax is completed. Press 
the  (Set) button to clear the message.

034-700 Press the  (Set) button to clear the message. Check that the phone line is connected properly. See 
"Connecting the Telephone Line" on page 43.034-701

034-702

Status-Code What you can do
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034-703 Press the  (Set) button to clear the message. Check that the phone line is connected properly. See 
"Connecting the Telephone Line" on page 43.034-704

034-705

034-706

034-707

034-708

034-709

034-710

034-711

034-712

034-713

034-714

034-715

034-716

034-717

034-718

034-719

034-720

034-721

034-722

034-723

034-724

034-725

034-726

034-727

034-750

034-751

034-752

034-753

034-754

034-755

034-756

034-757

034-758

034-759

034-760

034-761

034-762

034-763

034-764

034-765

Status-Code What you can do
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034-766

034-767

034-768

062-321 Turn off the printer, and then on. If this does not solve the problem, contact Dell. See "Contacting Dell" on 
page 367.

062-790 Press the  (Set) button.

075-100 Check and clear the paper path, load the specified paper, and then press the  (Set) button. See "Clearing 
Paper Jams From the Front of the Printer" on page 337.

075-921 Load paper for the second side (odd) pages, and press the  (Set) button. See Figure "Loading Print Media 
When Manual Duplex Printing" on page 224.

077-100 Check and clear the paper path. See "Clearing Jams" on page 331.

077-101

077-102 Check and clear the paper path. See "Clearing Paper Jams From the Back of the Printer" on page 338.

077-104 Check and clear the paper path. See "Clearing Jams" on page 331.

077-105

077-300 Close the rear cover.

077-900 Check and clear the paper path. See "Clearing Paper Jams From the Output Tray" on page 340.

077-901 Check and clear the paper path. See "Clearing Jams" on page 331.

091-402 Turn off the printer, and then on. If this does not solve the problem, contact Dell. See "Contacting Dell" on 
page 367.

092-310 Clean the CTD sensor. See "Cleaning the Color Toner Density (CTD) Sensor" on page 324.

093-423 Replace the specified toner cartridge soon. Order a new consumable from www.dell.com/supplies.

See "Replacing Toner Cartridges" on page 318.093-424

093-425

093-426

093-919 Re-install or replace the specified toner cartridge. See "Replacing Toner Cartridges" on page 318.

093-920

093-921

093-922

093-930 Remove the specified toner cartridge and install a new one. If you do not replace the toner cartridge, print 
quality problems may occur. Order a new consumable from www.dell.com/supplies.

See "Replacing Toner Cartridges" on page 318.
093-931

093-932

093-933

093-960 Replace the specified toner cartridge with the supported one. Order a new consumable from 
www.dell.com/supplies.

See "Replacing Toner Cartridges" on page 318.
093-961

093-962

093-963

093-970 Re-install the specified toner cartridge. See "Installing a Toner Cartridge" on page 320.

093-971

093-972

093-973

Status-Code What you can do

www.dell.com/supplies
www.dell.com/supplies
http://www.dell.com/supplies
www.dell.com/supplies
www.dell.com/supplies
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117-331 Turn off the printer, and then on. If this does not solve the problem, contact Dell. See "Contacting Dell" on 
page 367.117-332

117-333

117-334

117-340

117-342

117-343

117-344

117-346

117-348

117-349

117-350

117-351

117-366

124-333 Turn off the printer, and then on. If this does not solve the problem, contact Dell. See "Contacting Dell" on 
page 367.134-211

191-310

193-700 This message indicates the printer is in the non-Dell toner mode.

Status-Code What you can do
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Specifications

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

Operating System Compatibility
Your Dell™ C1765nf/C1765nfw Color Multifunction Printer is compatible with Microsoft® Windows® XP, 
Windows XP 64-bit Edition, Windows Vista®, Windows Vista 64-bit Edition, Windows 7, Windows 7 64-bit 
Edition, Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit Edition, Windows Server® 2003, 
Windows Server 2003 x64 Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 
2008 R2, Windows Server 2012, Windows Server 2012 R2, Mac OS X Version 10.4.11, 10.5, 10.6, 10.7, 10.8, and 
10.9.

Power Supply

Dimensions
Height: 338 mm (13.31 inches) Width: 410 mm (16.14 inches) Depth: 379 mm (14.92 inches) 

Weight (only the toner cartridges are included):

• Dell C1765nf Color Multifunction Printer: 14.8 kg (32.63 lb)

• Dell C1765nfw Color Multifunction Printer: 14.9 kg (32.85 lb)

Memory

Page Description Language (PDL)/Emulation, Operating System, and 
Interface

Rated Voltage 220-240 VAC 110-127 VAC

Frequency 50/60 Hz 50/60 Hz

Current 5.0 A 7.0 A

Base memory 128 MB

PDL/Emulations Host-based printing system

OSes Windows XP, Windows XP 64-bit Edition, Windows Vista, Windows Vista 64-bit 
Edition, Windows 7, Windows 7 64-bit Edition, Windows 8, Windows 8 64-bit Edition, 
Windows 8.1, Windows 8.1 64-bit Edition, Windows Server 2003, Windows Server 
2003 x64 Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, 
Windows Server 2008 R2, Windows Server 2012, Windows Server 2012 R2, Mac OS X 
Version 10.4.11, 10.5, 10.6, 10.7, 10.8, and 10.9.
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MIB Compatibility
A Management Information Base (MIB) is a database containing information about network devices (such as 
adapters, bridges, routers, or computers). This information helps network administrators manage the network 
(analyze performance, traffic, errors, and so on). Dell C1765nf/C1765nfw Color Multifunction Printer complies with 
standard industry MIB specifications, allowing the printer to be recognized and managed by various printer and 
network management software systems.

Environment

Operation

Print Quality Guarantee

Storage

Altitude

 NOTE: For more information on adjusting the altitude, see "Adjust Altitude" on page 151.

Interfaces Standard local:

Standard network:

USB 2.0

10Base-T/100Base-TX Ethernet

IEEE 802.11b/802.11g (Wireless)
(Dell C1765nfw Color Multifunction 
Printer only)

Temperature 10-32°C

Relative humidity 10-85% RH (no condensation)

Temperature 15-28°C

Relative humidity 20-70% RH (no condensation)

Temperature range -20-40°C

Storage humidity range 5-80% RH (no condensation)

Operating Up to 3,100 m (10,000 feet)

Storage 70.9275 Kpa
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Cables
Your interconnection cable must meet the following requirements:

Connection type Connection specifications and symbols

1 Ethernet 10 Base-T/100 Base-TX

2 USB USB 2.0

3 Wall Jack Connector

4 Phone Connector

1

2

3

4 
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Copy Specifications

Scanner Specifications

Item Description

Copy Resolution Document glass: 600x600 dots/25.4 mm (1 inch), 
ADF: 600x300 dots/25.4mm (1 inch)
(Same for Color/Black&White)

Copy Speed Color 12 cpm or more, Black&White 15 cpm or more (When using the document glass to 
make sequential copies of a document with pages scanned one by one.)

Color 2.87 cpm or more, Black&White 10.64 cpm or more (When using the ADF to make 
sequential copies of multiple documents.)

Paper Size A4, A5, B5, Executive, Letter, Folio, Legal, Monarch, DL, C5, Envelope #10

Zoom Rate Document glass: 25% - 400%, ADF: 25% - 400%

Multiple copies 1 - 99 pages

Copy mode (=Original Type) Text, Text & Photo, Photo

Scanning method Document glass: Document-fixed flatbed scanning method 

ADF: Carriage-fixed, document-feeding scanning method (one side scanning) 

Item Description

Compatibility Tool Without An Interesting Name (TWAIN), Windows Image Acquisition (WIA)

Scan Resolution TWAIN: 75 x 75 to 4800 x 4800 dots/25.4 mm (1 inch)

WIA: 75/100/150/200/300/400/600 dots/25.4 mm 
(1 inch)

Resolutions other than the following are achieved by driver's resolution conversion:

200 x 200 dots/25.4 mm (1 inch)

300 x 300 dots/25.4 mm (1 inch) (Default)

600 x 600 dots/25.4 mm (1 inch)

1200 x 1200 dots/25.4 mm (1 inch)

Color bit depth 24 bit (WIA, TWAIN)

Mono bit depth 1 bit for Line art and 8 bit for Gray scale

Effective scanning length Document glass: 297 mm (11.69 inches), 
ADF: 355.6 mm (14 inches)

Effective scanning width 215.9 mm (8.5 inches)

Scan speed (Text mode) Black&White:
641.22 μsec/line (600 dots/25.4 mm (1 inch)), 
1265.19 μsec/line (1200 dots/25.4 mm (1 inch)) 

Color:
2176.52 μsec/line (600 dots/25.4 mm (1 inch)), 
4363.36 μsec/line (1200 dots/25.4 mm (1 inch))
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Facsimile Specifications

Item Description

Compatibility ITU-T Group 3 

Applicable line Public Switched Telephone Network (PSTN)

Data coding Black&White: 1bit, JBIG, MMR, MR, MH encoding 

Color: Not supported

Max modem speed  33.6 Kbps 

Transmission speed Approx. 3 seconds/page *Transmission time applies to memory transmission of text data 
scanned in Standard resolution with ECM using only ITU-T No.1 Chart. 

Scanning speed Document glass: approx. 3 seconds/A4 (at standard fax resolution mode) ADF: approx. 5 
seconds/Letter (at standard fax resolution mode), 7.5 seconds/Letter (at fine fax resolution 
mode) 

Maximum document length Document glass: 297 mm (11.69 inches), 
ADF: 355.6 mm (14 inches)

Paper size Letter, A4, Legal 

Resolution Standard: 8 pels/mm (203 pels/inch) x 3.85 lines/mm (98 lines/inch)
200 dpi x 100 dpi

Fine: 8 pels/mm (203 pels/inch) x 7.7 lines/mm (196 lines/inch)
200 dpi x 200 dpi

Super Fine: 8 pels/mm (203 pels/inch) x 15.4 lines/mm (391 lines/inch)
200 dpi x 400 dpi

Ultra Fine: 16 pels/mm (406 pels/inch) x 15.4 lines/mm (391 lines/inch)
400 dpi x 400 dpi 

User Memory 2 MB

Halftone 256 levels
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Maintaining Your Printer
Periodically, your printer requires you to complete certain tasks to maintain optimum print quality. If several people 
are using the printer, you may want to designate a key operator to maintain your printer. Refer printing problems and 
maintenance tasks to this key operator.

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

Determining the Status of Supplies
If your printer is connected to the network, the Dell Printer Configuration Web Tool can provide instant feedback 
on remaining toner levels. Type the printer's IP address in your web browser to view this information. To use 
the E-Mail Alert feature that notifies you when the printer requires new supplies, type your name or the name of the 
key operator in the e-mail list box.

On the operator panel, you can also confirm the following:

• Any supply or maintenance items that require attention replacing (However, the printer can only display 
information about one item at a time.)

• Amount of toner remaining in each toner cartridge

Conserving Supplies
You can change several settings in your printer driver to conserve toner cartridge and paper.

Storing Print Media
To avoid potential paper feeding problems and uneven print quality, there are several things you can do.

• To achieve the best possible print quality, store print media in an environment where the temperature is 
approximately 21°C (70°F) and the relative humidity is 40%.

• Store cartons of print media on a pallet or shelf, rather than directly on the floor.

• If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so 
the edges do not buckle or curl.

• Do not place anything on top of the print media packages.

Supply Setting Function

Toner cartridge Toner Saving Mode in the Graphics 
tab of the printer driver

This check box allows the users to select a print mode that uses less 
toner. When this feature is used, the image quality will be lower 
than when it is not used.

Print media Multiple Up in the Layout tab of 
the printer driver

The printer prints two or more pages on one side of a sheet. The 
available numbers that each printer driver can print one sheet of 
paper are as follows:

• Printer driver for Microsoft® Windows®: 2, 4, 8, or 16 pages

• Printer driver for Macintosh: 2, 4, 6, 9, or 16 pages

Combined with the duplex setting, Multiple Up allows you to 
print up to 32 pages on one sheet of paper. (16 images on the front 
and 16 on the back)
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Storing Consumables
Store consumables in their original packaging until you need to use them. Do not store consumables in:

• Temperatures greater than 40°C (104°F).

• An environment with extreme changes in humidity or temperature.

• Direct sunlight.

• Dusty places.

• A car for a long period of time.

• An environment where corrosive gases are present.

• An environment with salty air.

Replacing Toner Cartridges

 WARNING: Before replacing toner cartridges, read and follow the safety instructions in the Important Information.

Dell toner cartridges are available only through Dell. You can order more cartridges online at 
http://www.dell.com/supplies or by phone. To order by phone, see "Contacting Dell" on page 367.

It is recommended that you use Dell toner cartridges for your printer. Dell does not provide warranty coverage for 
problems caused by using accessories, parts, or components not supplied by Dell.

 WARNING: Never throw used toner cartridges into fire. The residual toner could explode resulting in burns and injuries.

 WARNING: Do not shake the used toner cartridge to avoid spilling of toner.

Removing the Toner Cartridges
1 Open the toner access cover.

http://www.dell.com/supplies
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2 Pinch the cartridge firmly as shown in the illustration.

 WARNING: Always pull the cartridge out slowly so you do not spill any toner. 

3 Pull the toner cartridge out.
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Installing a Toner Cartridge
1 Unpack a new toner cartridge of the desired color and shake it five to six times to distribute the toner evenly.

 NOTE: Ensure that the color of the new toner cartridge matches that on the handle before replacing it.

 NOTE: Handle the toner cartridge carefully to avoid spillage of the toner.

2 Remove the tape from the toner cartridge.

3 Adjust the toner cartridge to the associated cartridge holder, and then insert it firmly by pressing near the center of 
the label until the cartridge clicks.
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4 Close the toner access cover.

Cleaning Inside the Printer

 WARNING: To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet 
before performing maintenance.

1 Confirm that the printer is not in operation, and open the toner access cover.
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2 Pinch the cartridge firmly as shown in the illustration.

3 Pull the toner cartridge out.

4 Pull the other three cartridges out as well.

5 Pull the cleaning rod out.
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6 Insert the cleaning rod fully into the hole beside the arrow on the printer until its tip reaches the interior of the 
printer as illustrated below, and then pull it out.

7 Repeat the same procedure for the other three holes.

8 Insert the cleaning rod back to its original location.

9 Replace the black cartridge by adjusting it to the associated cartridge holder, and then insert it firmly by pressing 
near the center of the label until the cartridge clicks.
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10 Replace the other three cartridges as well.

11 Close the toner access cover.

Cleaning the Color Toner Density (CTD) Sensor

Clean the CTD sensor only when an alert for the CTD sensor is shown on the Status Monitor or operator panel.

1 Ensure that the printer is turned off.

2 Push the rear cover release handle and open the rear cover.
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3 Clean the CTD sensor inside the printer with a clean dry cotton swab.

4 Close the rear cover.

5 Turn on the printer.

Adjusting Color Registration
This section describes how to adjust the color registration when you first install the printer or after moving it to a 
new location.

 NOTE: A password is required to enter the Admin Menu menu when Panel Lock Set is set to Enable. In this case, 
enter the password you specified, and press the  (Set) button.

Performing Auto Adjust
Auto Adjust allows you to correct the color registration automatically.

The Operator Panel

1 Press the  (Menu) button.

2 Press the  button until System is highlighted, and then press the  (Set) button.

3 Press the  button until Admin Menu is highlighted, and then press the  (Set) button.

4 Press the  button until Maintenance is highlighted, and then press the  (Set) button.

5 Press the  button until Adjust ColorRegi is highlighted, and then press the  (Set) button.

6 Ensure that Auto Adjust is highlighted, and then press the  (Set) button.
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7 Ensure that Are You Sure? is displayed, press the  button to select Yes, and then press the  (Set) 
button.

Auto adjust is performed.

The Tool Box

1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Tool Box.

 NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this 
case, click Dell C1765nf Color Multifunction Printer or Dell C1765nfw Color Multifunction Printer listed in Printer Name.

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select Registration Adjustment from the list at the left side of the page.

The registration adjustment page is displayed.

4 Clear the On check box for Auto Registration Adjustment.

5 Click Start next to Auto Correct.

The color registration is corrected automatically.

Printing the Color Registration Chart 

The Tool Box

1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Tool Box.

 NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this 
case, click Dell C1765nf Color Multifunction Printer or Dell C1765nfw Color Multifunction Printer listed in Printer Name.

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select Registration Adjustment from the list at the left side of the page.

The registration adjustment page is displayed.

4 Clear the On check box for Auto Registration Adjustment.

5 Click Start next to Print Color Regi Chart.

The color registration chart is printed.

Determining Values
On the color registration chart printed, find the straightest lines where the two black lines and the colored line are 
most closely aligned for each color (Y, M, and C).

If you find the straightest line, make a note of the value (-5 - +5) indicated by the straightest line for each color.

When the value is 0 for each color, you do not need to adjust the color registration.

When the value is not 0, enter the value according to the procedure in "Entering Values" on page 327.
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Entering Values

The Tool Box

Using the Tool Box, enter the values that you found in the color registration chart to make adjustments. 

1 Click Start → All Programs → Dell Printers → Dell C1765 Color Multifunction Printer → Tool Box.

 NOTE: The Select Printer window appears in this step, when multiple printer drivers are installed on your computer. In this 
case, click Dell C1765nf Color Multifunction Printer or Dell C1765nfw Color Multifunction Printer listed in Printer Name.

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select Registration Adjustment from the list at the left side of the page.

The registration adjustment page is displayed.

4 Clear the On check box for Auto Registration Adjustment.

5 Select the value with the straight line, and then click Apply New Settings.

6 Click Start next to Print Color Regi Chart.

The color registration chart is printed with the new values.

7 Adjust the values for every color until the lines at 0 are the straightest. If a line is not the straightest at 0, determine 
the value and adjust the printer again.

 CAUTION: After printing the color registration chart, do not turn off the printer until the printer motor has stopped running. 
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Cleaning the Scanner
Keeping the scanner clean helps ensure the best possible copies. It is recommended to clean the scanner at the start 
of each day and during the day, as needed.

1 Slightly dampen a soft lint-free cloth or paper towel with water.

2 Open the document cover.

3 Wipe the surface of the document glass and ADF glass until it is clean and dry.

1 White Sheet

2 White Document Cover

3 Document Glass

4 ADF Glass

1

3

4

2
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4 Wipe the underside of the white document cover and white sheet until they are clean and dry.

5 Close the document cover.
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Cleaning the ADF Feed Roller
Keeping the ADF feed roller clean helps ensure the best possible copies. It is recommended to clean the ADF feed roller 
at regular intervals.

1 Open the ADF cover.

2 Wipe the ADF feed roller with a dry soft lint-free cloth or paper towel until it is clean.

If the ADF feed roller gets soiled with ink stains, paper from the ADF may also be soiled. In this case, slightly 
dampen a soft lint-free cloth or paper towel with a neutral detergent or water, and then remove the contamination 
from the ADF feed roller until it is clean and dry.
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Clearing Jams
Careful selection of appropriate print media and proper loading allow you to avoid most jams. See "Print Media 
Guidelines" on page 203 for more information.

 NOTE: The images used in this manual are those of the Dell™ C1765nfw Color Multifunction Printer unless otherwise mentioned.

 NOTE: Before buying large quantities of any print media, it is recommended that you try a sample first.

Avoiding Jams
• Use only recommended print media. See "Print Media Guidelines" on page 203 for more information.

• See "Loading Print Media in the Multipurpose Feeder (MPF)" on page 211 and "Loading Print Media in the 
Priority Sheet Inserter (PSI)" on page 219 to load print media properly.

• Do not overload the print media sources. Ensure that the stack print media height does not exceed the maximum 
height indicated by the line with an arrow on each width guide.

• Do not load wrinkled, creased, damp, or curled print media.

• Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at a 
time through the MPF or the PSI.

• Do not use print media that you have cut or trimmed yourself.

• Do not mix print media sizes, weights, or types in the same print media source.

• Ensure that the recommended print side is face up when you insert the print media.

• Keep print media stored in an acceptable environment. For more information, see "Storing Print Media" on 
page 207.

• Do not remove the PSI during a print job.

• Ensure that all cables that connect to the printer are correctly attached.

• Overtightening the guides may cause jams.
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Identifying the Location of Paper Jams
 WARNING: Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

1 Scanner Unit

2 Fusing Unit

3 Levers

4 Rear Cover

5 ADF Cover

6 Front Cover

7 Multipurpose Feeder (MPF)

1 2 3

7 6 5

4
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Clearing Paper Jams From the ADF

When a document jams while it passes through the Automatic Document Feeder (ADF), remove jams in the 
following procedure.

 WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Important 
Information.

 WARNING: To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet 
before performing maintenance.

 WARNING: To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot during 
use.

 NOTE: To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1 Open the ADF cover.

2 Remove the jammed document by carefully pulling it in the direction of the arrow shown in the following 
illustration.
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3 If you find it difficult to pull the document, open the document feeder tray.

4 Remove the jammed document from the document output tray.

5 Close the document feeder tray.
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6 Close the ADF cover, and then load the documents back into the ADF.

 NOTE: Ensure that you adjust the document guides before printing a Legal-size document.

7 If you cannot remove the jammed document from the document output tray or cannot find any jammed 
document there, open the document output tray.
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8 Remove the document from the ADF feed roller or the feed area by carefully pulling the document in the direction 
of the arrow shown in the following illustration.
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Clearing Paper Jams From the Front of the Printer

 WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Important 
Information.

 NOTE: To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1 Pull the PSI out.

2 Remove any jammed paper from the front of the printer.
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3 Replace the PSI in the printer.

 WARNING: When putting the PSI back into the printer, do not use excessive force. Doing so could damage the PSI or 
the inside of the printer.

4 Press the  (Set) button.

Clearing Paper Jams From the Back of the Printer

 WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Important 
Information.

 WARNING: To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet 
before performing maintenance.

 WARNING: To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot during 
use.

 NOTE: To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1 Push the rear cover release handle and open the rear cover.



Clearing Jams 339

2 Lift up the levers.

3 Remove any jammed paper from the back of the printer.

4 Lower the levers to their original position.
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5 Close the rear cover.

Clearing Paper Jams From the Output Tray

 WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Important 
Information.

 WARNING: To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet 
before performing maintenance.

 WARNING: To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot during 
use.

 NOTE: To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1 Push the rear cover release handle and open the rear cover.
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2 Lift up the levers.

3 Remove any jammed paper from the back of the printer. If no paper is found in the paper path, face the front of 
the printer and check the output tray.

4 Lift and open the scanner unit.
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5 Remove any jammed paper out of the output tray. 

6 Lower and close the scanner unit.

7 Lower the levers to their original position.
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8 Close the rear cover.
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Troubleshooting

Basic Printer Problems
Some printer problems can be easy to resolve. If a problem occurs with your printer, check each of the following:

• The power cable is connected to the printer, and to a properly grounded electrical outlet.

• The printer is turned on.

• The electrical outlet is not turned off at any switch or breaker.

• Other electrical equipment plugged into the outlet is working.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn 
on the printer. This often fixes the problem.

 NOTE: If error messages are displayed on the operator panel or on your computer screen, follow the on-screen instructions to 
resolve the printer problems. For details about error messages and status codes, see "Understanding Printer Messages" on 
page 303.

Display Problems

Printing Problems
 NOTE: A password is required to enter the Admin Menu menu when Panel Lock Set is set to Enable. In this case, 

enter the password you specified, and press the  (Set) button.

Problem Action

Menu settings changed from the operator 
panel have no effect.

Settings in the software program, the printer driver, or the printer utilities have 
precedence over the settings made on the operator panel.

Change the menu settings from the printer driver, the printer utilities, or the 
software program instead of the operator panel.

Problem Action

Job did not print or incorrect characters 
printed.

Ensure that Ready to Copy appears on the operator panel before you send a 
job to print.

Ensure that print media is loaded in the printer.

Verify that you are using the correct printer driver.

Ensure that you are using the correct Ethernet or USB cable and that it is securely 
connected to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Check the interface of your printer from the Admin Menu.

Determine the host interface you are using. Print a panel settings page to verify 
that the current interface settings are correct. Refer to "Printing a Report/List 
Using the Operator Panel" on page 175 for details on how to print a panel settings 
page.
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Print media misfeeds or multiple feeds 
occur.

Ensure that the print media you are using meets the specifications for your printer. 
See "Supported Paper Sizes" on page 208 for more information.

Fan the print media before loading it.

Ensure that the print media is loaded correctly.

Ensure that the width and length guides are adjusted correctly.

Ensure that the Priority Sheet Inserter (PSI) is securely inserted.

Do not overfill the print media sources.

Do not force print media into the PSI or the Multipurpose Feeder (MPF) when 
you load it. Otherwise, it may skew or buckle.

Ensure that the print media is not curled.

Load the recommended print side correctly for the type of print media you are 
using. See "Loading Print Media" on page 211 for more information.

Turn the print media over or around and try printing again to see if feeding 
improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom curled sheets of a ream before loading the print 
media.

Load a print media source only when it is empty.

The envelope is creased after printing. Ensure that the envelope is loaded as instructed in "Loading an Envelope in the 
Multipurpose Feeder (MPF)" on page 216 or "Loading an Envelope in the Priority 
Sheet Inserter (PSI)" on page 221.

Page breaks in unexpected places. Increase the setting for Time-Out in the Printer Settings menu in the 
Dell™ Printer Configuration Web Tool.

Print media does not stack neatly in the 
output tray.

Turn the print media stack over in the PSI and MPF.

Printer does not duplex pages. Select Flip on Short Edge or Flip on Long Edge from the Duplex menu on the 
Paper/Output tab in the printer driver.

Problem Action
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Print Quality Problems
 NOTE: In this section, some procedures that use the Tool Box can also be performed using the operator panel or 

Dell Printer Configuration Web Tool. For information on how to use the operator panel and Dell Printer Configuration Web Tool, 
see "Understanding the Printer Menus" on page 163 and "Dell™ Printer Configuration Web Tool" on page 97.

The output is too light

Action Yes No

1 The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner in each toner cartridge. 

a Check the toner level in the Status tab in the Status Monitor.
b Replace the toner cartridges as necessary.

Is the problem recovered?

The task is complete. Go to action 2.

2 Verify that the print media is not damp and the correct print media is 
used. See "Supported Paper Types" on page 209. If not, use the print 
media recommended for the printer.

Is the problem recovered?

The task is complete. Go to action 3.

3 Verify that the Paper Type setting in the printer driver matches the print 
media you loaded.

a On the Paper/Output tab in Printing Preferences of the printer 
driver, check the Paper Type setting.

b Load dry (not damp) and corrected print media, and then click Print 
Test Page in Printer properties of the printer driver.

Is the problem recovered?

The task is complete. Go to action 4.

4 Disable the Toner Saving Mode in the printer driver.
a On the Graphics tab in Printing Preferences of the printer driver, 

ensure that the Toner Saving Mode check box is not selected.

Is the problem recovered?

The task is complete. Contact Dell.
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Toner smears or print comes off/Stain on back side

Action Yes No

1 The print media surface may be uneven. Try changing the Paper Type 
setting in the printer driver. For example, change the plain paper to 
thick.

a On the Paper/Output tab in Printing Preferences of the printer 
driver, change the Paper Type setting.

Is the problem recovered?

The task is complete. Go to action 2.

2 Verify that the correct print media is being used. See "Supported Paper 
Types" on page 209. If not, use the print media recommended for the 
printer.

Is the problem recovered?

The task is complete. Go to action 3.

3 Adjust the fusing unit temperature.
a Launch the Tool Box, and click Adjust Fusing Unit on the Printer 

Maintenance tab.
b Adjust the fixing temperature by turning up the value for your 

printing media.
c Click Apply New Settings.
d Click close box to exit Tool Box.

Is the problem recovered?

The task is complete. Contact Dell.
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Random spots/Blurred images

The entire output is blank

If this trouble comes out, contact Dell.

Streaks appear on the output

If this trouble comes out, contact Dell.

Action Yes No

1 Ensure that the toner cartridges are installed correctly. See "Installing a 
Toner Cartridge" on page 320.

Is the problem recovered?

The task is complete. Go to action 2.

2 If you use non-Dell brand toner cartridges, install Dell brand toner 
cartridges.

Is the problem recovered?

The task is complete. Go to action 3.

3 Clean up the fusing unit.
a Load one sheet of paper on the MPF, and then print a solid image all 

over paper.
b Load the printed sheet with the side to be printed on facing down, 

and then print a blank sheet of paper.

Is the problem recovered?

The task is complete. Contact Dell.
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Pitched color dots

If this trouble comes out, contact Dell.

Vertical blanks

Mottle

Action Yes No

1 Clean inside the printer and performing test print.
a Clean inside the printer by using the cleaning rod. See "Cleaning 

Inside the Printer" on page 321.
b Click Print Test Page in Printer properties of the printer driver.

Is the problem recovered?

The task is complete. Contact Dell.

Action Yes No

1 Adjust the transfer bias.
a Launch the Tool Box, click Adjust Transfer Roller on the Printer 

Maintenance tab.
b Adjust the setting for the type of print media being used.

Is the problem recovered?

The task is complete. Go to action 2.

2 If you use non-recommended print media, use the print media 
recommended for the printer.

Is the problem recovered?

The task is complete. Contact Dell.
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Ghosting

Action Yes No

1 Adjust the transfer bias.
a Launch the Tool Box, and click Chart Print on the Diagnosis tab.
b Click Ghost Configuration Chart.

The ghost configuration chart is printed.
c Launch the Tool Box, and click Transfer Roller Refresh Mode on the 

Printer Maintenance tab.
d Check the check box next to On, and then click Apply New Settings.
e Click Chart Print on the Diagnosis tab.
f Click Ghost Configuration Chart.

The ghost configuration chart is printed.

Is the problem recovered?

The task is complete. Go to action 2.

2 The print media surface may be uneven. Try changing the Paper Type 
setting in the printer driver. For example, change the plain paper to 
thick.

a On the Paper/Output tab in Printing Preferences of the printer 
driver, change the Paper Type setting.

Is the problem recovered?

The task is complete. Go to action 3.

3 Adjust the fusing unit temperature.
a Launch the Tool Box, and click Adjust Fusing Unit on the Printer 

Maintenance tab.
b Adjust the fixing temperature by turning up the value for your 

printing media.
c Click Apply New Settings.
d Click close box to exit Tool Box.

Is the problem recovered?

The task is complete. Go to action 4.

4 If you use non-recommended print media, use the print media 
recommended for the printer.

Is the problem recovered?

The task is complete. Contact Dell.
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Fog

Bead-Carry-Out (BCO)

Action Yes No

1 Is the whole page printed light? Contact Dell. Go to action 2.

2 Start Clean Developer.
a Launch the Tool Box, and click Clean Developer on the Diagnosis 

tab.
b Click Start.

Is the problem recovered?

The task is complete. Contact Dell.

Action Yes No

1 If the printer is installed in a high altitude location, set the altitude of 
the location.

a Launch the Tool Box, and click Adjust Altitude on the Printer 
Maintenance tab.

b Select the value close to the altitude of the location where the printer 
is installed.

Is the problem recovered?

The task is complete. Contact Dell.
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Auger mark

Wrinkled/Stained paper

Action Yes No

1 The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner in each toner cartridge.

a Check the toner level in the Status tab in the Status Monitor.
b Replace the toner cartridges as necessary.

Is the problem recovered?

The task is complete. Go to action 2.

2 Start Clean Developer.
a Launch the Tool Box, and click Clean Developer on the Diagnosis 

tab.
b Click Start.

Is the problem recovered?

The task is complete. Contact Dell.

Action Yes No

1 Verify that the correct print media is being used. See "Supported Paper 
Sizes" on page 208 and "Print Media Guidelines" on page 203. If not, use 
the print media recommended for the printer.

Is the problem recovered?

The task is complete. If printing on an 
envelope, go to action 
2.

If printing on print 
media other than 
envelopes, contact Dell.

2 Check the crease. Is the crease within 30 mm of the four edges of the 
envelope?

This type of crease is 
considered normal. 
Your printer is not at 
fault.

If the envelope is 220 
mm or longer (C5 or 
Envelope #10), go to 
action 3a. 

If the envelope is 
shorter than 220 mm 
(Monarch or DL), go to 
action 3b.
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The top margins is incorrect

3a Does the envelope have a flap on the long edge? The envelope is 
Envelope #10. 

Go to action 4b.

The envelope is C5. 

Go to action 4a.

3b Load the envelope long edge feed in the MPF with the flap open and 
facing up. For details, see "When Loading Envelope #10, DL, or 
Monarch" on page 216.

Is the problem recovered?

The task is complete. Go to action 4b.

4a Load the envelope in the MPF with the flap open and facing up. For 
details, see "When Loading C5" on page 217.

Is the problem recovered?

The task is complete. Contact Dell.

4b Use a different size envelope.

Is the problem recovered?

The task is complete. Contact Dell.

Action Yes No

1 Ensure that the margins are set correctly on the application being used.

Is the problem recovered?

The task is complete. Contact Dell.

Action Yes No
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Color registration is out of alignment

Action Yes No

1 Execute auto color registration adjustment.
a Launch the Tool Box, and click Registration Adjustment on the 

Printer Maintenance tab.
b Clear the On check box for Auto Registration Adjustment.
c Click Start next to Auto Correct.

Is the problem recovered?

The task is complete. Go to action 2.

2 Clean the CTD sensor.
a Clean the CTD sensor. See "Cleaning the Color Toner Density 

(CTD) Sensor" on page 324.
b Launch the Tool Box, and click Registration Adjustment on the 

Printer Maintenance tab.
c Clear the On check box for Auto Registration Adjustment.
d Click Start next to Auto Correct.

Is the problem recovered?

The task is complete. Go to action 3.

3 Print the color registration chart and manually correct the color 
registration. 

a Click Registration Adjustment on the Printer Maintenance tab.
b Clear the On check box for Auto Registration Adjustment.
c Click Start next to Print Color Regi Chart.

The color registration chart is printed.
d Select the value with the straight line. See "Adjusting Color 

Registration" on page 325 for details.
e Click Apply New Settings.
f Click Start next to Print Color Regi Chart to print the color 

registration chart again.
g Adjust the values for every color until the lines at 0 are the straightest.

Is the problem recovered?

The task is complete. Contact Dell.
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Protrudent / Bumpy paper

Jam

Misfeed jam

Action Yes No

1 Clean up the fusing unit.
a Load one sheet of paper on the MPF, and then print a solid image all 

over paper.
b Load the printed sheet with the side to be printed on facing down, 

and then print a blank sheet of paper.

Is the problem recovered?

The task is complete. Contact Dell.

Action Yes No

1 Remove the paper from the PSI, and then ensure that papers are 
properly inserted on the MPF.

Is the problem recovered?

The task is complete. Proceed to the action 
corresponding to the 
type of the print media 
being used:

• Thick - 2a

• Thin - 2b

• Envelope - 2c

If performing manual 
duplex printing, go to 
action 2d. 

If using paper other 
than the above or if not 
performing duplex 
printing, go to action 
2e.

2a Use thick paper that is 163 gsm or less.

Is the problem recovered?

The task is complete. Go to action 3a.

2b Use thin paper that is 60 gsm or more.

Is the problem recovered?

The task is complete. Go to action 3a.

2c Ensure that the envelope is properly loaded in the MPF as instructed in 
"Loading an Envelope in the Multipurpose Feeder (MPF)" on page 216.

Is the problem recovered?

The task is complete. Go to action 3b.
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Multi-feed jam

A document jam occurs in the Automatic Document Feeder (ADF) if scanning of multiple-sheet document is 
cancelled while scanning is in progress.

2d Ensure that the print media is not curled.

Is the problem recovered?

The task is complete. Go to action 3a.

2e Is the print media damp? Go to action 3c. Go to action 3a.

3a Fan the print media.

Is the problem recovered?

The task is complete. Go to action 3c.

If you are performing 
manual duplex printing 
or if using an envelope, 
contact Dell. 

3b If the envelope is deformed, correct it or use another envelope.

Is the problem recovered?

The task is complete. Go to action 3a.

3c Turn over the print media.

Is the problem recovered?

The task is complete. Go to action 4.

4 Use print media that is not damp.

Is the problem recovered?

The task is complete. Contact Dell.

Action Yes No

1 Remove the paper from the PSI, and then ensure that papers are 
inserted properly in the MPF.

Is the problem recovered?

The task is complete. Go to action 2.

2 Is the print media damp? Go to action 3a. Go to action 3b.

3a Use print media that is not damp.

Is the problem recovered?

The task is complete. Go to action 3b.

3b Fan the print media.

Is the problem recovered?

The task is complete. Contact Dell.

Action Yes No

1 Clear the jam. See "Clearing Paper Jams From the ADF" on page 333.

Is the problem recovered?

The task is complete. Contact Dell.

Action Yes No
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Copy Problem

Fax Problems

Problem Action

A document loaded in the ADF cannot be 
copied.

Ensure that the ADF cover is firmly closed. 

Problem Action

The printer is not working, there is no 
display and the buttons are not working.

Unplug the power cord and plug it in again. 

Ensure that there is power to the electrical receptacle. 

No dial tone sounds. Check that the phone line is connected properly. See "Connecting the Telephone 
Line" on page 43. 

Check that the phone socket in the wall is working by plugging in another phone. 

The numbers stored in the memory do not 
dial correctly.

Print an Address Book list and ensure that the numbers are stored in the memory 
correctly. 

The document does not feed into the 
printer.

Ensure that the document is not wrinkled and you are putting it in correctly. 
Check that the document is of the right size, not too thick or thin. 

Ensure that the ADF cover is firmly closed. 

Faxes are not received automatically. The FAX mode should be selected. 

Ensure that there is paper in the PSI or MPF. 

Check to see if the display shows Memory Full.

Check the Junk Fax Setup setting.

The printer does not send faxes. Sending should show up on the display. 

Check the other fax machine you are sending to, to see if it can receive your fax. 

The incoming fax has blank spaces or is 
received in poor-quality.

The fax machine sending you the fax may be faulty. 

A noisy phone line can cause line errors. 

Check your printer by making a copy. 

The toner cartridge may be empty. Replace the toner cartridge. For details, see 
"Replacing Toner Cartridges" on page 318. 

Some of the words on an incoming fax are 
stretched.

The fax machine sending you the fax had a temporary document jam. 

There are lines on the documents you send. Check the surface of the document glass and ADF glass for marks and clean it. See 
"Cleaning the Scanner" on page 328. 

The printer dials a number, but the 
connection with another fax machine fails.

The other fax machine may be turned off, out of paper, or cannot answer incoming 
calls. Speak with the other machine operator and ask her/him to sort out the 
problem. 

Documents are not stored in the memory. There may not be enough memory to store the document. If the display shows a 
Memory Full message, delete any documents you no longer need from the 
memory and then restore the document, or wait for the job in progress (e.g., a fax 
transmission or reception) to complete.
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Scanning Problems

Blank areas appear at the bottom of each 
page or on other pages, with a small strip of 
text at the top.

You may have chosen the wrong paper settings in the user option setting. See 
"Print Media Guidelines" on page 203.

The printer will not send or receive faxes. Ensure that the country code is set correctly under (Menu) → System 
→Admin Menu → Fax Settings → Country.

Check that the phone line is connected properly. See "Connecting the Telephone 
Line" on page 43.

An error often occurs during a fax 
transmission or reception.

Reduce the modem speed under (Menu) → System → Admin Menu → 
Fax Settings → Modem Speed.

Problem Action

The scanner does not work. Ensure that you place the document to be scanned face down from the document 
glass, or face up in the ADF. 

There may not be enough available memory to hold the document you want to 
scan. Try the preview function to see if that works. Try lowering the scan resolution 
rate. 

Check that the Ethernet or USB cable is connected properly. 

Ensure that the Ethernet or USB cable is not defective. Switch the cable with a 
known good cable. If necessary, replace the cable.

Check that the scanner is configured correctly. Check the application you want to 
use to make certain that the scanner job is being sent to the correct port. 

The printer scans very slowly. Graphics are scanned more slowly than text when using the Scan to E-Mail or Scan 
to Network Folder feature. 

Communication speed becomes slow in scan mode because of the large amount of 
memory required to analyze and reproduce the scanned image. 

Scanning images at a high resolution takes more time than scanning at a low 
resolution.

Document misfeeds or multiple feeds occur 
in the ADF.

Ensure that the document’s paper type meets the specifications for the printer. See 
"Supported Paper Types" on page 209 for more information.

Check whether the document is properly loaded in the ADF.

Ensure that the document guides are adjusted properly.

Ensure that the number of document sheets do not exceed the maximum capacity 
of the ADF.

Ensure that the document is not curled.

Fan the document well before loading it in the ADF.

Vertical stripes appear on the output when 
scanned using the ADF.

Clean the ADF glass.

See "Cleaning the Scanner" on page 328.

A smear appears at the same location on the 
output when scanned using the document 
glass.

Clean the document glass.

See "Cleaning the Scanner" on page 328.

Images are skewed. Ensure that the document is loaded straight in the ADF or on the document glass.

Diagonal lines appear jagged when scanned 
using the ADF.

If the document uses thick media, try scanning it from the document glass.

Problem Action
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The printer does not properly transfer scan 
data to a specified destination via the Scan 
to E-Mail or Scan to Network Folder feature. 

Check if the following settings have been set correctly on the 
Dell Printer Configuration Web Tool.

Scan to Network Folder

Check the following settings under Address Book → Server Address:

•Server Address

•Share Name

•Server Path

•Login Name

•Login Password

Scan to E-Mail

Check the following setting under Address Book → Fax/E-Mail:

• E-Mail Address

Cannot scan using Windows Image 
Acquisition (WIA) on a Microsoft® 
Windows Server® 2003 computer.

Enable WIA on the computer.

To enable WIA: 
1 Click Start, point to Administrative Tools, and then click Services.
2 Right-click Windows Image Acquisition (WIA), and then click Start.

Cannot scan using TWAIN or WIA on a 
Windows Server 2008 or Windows Server 
2008 R2 computer.

Install the Desktop Experience feature on the computer.

To install Desktop Experience:
1 Click Start, point to Administrative Tools, and then click Server Manager.
2 Under Features Summary, click Add Features.
3 Select the Desktop Experience check box, click Next, and then click Install.  
4 Restart the computer.

Cannot scan using TWAIN or WIA on a 
Windows Server 2012 or Windows Server 
2012 R2 computer.

Install the Desktop Experience feature on the computer.

To install Desktop Experience:
1 Click Server Manager from the Start screen.

The Server Manager screen appears.
2 Under Manage, click Add Roles and Features.

Add Roles and Features Wizard appears.
3 Click Next to skip the Before you begin page.
4 Ensure that Role-based or feature-based installation is selected, and then click 

Next.
5 Ensure that Select a server from the server pool is selected, select the server under 

Server Pool, and then click Next.
6 Click Next to skip the Select server roles page.
7 Select the Desktop Experience check box under User Interfaces and 

Infrastructure, and then click Next.
8 Click Confirmation from the list on the left.
9 Select the Restart the destination server automatically if required check box, and 

then click Install.
10 Restart the computer.

Problem Action
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Scanner Driver/Printer Utility Problems

Problem Action

Unable to retrieve the Address Book data 
from the printer on the Address Book 
Editor.

Ensure that your computer and the printer is properly connected with the 
Ethernet or USB cable.

Ensure that the printer’s power is on.

Ensure that the printer driver is installed on your computer. 
(The Address Book Editor retrieves the Address Book data via the printer driver.) 

The TWAIN driver cannot connect to the 
printer.

Ensure that your computer and the printer is properly connected with the 
Ethernet or USB cable.

Check whether the printer is on. If the printer is on, reboot it by turning the power 
switch off and then on again.

If a scan application is running, close the application once, restart the application, 
and then try scanning again. 

The scanner driver has not been registered 
on your computer and cannot be accessed 
from ScanButton Manager. 

Install the scanner driver. If the driver is installed, uninstall it and then reinstall it.

Failed to scan your document on the printer 
via ScanButton Manager.

Ensure that your computer and the printer is properly connected with the USB 
cable.

Check whether the printer is on. If the printer is on, reboot it by turning the power 
switch off and then on again.

If a scan application is running, close the application once, restart the application, 
and then try scanning again. 

Failed to create an image file via 
ScanButton Manager.

Ensure that there is sufficient space in your hard disk.

Uninstall ScanButton Manager on your computer and then reinstall it.

Failed to initialize ScanButton Manager. Uninstall ScanButton Manager on your computer and then reinstall it.

Failed to execute ScanButton Manager. Uninstall ScanButton Manager on your computer and then reinstall it.

An unexpected error occurred on 
ScanButton Manager. 

Uninstall ScanButton Manager on your computer and then reinstall it.
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Wireless Problems (Dell C1765nfw Color Multifunction Printer only)

Other Problems

Contacting Service
When you call for printer service, be prepared to describe the problem you are experiencing or the error message on 
the display.

You need to know the model of your printer type and serial number. See the label located inside the side door of your 
printer.

Problem Action

Cannot setup wireless connection. Ensure that the Ethernet cable is disconnected from the printer.

Ensure that Wi-Fi is set to On. See "Wi-Fi (Dell C1765nfw Color Multifunction 
Printer only)" on page 180.

Try disabling the firewall on your computer. The firewall on your computer may be 
blocking communication with your printer.

Cannot setup wireless connection with WPS 
(Wi-Fi Protected Setup®).

Ensure that the security setting of the wireless LAN access point or router is WPA 
or WPA2. (WEP is not supported on WPS.)

Cannot setup wireless connection with the 
WPS-PBC (Wi-Fi Protected Setup-Push 
Button Configuration).

Press the WPS button on the wireless LAN access point or router within 2 minutes 
after starting the WPS operation on the printer. For details about the wireless LAN 
access point or router, refer to the manual supplied with the wireless LAN access 
point or router.

Cannot setup wireless connection with 
WPS-PIN (Wi-Fi Protected Setup-Personal 
Identification Number).

Check if the PIN you have entered on the computer is correct.

Problem Action

Condensation has occurred inside the 
printer.

This usually occurs within several hours after you heat the room in winter. This 
also occurs when the printer is operating in a location where relative humidity 
reaches 85% or more. Adjust the humidity or relocate the printer to an appropriate 
environment.

No file is displayed on the operator panel 
when you are selecting a file for Printing 
from USB Memory feature.

Confirm that there are files with the supported file formats (PDF, TIFF, or JPEG) 
in the USB storage device.

If the target file is in a deep hierarchy in the USB storage device, move the file to 
the root directory in the USB storage device with your computer.

Shorten the target file name in the USB storage device with your computer, and try 
printing again.
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Appendix

Dell Technical Support Policy
Technician-assisted technical support requires the cooperation and participation of the customer in the 
troubleshooting process and provides for restoration of the operating system, software program and hardware drivers 
to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality of 
the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical 
support is available at Dell Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for 
third-party software and peripherals is provided by the original manufacturer, including those purchased and/or 
installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus).

Online Services
You can learn about Dell products and services on the following websites:

www.dell.com

www.dell.com/ap (Asian/Pacific countries only)

www.dell.com/jp (Japan only)

www.euro.dell.com (Europe only)

www.dell.com/la (Latin American and Caribbean countries)

www.dell.ca (Canada only)

You can access Dell Support through the following websites and e-mail addresses:

• Dell Support websites

www.dell.com/support

support.euro.dell.com (Europe only)

• Dell Support e-mail addresses

mobile_support@us.dell.com

support@us.dell.com 

la-techsupport@dell.com (Latin America and Caribbean countries only)

apsupport@dell.com (Asian/Pacific countries only)

• Dell Marketing and Sales e-mail addresses

apmarketing@dell.com (Asian/Pacific countries only)

sales_canada@dell.com (Canada only)

• Anonymous file transfer protocol (FTP)

ftp.dell.com

Log in as user: anonymous, and use your e-mail address as your password.

http://www.dell.com
http://www.dell.com/ap
http://www.dell.com/jp
http://www.euro.dell.com
http://www.dell.com/la
http://www.dell.ca
http://www.dell.com/support
http://support.euro.dell.com
http://ftp.dell.com
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Warranty and Return Policy
Dell Computer Corporation ("Dell") manufactures its hardware products from parts and components that are new or 
equivalent to new in accordance with industry-standard practices. For information about the Dell warranty for your 
printer, see www.dell.com/support.

Recycling Information
It is recommended that customers dispose of their used computer hardware, monitors, printers, and other peripherals in an environmentally 
sound manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials. 

For specific information on Dell's worldwide recycling programs, see www.dell.com/ recyclingworldwide. 

Contacting Dell
You can access Dell Support at www.dell.com/support. Select your region on the WELCOME TO DELL SUPPORT 
page, and fill in the requested details to access help tools and information.

You can contact Dell electronically using the following addresses:

• World Wide Web

www.dell.com

www.dell.com/ap (Asian/Pacific countries only)

www.dell.com/jp (Japan only)

www.euro.dell.com (Europe only)

www.dell.com/la (Latin American and Caribbean countries)

www.dell.ca (Canada only)

• Anonymous file transfer protocol (FTP)

ftp.dell.com

Log in as user: anonymous, and use your e-mail address as your password.

• Electronic Support Service

mobile_support@us.dell.com

support@us.dell.com

la-techsupport@dell.com (Latin America and Caribbean countries only)

apsupport@dell.com (Asian/Pacific countries only)

support.jp.dell.com (Japan only)

support.euro.dell.com (Europe only)

• Electronic Quote Service

apmarketing@dell.com (Asian/Pacific countries only)

sales_canada@dell.com (Canada only)

http://www.dell.com/support
http://www.dell.com/recyclingworldwide
http://www.dell.com
http://www.dell.com/ap
http://www.dell.com/jp
http://www.euro.dell.com
http://www.dell.com/la
http://www.dell.ca
http://www.dell.com/support
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New Zealand PTC200 Warnings

General warning
The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted that the 
item complies with minimum conditions for connection to its network. It indicates no endorsement of the product 
by Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance that any item will work 
correctly in all respects with another item of Telepermitted equipment of a different make or model, nor does it 
imply that any product is compatible with all of Telecom's network services Warnings taken from Specification text

2.11.1 Compliance testing (6) & (7) (Functional tests) 
"This equipment is not capable, under all operating conditions, of correct operation at the higher speeds for which it 
is designed. Telecom will accept no responsibility should difficulties arise in such circumstances"

4.5.1 Off-hook line impedance
(4) "This equipment does not fully meet Telecom's impedance requirements. Performance limitations may occur 
when used in conjunction with some parts of the network. Telecom will accept no responsibility should difficulties 
arise in such circumstances"

4.9.3 Non-voice equipment
(4) "This equipment is not capable, under all operating conditions, of correct at the higher speeds for which it is 
designed. Telecom will accept no responsibility should difficulties arise in such circumstances"

5.6.1 General requirements (automatic dialling devices) 
(3) "This equipment shall not be set up to make automatic calls to the Telecom '111' Emergency Service

5.5.5 User instructions
(4) If a charge for local calls is unacceptable, the 'Dial' button should NOT be used for local calls. Only the 7-digits of 
the local number should be dialled from your telephone. DO NOT dial the area code digit or the '0' prefix

8.1.7 User Instructions (automatic call set-up) 
(b) This equipment shall not be set up to make automatic calls to the Telecom '111' Emergency Service

8.2.1(b) Call answering
When this equipment is set up call answering not within 3~30 sec., the telephone or answering machine shall 
answer incoming call with 3~30sec.
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USA/Canada Wi-Fi Warnings

Class B:

FEDERAL COMMUNICATIONS COMMISSION INTERFERENCE STATEMENT 
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, 
the user is encouraged to try to correct the interference by one or more of the following measures:

-Reorient or relocate the receiving antenna.

-Increase the separation between the equipment and receiver.

-Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

-Consult the dealer or an experienced radio/ TV technician for help.

CAUTION:
Any changes or modifications not expressly approved by the grantee of this device could void the user's authority to 
operate the equipment.

Labeling requirements 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this 
device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation.

RF exposure warning  
This equipment must be installed and operated in accordance with provided instructions and the antenna(s) used 
for this transmitter must be installed to provide a separation distance of at least 20 cm from all persons and must not 
be co-located or operating in conjunction with any other antenna or transmitter. End-users and installers must be 
provide with antenna installation instructions and transmitter operating conditions for satisfying RF exposure 
compliance.

Canada, Industry Canada (IC) Notices 
This Class B digital apparatus complies with Canadian ICES-003 and RSS-210. 

Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device 
must accept any interference, including interference that may cause undesired operation of the device.
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Radio Frequency (RF) Exposure Information 
The radiated output power of the Wireless Device is below the Industry Canada (IC) radio frequency exposure 
limits. The Wireless Device should be used in such a manner such that the potential for human contact during 
normal operation is minimized. 

This device has also been evaluated and shown compliant with the IC RF Exposure limits under mobile exposure 
conditions. (antennas are greater than 20cm from a person's body).

This device has been certified for use in Canada. Status of the listing in the Industry
Canada's REL (Radio Equipment List) can be found at the following web address:
http://www.ic.gc.ca/app/sitt/reltel/srch/nwRdSrch.do?lang=eng
Additional Canadian information on RF exposure also can be found at the following web address:
http://www.ic.gc.ca/eic/site/smt-gst.nsf/eng/sf08792.html

Canada, avis d'Industry Canada (IC) 
Cet appareil numérique de classe B est conforme aux normes canadiennes ICES-003 et RSS-210. 
Son fonctionnement est soumis aux deux conditions suivantes : (1) cet appareil ne doit pas causer d'interférence et 
(2) cet appareil doit accepter toute interférence, notamment les interférences qui peuvent affecter son 
fonctionnement.

Informations concernant l'exposition aux fréquences radio (RF)
La puissance de sortie émise par l'appareil de sans fil Dell est inférieure à la limite d'exposition aux fréquences radio 
d'Industry Canada (IC). Utilisez l'appareil de sans fil Dell de façon à minimiser les contacts humains lors du 
fonctionnement normal.

Ce périphérique a également été évalué et démontré conforme aux limites d'exposition aux RF d'IC dans des 
conditions d'exposition à des appareils mobiles (les antennes se situent à moins de 20 cm du corps d'une 
personne). 

Ce périphérique est homologué pour l'utilisation au Canada. Pour consulter l'entrée correspondant à l'appareil dans 
la liste d'équipement radio (REL - Radio Equipment List) d'Industry Canada rendez-vous sur: 
http://www.ic.gc.ca/app/sitt/reltel/srch/nwRdSrch.do?lang=eng 

Pour des informations supplémentaires concernant l'exposition aux RF au Canada rendez-vous sur :
http://www.ic.gc.ca/eic/site/smt-gst.nsf/eng/sf08792.html

Canada IC statement
This product meets the applicable Industry Canada technical specifications. / Le présent matériel est conforme 
aux specifications techniques applicables d'Industrie Canada.
The Ringer Equivalence Number (REN) is an indication of the maximum number of devices allowed to be 
connected to a telephone interface. The termination of an interface may consist of any combination of devices 
subject only to the requirement that the sum of the RENs of all the devices not exceed five. / L'indice 
d'équivalence de la sonnerie (IES) sert à indiquer le nombre maximal de terminaux qui peuvent être raccordés à 
une interface téléphonique. La terminaison d'une interface peut consister en une combinaison quelconque de 
dispositifs, à la seule condition que la somme d'indices d'équivalence de la sonnerie de tous les dispositifs n'excède 
pas cinq.

http://www.ic.gc.ca/app/sitt/reltel/srch/nwRdSrch.do?lang=eng
http://www.ic.gc.ca/eic/site/smt-gst.nsf/eng/sf08792.html
http://www.ic.gc.ca/app/sitt/reltel/srch/nwRdSrch.do?lang=eng
http://www.ic.gc.ca/eic/site/smt-gst.nsf/eng/sf08792.html
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Index

Numerics
100Base-TX Full-Duplex, 126

100Base-TX Half-Duplex, 126

10Base-T Full-Duplex, 126

10Base-T Half-Duplex, 126

A
A4, 208

A5, 208

About printer, 25

AC (All Clear) button, 92

Address Book, 100, 102, 112, 133, 175

Address Book Editor, 301

ADF Cover, 26, 28, 332

ADF Glass, 328

Ad-Hoc, 127

Adjust Altitude, 111, 120, 151, 196

Adjust ColorRegi, 194

Adjust Fusing Unit, 111, 119, 149, 193

Adjust Transfer Roller, 111, 119, 149, 193

Adjusting Color Registration, 325

Admin Menu, 176

Administrator Password, 132

Alert Tone, 108, 113, 190

All Tones, 108, 113

Altitude, 310

Ans Machine/Fax, 278

Answer Machine/Fax, 117

Appendix, 366

Apply New Settings, 103

Asset Tag Number, 106

Authenticate Error Trap, 131

Auto Clear Alert Tone, 108, 113

Auto Exposure, 109, 115-116, 166, 170, 240

Auto Log Print, 108, 113, 191

Auto Rec Ans/FAX, 181, 278

Auto Rec Fax, 181, 278

Auto Rec TEL/FAX, 181, 278

Auto Receive Answer/Fax, 110, 117

Auto Receive Fax, 110, 117

Auto Receive Tel/Fax, 110, 117

Auto Regi Adjust, 194

Auto Registration Adjustment, 111, 119

Auto Reset, 108, 113, 189

Auto SSID Setup, 40

Automatic Document Feeder (ADF), 25, 28

Automatic Redialing, 282

Avoiding Jam, 229, 331

B
B&W / Color LED, 92

B5, 208

Back button, 92

Backspace button, 92

Base memory, 309

Basic Information, 125

Basic Printer Problems, 347

Blue plug, 43

Bonjour (mDNS), 123, 126, 130

C
C5, 208

Cable, 311

Cancel button, 92

Canceling a job, 230
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Canceling a Job From the Computer Running 
Windows, 230

Carbonless copy paper, 204

CCP, 204

Chart Print, 161

Clean Developer, 120, 162, 194

Clearing Paper Jam, 331
From ADF, 333
From Back of the Printer, 338
From Front of the Printer, 337
From Output Tray, 340

Clock Mode, 276

Clock Settings, 111, 121

Coated, 111, 119, 149, 193

Collated, 109, 115, 163, 236

Color, 109, 115-116, 163, 168, 236

Color Balance, 166

Color Button Set, 168

Color Mode button, 92

Color Registration Adjustment, 120

Color Registration Chart, 326

Color Test Page, 175

Community Name, 131

Completed Jobs, 99, 107

Connecting Printer, 35

Connection specification, 35, 311

Connection type, 35, 311

Conserving supplies, 317

Contact Dell Support at, 100, 102

Contact Person, 101

Contacting Service, 364

Contacts button, 91

Control Panel Tone, 108, 113

Copy button, 91

Copy Color Balance, 109, 115

Copy Defaults, 109, 115, 157

Copy Problem, 360

Copy Service Lock Set, 109, 114

Copy Settings, 109, 115

Country, 111, 118, 279

Cover, 106

Covers, 111, 119, 149, 193

CTD Sensor, 324

Custom Reduce/Enlarge, 115

D
Data LED, 91

Date & Time, 148, 190

Date Format, 111

Defaults Settings, 144

Delayed Start, 110, 116, 173

Dell Printer Configuration Web Tool, 97

Dell ScanCenter, 302

Dell Service Tag Number, 106

Dell Supplies Management System, 299

Dell Technical Support Policy, 366

Demo Page, 112

Details, 106

Determining Values, 326

DHCP, 123, 129

Dimensions, 309

Direct Connection, 36

Direct Connection Setup, 65

Direct Fax, 283

Discard Size, 110, 118, 186, 279

Display Popup, 112

Display Problems, 347

DL, 208

DL LEF, 208

DNS, 123, 129

Document Feeder Tray, 25, 28

Document Glass, 28, 328

Document Guides, 28

Document Output Tray, 25

Document Size, 109, 115-116, 165, 169, 238
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Driver, 21

DRPD, 117, 278

DRPD Pattern, 110, 118, 185, 278

E
ECM, 110, 118, 186, 279

Edit From Field, 198

E-Mail Alert, 100, 102, 126, 129, 179

E-Mail Alert Settings, 124, 130

E-Mail Alert Setup, 97

E-mail Alert Setup Page, 124

E-Mail Default Setup, 137

E-Mail Group, 136

E-Mail Server Settings, 129

Emulations, 309

Encryption, 122, 127

Entering Values, 327

Envelope, 111, 119, 149-150, 193-194, 206

Envelope #10, 208

Environment, 310

Environment Sensor Info, 161

Environment settings of your web browser, 97

Error History, 112, 175

Ethernet, 122, 126, 176, 311

Ethernet Connection, 36

Ethernet Port, 26, 35

EWS, 154, 180

EWS Settings, 125

Executive, 208

Express Code, 192

F
F/W Version, 192

Fault Time-out, 189

Fax, 117

Fax Activity, 110, 118, 175, 187, 279

Fax Broadcast, 111, 118, 187, 279

Fax button, 91

Fax Cover Page, 110, 118, 184, 278

Fax Defaults, 110, 116, 156

Fax Forward Number, 110, 118

Fax Fwd Number, 186, 279

FAX Group, 135

Fax Group, 135

Fax Header, 110, 117, 184, 278

Fax Header Name, 110, 117, 184, 278

Fax Number, 110, 118, 184, 278

Fax Problems, 360

Fax Protocol, 111, 118

Fax Service Lock Set, 109, 114

Fax Settings, 110, 117, 145, 159, 181

FAX Speed Dial, 135

Fax Transmit, 111, 118, 279

File Format, 109, 116, 168

Finding Information, 21

Firmware Version, 107

Folio, 208

Forward Settings, 185, 279

Front Cover, 25, 332

Front USB Port, 25

FTP Client, 123

Function Enabled, 114, 197

Fusing Unit, 332

G
Gateway Address, 123, 128

Group Dial, 176

H
Host I/F, 107

Host Name, 107, 123, 128

How to set up, 22
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How to use, 21

HTTP, 123, 129

I
ID, 107

Identifying Print Media and Specifications, 208

Image Compression, 109, 116, 171

Important Information, 21

Impression Number, 107

Infrastructure, 127

Initial Settings, 47

Initialize NIC NVM and restart printer, 132

Initialize NVM, 180, 195

Installing a Toner Cartridge, 320

Installing Printer Drivers, 65, 85

Interfaces, 310

IP Address, 53, 99, 101, 123, 128

IP address, 123

IP Address Mode, 123, 128

IP Filter, 180

IP Filter (IPv4), 133

IP Mode, 123, 128

IP Settings, 55

IPv4, 123, 128-129, 131

IPv6, 123, 128-129, 131

J
Jam, 358

Job History, 112, 175

Job List, 99, 107

Job Name, 107

Job Status, 107

Job Submitted Time, 107

Job Time-Out, 108, 113

Job Time-out, 189

Job Tone, 108, 113

Job Type, 107

Junk Fax Setup, 110, 117, 160, 183, 278

K
Kensington lock, 29

L
Label, 111, 119, 149-150, 193-194, 207

LCD, 91

LCD Panel, 92

Left frame, 102

Legal, 208

Length Guide, 25

Letter, 208

Levers, 26, 332

Lighter/Darker, 109-110, 115-116, 165, 169, 172, 
239, 282

Line Monitor, 110, 117, 182, 278

Line Type, 110, 117, 182, 278

Link Channel, 122, 127

Link Quality, 122, 127

Liquid crystal display, 91

Loading Envelope, 216, 221

Loading Letterhead, 205, 218, 223

Loading Paper, 57

Loading Print Media, 211

Loading Print Media in Multipurpose Feeder 
(MPF), 57, 211

Loading Print Media in Priority Sheet Inserter 
(PSI), 62, 219

Location, 101, 106

Low Toner Alert Msg, 191

LPD, 123, 126, 129, 179

M
MAC Address, 122, 127
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Maintenance, 317

Manual Duplex Printing, 224

Manual SSID Setup, 41

Margin Left/Right, 109, 115-116, 167, 170, 242

Margin Middle, 109, 115-116, 167, 171, 243

Margin Top/Bottom, 109, 115-116, 167, 170, 242

Max E-Mail Size, 109, 116, 171

Memory, 309

Memory Capacity, 107

Menu button, 92

Menu Items, 104

Menu Settings, 108, 140

MIB Compatibility, 310

Mixed Mode PSK, 127

mm/inch, 108, 113, 191

Modem Speed, 110, 118, 187, 279

Monarch, 208

Monarch LEF, 208

MPF Extension, 25

Multiple Up, 317

Multiple-Up, 109, 115, 167, 241

Multipurpose Feeder (MPF), 25, 332

N
NCR, 204

Network, 176

Network Connection Setup, 68

Network Firmware Version, 107

Network Type, 122, 127

New Password, 114

No carbon required, 204

No. of Sheets, 107

Non-Dell Toner, 111, 121, 151, 196

Number of Copies, 235

Numeric keypad, 92, 94

O
OCR, 204

One Touch Dial button, 91

Online Help, 100, 102

Online Services, 366

Operating System Compatibility, 309

Operation, 310

Operator Panel, 25, 91
Button, 91

Optical character recognition, 204

Order Supplies, 30

Order Supplies at, 100, 102

Original Type, 109, 115, 165, 238, 281

OS, 309

Out of Paper Tone, 108, 113

Output Result, 107

Output Tray, 106

Output Tray Extension, 226

Owner, 107

P
Panel Alert Tone, 108, 113

Panel Language, 95, 108, 113, 199

Panel Lock, 197, 200

Panel Lock Set, 109

Panel Settings, 112, 174

Panel Settings Page, 95

Paper, 203
Characteristics, 203
Curl, 203
Fiber Content, 204
Grain Direction, 203
Moisture Content, 203
Smoothness, 203
Weight, 203

Paper Chute, 26

Paper Density, 111, 118, 148, 192

Paper Feed Roller, 26
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Paper jam location, 332

Paper Size, 208

Paper Trays, 106

Paper Type, 209

Paper Used, 133

Paper Width Guides, 25

Parts name, 25

PDL, 309

Peer-to-Peer, 82

Phone Book, 176

Phone Connector, 26, 35, 43, 311

Plain, 111, 119, 149, 193

Plain Thick, 111, 119, 149, 193

Point and Print, 80

Port Settings, 126

Port Status, 123, 126

Port9100, 123, 126, 129, 179

Power Connector, 26

Power On Wizard, 192

Power Saver Timer, 95

Power Saver Timer - Deep Sleep, 108, 113

Power Saver Timer - Sleep, 108, 113

Power Saving Timer, 95, 188

Power Supply, 309

Power Switch, 25

Prefix Dial, 110, 118, 186, 279

Prefix Dial Num, 186

Prefix Dial Number, 110, 118, 279

Premier, 111

Print Cartridge Level, 106

Print from USB, 109, 114

Print Head Cleaning Rod, 25

Print media, 317

Print Media Dimensions, 211

Print Media Guidelines, 203

Print Quality Guarantee, 310

Print Quality Problems, 349

Print Server Reports, 122

Print Server Settings, 100, 102, 122, 125

Print Server Setup Page, 122

Print Volume, 100, 102, 133

Printer Driver Pre-install Status, 65

Printer Events, 106

Printer Information, 100, 102, 106, 140

Printer Jobs, 99, 102, 107

Printer Maintenance, 118

Printer Page Count, 133

Printer Revision Levels, 107

Printer Serial Number, 107

Printer Settings, 99, 102, 108, 113

Printer Settings Report, 108

Printer Software, 299

Printer specification, 309

Printer Status, 99, 102, 106

Printer Type, 106

Printing, 229

Printing on Letterhead, 205

Printing Problems, 347

Printing Speed, 106

Printing Status Window, 299

Priority Sheet Inserter (PSI), 25

Processor Speed, 107

Product Features, 23

Protocol, 179

Protocol Monitor, 175, 279

Q
Quick Launch Utility, 300

Quick Reference Guide, 21

R
Ready / Error LED, 91

Rear Cover, 26, 332
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Receive Mode, 110, 117, 181, 278

Recommended Paper, 204

Recycled, 111, 119, 149, 193-194

Recycling Information, 367

Re-dial / Pause button, 91

Redial Attempts, 110, 117, 183, 278

Redial Delay, 110, 117, 183, 278

Reduce/Enlarge, 109, 115, 164, 237

Re-enter Password, 114

Refresh, 103

Refresh Mode, 162

Registration Adjustment, 150

Regular, 111

Relative humidity, 310

Remote Rcv Tone, 183, 278

Remote Receive, 110, 117, 183, 278

Remote Receive Tone, 110, 117

Removing the Toner Cartridges, 318

Report Page, 231

Reports, 112, 142

Resend Delay, 110, 117, 183, 278

Reset Defaults, 121, 151

Reset Print Server, 132

Reset Wireless, 179

Resetting Defaults, 162, 201

Resolution, 109-110, 116, 168, 172, 281

Restore Settings, 103

Return Policy, 367

Right Frame, 103

Ring Tone Volume, 110, 117, 182, 278

Ringer Volume, 277

S
Safety information, 21

Scan button, 92

Scan Defaults, 109, 116, 154

Scan Service Lock Set, 109, 114

Scan to PC, 132

ScanButton Manager, 301

Scanner Driver/Printer Utility Problems, 363

Scanner Unit, 332

Scanning Problems, 361

Secure Receive, 114, 198

Secure Receive Set, 109, 114

Secure Settings, 109, 114, 197

Security, 132

Security Settings, 127

Security Slot, 26

Select Reorder URL, 111

Selecting Paper, 204

Selecting Preprinted Media and Letterhead, 205

Selecting Pre-Punched Paper, 206

Sending a Fax, 280

Sending a Fax Automatically, 280

Sending a Fax Manually, 280

Sending print job, 229

Sent Fax Forward, 110, 118

Server Address, 137

Service Code, 22

Service Tag, 22, 192

Set Date, 111

Set Password, 100, 102, 132

Set Time, 111

Setting Copy Options, 235

Setting the IP Address, 53

Setting the Printer ID, 275

Setting the Time and Date, 276

Setting Up Printer, 47

Setting Your Country, 275

Setup diagram, 22

Sharpness, 109, 115-116, 166, 170, 239

SMB Client, 123

SNMP, 123, 126, 131

SNMP UDP, 179
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Software and Documentation disc, 21, 51

Software Download, 109, 114, 198

Speaker Volume, 277

Speed Dial, 176

Speed Dial button, 92

SSID, 122, 127

Start, 92

Start button, 92

Status Messager, 126

Status Monitor Console, 299

Status of printer supplies, 317

Storage, 310

Storage humidity range, 310

Storing consumables, 318

Storing Print Media, 207, 229, 317

Subnet Mask, 123, 128

Support
Contacting Dell, 367

System Settings, 108, 112-113, 125, 146, 174

System Settings page, 112

T
TCP/IP, 128

TCP/IP Settings, 123, 128, 143, 152

Telephone, 117, 278

Telephone/Fax, 117, 278

Temperature, 310

TIFF File Format, 116, 171

Time Format, 111

Time Zone, 111

Time-Out, 123, 129

Tone/Pulse, 110, 117, 182, 278

Toner Access Cover, 25

Toner Refresh, 120, 195

Top frame, 101

Transfer Belt, 26

Transfer Roller, 26

Transfer Roller Refresh, 195

Transfer Roller Refresh Mode, 152

Transmit Key, 122

Trap Notification, 131

Tray 1 Custom Size - X, 112

Tray 1 Custom Size - Y, 112

Tray 1 Paper Size, 112

Tray 1 Paper Type, 112

Tray Settings, 100, 102, 112, 138, 143, 153, 173

TWAIN, 250

U
Unacceptable Paper, 204

UNITED STATES GOVERNMENT 
RESTRICTED RIGHTS, 17

USB, 311

USB port, 26, 35

USB Settings
USB port, 199

USB storage device, 268

W
Wall Jack Connector, 26, 35, 43, 311

Warranty, 367

Warranty information, 21

Web Link Customization, 111, 122, 152

WEP 128 Bit ASCII (13 Bytes), 127

WEP 128 Bit Hex (26 Bytes), 127

WEP 64 Bit ASCII (5 Bytes), 127

WEP 64 Bit Hex (10 Bytes), 127

White Document Cover, 328

White Sheet, 328

Wi-Fi, 180

Wi-Fi | WPS button, 38, 92
Backlight, 93

Windows Image Acquisition (WIA), 251

Wireless Connection, 37
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Wireless LAN, 122, 127

Wireless Problems, 364

Wireless Settings, 122, 127

Wireless Setup, 177

Wireless Status, 177

WPA2-PSK AES, 127

WPA-PSK TKIP, 127

WPS, 178

WPS-PBC, 38-39

WPS-PIN, 40

WSD, 76, 123, 126, 129

Y
Yellow terminator, 44
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